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Notes, Notices, and Cautions
 NOTE: A NOTE indicates important information that helps you make better use of 

your computer.

 NOTICE: A NOTICE indicates either potential damage to hardware or loss of data 

and tells you how to avoid the problem.

 CAUTION: A CAUTION indicates a potential for property damage, personal injury, 
or death.

____________________

Information in this document is subject to change without notice.
© 2007-2008 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell, the DELL logo, YOURS IS HERE, XPS, Wi-Fi Catcher, and Dell 
MediaDirect are trademarks of Dell Inc.; Intel, and Core are registered trademarks of Intel 
Corporation.; Microsoft and Windows are registered trademarks and Windows Vista is a trademark of 
Microsoft Corporation in the United States and/or other countries; Bluetooth is a registered trademark 
owned by Bluetooth SIG, Inc. and is used by Dell under license. Logitech, the Logitech logo, and the 
Logitech products referred to herein are either the trademarks or the registered trademarks of Logitech.

Other trademarks and trade names may be used in this document to refer to either the entities claiming 
the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and 
trade names other than its own.
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Finding Information
 NOTE: Some features or media may be optional and may not ship with your 

computer. Some features or media may not be available in certain countries.

 NOTE: Additional information may ship with your computer.

What Are You Looking For? Find It Here

• A diagnostic program for my computer

• Drivers for my computer 

• My device documentation

• Notebook System Software (NSS)

Drivers and Utilities Media

Documentation and drivers are already 
installed on your computer. You can use 
the media to reinstall drivers (see 
"Reinstalling Drivers and Utilities" on 
page 136), to run the Dell Diagnostics 
(see "Dell Diagnostics" on page 107), or to 
access your documentation.

Readme files may be included on your 
media to provide last-minute updates 
about technical changes to your computer 
or advanced technical-reference material 
for technicians or experienced users.

NOTE: Drivers and documentation updates 

can be found at support.dell.com.
Finding Information 13

Download from Www.Somanuals.com. All Manuals Search And Download.



book.book  Page 14  Monday, April 14, 2008  4:23 PM
• Warranty information

• Terms and Conditions (U.S. only)

• Safety instructions

• Regulatory information

• Ergonomics information

• End User License Agreement

Dell™ Product Information Guide

• How to set up my computer Setup Diagram

NOTE: The appearance of your setup 

diagram may vary.

• Service Tag and Express Service Code Service Tag and Microsoft® Windows® 
License

This label is located in the battery bay of 
your computer.

• Use the Service Tag to identify your 
computer when you use 
support.dell.com or contact support. 

• Enter the Express Service Code to direct 
your call when contacting support.

What Are You Looking For? Find It Here
14 Finding Information
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• Microsoft Windows License Label The label is located on the memory 
module cover at the bottom of the system.

NOTE: If your operating system is 

Windows XP, this label might look different.

NOTE: As an increased security 

measure,the newly designed Microsoft 

Windows license label incorporates a 

missing portion or "hole" to discourage 

removal of the label.

• Solutions — Troubleshooting hints and 
tips, articles from technicians, and online 
courses, frequently asked questions

• Community — Online discussion with 
other Dell customers

• Upgrades — Upgrade information for 
components, such as memory, the hard 
drive, and the operating system

• Customer Care — Contact 
information, service call and order 
status, warranty, and repair information

• Service and support — Service call status 
and support history, service contract, 
online discussions with technical support

• Dell Technical Update Service — 
Proactive e-mail notification of software 
and hardware updates for your computer

• Reference — Computer 
documentation, details on my 
computer configuration, product 
specifications, and white papers

• Downloads — Certified drivers, 
patches, and software updates

Dell Support Website — support.dell.com

NOTE: Select your region or business 

segment to view the appropriate support site.

What Are You Looking For? Find It Here
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• Notebook System Software (NSS)— If 
you reinstall the operating system for 
your computer, you should also reinstall 
the NSS utility. NSS provides critical 
updates for your operating system and 
support for processors, optical drives, 
USB devices, and so on. NSS is necessary 
for correct operation of your Dell 
computer. The software automatically 
detects your computer and operating 
system and installs the updates 
appropriate for your configuration.

To download Notebook System Software:

1 Go to support.dell.com and click 
Drivers & Downloads.

2 Enter your Service Tag or Product Type 
and Product Model, and click Go. 

3 Scroll to System and Configuration 
Utilities→ Dell Notebook System 
Software and click Download Now.

4 Select Drivers & Downloads and click Go.

NOTE: The support.dell.com user interface 

may vary depending on your selections.

• Software upgrades and troubleshooting 
hints — Frequently asked questions, 
hot topics, and general health of your 
computing environment

Dell Support Utility

The Dell Support Utility is an automated 
upgrade and notification system installed 
on your computer. This support provides 
real-time health scans of your computing 
environment, software updates, and 
relevant self-support information. Access 
the Dell Support Utility from the 
icon in the taskbar. For more information, 
see "Dell Support Utility" on page 111.

• How to use Windows XP or 
Windows Vista™

• How to work with programs and files

• How to personalize my desktop

Microsoft Windows XP and Windows Vista 
Help and Support Center 

1 Click Start→ Help and Support.

2 Type a word or phrase that describes 
your problem and click the arrow icon.

3 Click the topic that describes your 
problem.

4 Follow the instructions on the screen.

What Are You Looking For? Find It Here
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• Information on network activity, the 
Power Management Wizard, hotkeys, 
and other items controlled by 
Dell QuickSet.

• How to change the LED colors for the 
zones, play various LED effects (like 
strobe lights, breathing lights, rotating 
lights), enable or disable visualization 
plugins for select music players

Dell QuickSet Help

To view Dell QuickSet Help, right-click the 
QuickSet icon in the Microsoft® 
Windows® taskbar, and select Help. 
The taskbar is located in the lower-right 
corner of your screen.

• How to reinstall my operating system Operating System Media

The operating system is already installed 
on your computer. To reinstall your 
operating system, use the Operating 
System media. See "Restoring Your 
Operating System" on page 140 in your 
Owner’s Manual.

After you reinstall your operating system, 
use the Drivers and Utilities media to 
reinstall drivers for the devices that came 
with your computer.

Your operating system product key label is 
located on your computer.

NOTE: The color of your DVD varies based 

on the operating system you ordered.

What Are You Looking For? Find It Here
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About Your Computer

Front View
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CAMERA — Built-in camera for video capture, conferencing, and chat.

DISPLAY — For more information about your display, see "Using the Display" on 
page 39.

POWER  BUTTON — Press the power button to turn on the computer or exit a power 
management mode (see "Power Management Modes" on page 50).

 NOTICE: To avoid losing data, turn off your computer by performing a 

Microsoft® Windows® operating system shutdown rather than by pressing the 

power button.

If the computer stops responding, press and hold the power button until the computer 
turns off completely (which may take several seconds).

GAMEPANEL — A small secondary LCD for displaying text and graphical information.

1 camera 2 display

3 power button 4 GamePanel

5 device status lights 6 right speaker

7 infrared sensor 8 media control buttons

9 touch pad 10 left speaker

11 Dell™ MediaDirect™ button 12 keyboard status lights

13 digital array microphones (2) 14 display latch

15 camera indicator
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DEVICE  STATUS  L IGHTS

If the computer is connected to an electrical outlet, the  light operates as follows:

– Solid blue: The battery is charging.

– Flashing blue: The battery is almost fully charged.

– Off: The battery is adequately charged (or external power is not available to charge 
the battery).

If the computer is running on a battery, the  light operates as follows:

– Off: The battery is adequately charged (or the computer is turned off).

– Flashing orange: The battery charge is low.

– Solid orange: The battery charge is critically low.

Turns on when you turn on the computer and blinks when the computer is 
in a power management mode.

Turns on when the computer reads or writes data.

 NOTICE: To avoid loss of data, never turn off the computer while the 

 light is flashing.

Turns on steadily or blinks to indicate battery charge status.

Turns on when wireless devices are enabled.

Turns on when Bluetooth® wireless technology is enabled. To enable or 
disable Bluetooth wireless technology, toggle the wireless switch between 
the "on" and "off" positions (see "wireless switch" on page 27 for more 
information).
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TOUCH  PAD — Provides the functionality of a mouse (see "Touch Pad" on page 45).

INFRARED  SENSOR — Consumer Infrared sensor to operate the remote control.

MEDIA  CONTROL  BUTTONS — Control CD, DVD, and Media Player playback.

SPEAKERS — To adjust the volume of the integrated speakers, press the volume 
control buttons or mute button.

Mute the sound. Play the previous track.

Turn the volume down. Play the next track. 

Turn the volume up. Stop. 

Play or pause. 
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DELL™ MEDIAD IRECT™ BUTTON — Press the Dell MediaDirect button to launch 
Dell MediaDirect (see "Using Dell MediaDirect™" on page 67).

1 Dell MediaDirect button

1
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KEYBOARD  STATUS  L IGHTS

The blue lights located above the keyboard indicate the following:

D IG ITAL  M ICROPHONES — Digital directional microphones for conferencing and 
chat.

DISPLAY  LATCH — Keeps the display closed.

CAMERA  INDICATOR — The indicator shows solid blue light when the camera is 
active and off when the camera is not.

Turns on when the numeric keypad is enabled.

Turns on when the Caps Lock function is enabled.

Turns on when the scroll lock function is enabled.

9

A
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Left Side View

DVI- I  CONNECTOR — Used for connecting a DVI or VGA display (through dongle).

S-VIDEO  CONNECTOR — Connects your computer to a TV. Also connects digital 
audio-capable devices using the TV/digital audio adapter cable.

USB CONNECTORS  

IEEE 1394 CONNECTOR — Connects devices supporting IEEE 1394 high-speed 
transfer rates, such as some digital video cameras.

1 DVI-I connector (Dual link) 2 S-video connector

3 USB connector 4 IEEE 1394 connector

5 8-in-1 memory card reader 6 optical drive

7 microphone connector 8 headphone connectors (2)

Connect USB devices, such as a mouse, keyboard, or printer.

1 2 3 4 5 6 7 8
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8- IN -1  MEMORY  CARD  READER — Provides a fast and convenient way to view and 
share digital photos, music, and videos stored on a memory card. The 8-in-1 media 
memory card reader reads the following digital media memory cards:

• Secure Digital (SD)

• SDIO

• MultiMediaCard (MMC)

• Memory Stick

• Memory Stick PRO

• xD-Picture Card

• Hi Speed-SD

• Hi Density-SD

OPT ICAL  DRIVE — For more information about the optical drive, see "Using 
Multimedia" on page 59.

MICROPHONE  CONNECTOR — Attach a microphone to this connector.

HEADPHONE  CONNECTORS — Dual headphone connectors for attaching headphones.

Attach a microphone to the  connector.

Attach headphones to the  connectors.
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Right Side View

EXPRESSCARD  SLOT — Supports one ExpressCard. The computer ships with a 
plastic blank installed in the slot. For more information, see "ExpressCards" on 
page 85.

WIRELESS  SWITCH — You can use this switch to rapidly turn off or on any wireless 
devices such as WLAN cards and internal cards with Bluetooth wireless technology. 

1 Express card slot 2 wireless switch

3 Wi-Fi Catcher™ Network Locator 4 USB connectors (2)

5 security cable slot

1 off 2 on

2 3 4 51

1 2
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DELL W I-F I  CATCHER™ NETWORK  LOCATOR — Push this button to scan 
specifically for wireless networks in your vicinity.

The Wi-Fi Catcher Network Locator has an LED that operates as follows:

– Flashing blue: Searching for networks

– Solid blue: Strong network found

– Solid yellow: Weak network found

– Off: No signal found

 NOTE: The Dell Wi-Fi Catcher Network Locator light appears only when the 

computer is turned off and wireless networking is activated in the system setup 

program.

USB CONNECTORS  

SECURITY  CABLE  SLOT — Lets you attach a commercially available antitheft device 
to the computer (see "Security Cable Lock" on page 103).

Back View

AIR  VENTS — The computer uses an internal fan to create airflow through the vents, 
which prevents the computer from overheating.

Connect USB devices, such as a mouse, keyboard, or printer.

1 air vents 2 AC adapter connector

3 USB connector 4 network connector (RJ-45)

1 432
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 CAUTION: Do not block, push objects into, or allow dust to accumulate in the air 
vents. Do not store your computer in a low-airflow environment, such as a closed 
briefcase, while it is running. Restricting the airflow can damage the computer or 
cause a fire.

AC ADAPTER  CONNECTOR

The AC adapter converts AC power to the DC power required by the computer. You 
can connect the AC adapter with your computer turned either on or off.

 CAUTION: The AC adapter works with electrical outlets worldwide. However, 
power connectors and power strips vary among countries. Using an incompatible 
cable or improperly connecting the cable to the power strip or electrical outlet 
may cause fire or equipment damage.

 NOTICE: When you disconnect the AC adapter cable from the computer, grasp the 

connector, not the cable itself, and pull firmly but gently to avoid damaging the 

cable. When you wrap the AC adapter cable, ensure that you follow the angle of the 

connector on the AC adapter to avoid damaging the cable.

Connects an AC adapter to the computer.
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USB CONNECTORS

NETWORK  CONNECTOR  (RJ-45)

 NOTICE: To avoid damaging the computer, do not plug a telephone line into the 

network connector.

Connect USB devices, such as a mouse, keyboard, or printer. 

Connects the computer to a network. The two lights next to 
the connector indicate status and activity for wired network 
connections.

For information on using the network adapter, see the device 
user’s guide supplied with your computer.
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Bottom View

MEMORY  MODULE  COVER — Covers the compartment that contains the memory 
module connectors.

BATTERY -BAY  LATCH  RELEASES — Release the battery.

BATTERY  CHARGE  GAUGE /HEALTH  GAUGE — Provides information on the battery 
charge (see "Checking the Battery Charge" on page 48).

BATTERY — When a battery is installed, you can use the computer without 
connecting the computer to an electrical outlet.

HARD  DRIVE — Stores software and data.

AIR  VENTS — The computer uses an internal fan to create airflow through the vents, 
which prevents the computer from overheating.

1 memory module cover 2 battery-bay latch release

3 battery charge gauge/health gauge 4 battery

5 hard drive 6 air vents

4

1

3

5
2

6
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 CAUTION: Do not block, push objects into, or allow dust to accumulate in the air 
vents. Do not store your computer in a low-airflow environment, such as a closed 
briefcase, while it is running. Restricting the airflow can damage the computer or 
cause a fire.
32 About Your Computer

Download from Www.Somanuals.com. All Manuals Search And Download.



book.book  Page 33  Monday, April 14, 2008  4:23 PM
Setting Up Your Computer

Connecting to the Internet
 NOTE: ISPs and ISP offerings vary by country.

To connect to the Internet, you need a wireless modem/router or network 
connection and an Internet service provider (ISP). Your ISP will offer one or 
more of the following Internet connection options:

• DSL connections that provide high-speed Internet access through your 
existing telephone line or cellular telephone service. With a DSL 
connection, you can access the Internet and use your telephone on the 
same line simultaneously.

• Cable modem connections that provide high-speed Internet access 
through your local cable TV line.

• Satellite modem connections that provide high-speed Internet access 
through a satellite television system.

• Wireless LAN connections that provide Internet access using Bluetooth® 
wireless technology.

 NOTE: If you are using a DSL, cable, or satellite modem connection, contact your 

ISP or cellular telephone service provider for setup instructions.

Setting Up Your Internet Connection

To set up an Internet connection with a provided ISP desktop shortcut:

1 Save and close any open files, and exit any open programs.

2 Double-click the ISP icon on the Microsoft® Windows® desktop.

3 Follow the instructions on the screen to complete the setup.
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If you do not have an ISP icon on your desktop or if you want to set up an 
Internet connection with a different ISP, perform the steps in the following 
section that corresponds to the operating system your computer is using.

 NOTE: If you are having problems connecting to the Internet, see "E-Mail and 

Internet Problems" on page 114. If you cannot connect to the Internet but have 

successfully connected in the past, the ISP might have a service outage. Contact 

your ISP to check the service status, or try connecting again later.

 NOTE: Have your ISP information ready. If you do not have an ISP, the Connect to 

the Internet wizard can help you get one.

1 Save and close any open files, and exit any open programs.

2 Click the Windows Vista Start button , and click Control Panel

3 Under Network and Internet, click Connect to the Internet.

The Connect to the Internet window appears.

4 Click Wireless to configure your WLAN/WWAN card to connect to the 
Internet.

5 Follow the instructions on the screen and use the setup information 
provided by your ISP to complete the setup.

Transferring Information to a New Computer
You can use your operating system "wizards" to help you transfer files and 
other data from one computer to another—for example, from an old 
computer to a new computer. For instructions, see the following section that 
corresponds to the operating system that your computer is running.

1 Click the Windows Vista Start button , and then click Transfer files 
and settings→ Start Windows Easy Transfer.

2 In the User Account Control dialog box, click Continue.

3 Click Start a new transfer or Continue a transfer in progress.

Follow the instructions provided on the screen by the Windows Easy Transfer 
wizard.
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Setting Up a Printer
 NOTICE: Complete the operating system setup before you connect a printer to 

the computer.

See the documentation that came with the printer for setup information, 
including how to:

• Obtain and install updated drivers.

• Connect the printer to the computer.

• Load paper and install the toner or ink cartridge.

For technical assistance, refer to the printer owner's manual or contact the 
printer manufacturer. 

Printer Cable

Your printer connects to your computer with either a USB cable or a parallel 
cable. Your printer may not come with a printer cable, so if you purchase a 
cable separately, ensure that it is compatible with your printer and computer. 
If you purchased a printer cable at the same time you purchased your 
computer, the cable may arrive in the computer’s shipping box. 

Connecting a USB Printer

 NOTE: You can connect USB devices while the computer is turned on.

1 Complete the operating system setup if you have not already done so.

2 Attach the USB printer cable to the USB connectors on the computer and 
the printer. The USB connectors fit only one way.
Setting Up Your Computer 35

Download from Www.Somanuals.com. All Manuals Search And Download.



book.book  Page 36  Monday, April 14, 2008  4:23 PM
3 Turn on the printer and then turn on the computer. 

4 Depending on your computer’s operating system, a printer wizard may be 
available to help you install the printer driver:

If your computer is running the Windows Vista™ operating system, click the 
Windows Vista Start button , and click Network→ Add a printer to 
start the Add Printer Wizard.

5 Install the printer driver if necessary. See "Reinstalling Drivers and 
Utilities" on page 136 and the documentation that came with your printer.

1 USB connector on computer 2 USB connector on printer

3 USB printer cable

3

2

1
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Power Protection Devices
Several devices are available to protect against power fluctuations and failures:

• Surge protectors

• Line conditioners

• Uninterruptible power supplies (UPS)

Surge Protectors

Surge protectors and power strips equipped with surge protection help prevent 
damage to your computer from voltage spikes that can occur during electrical 
storms or after power interruptions. Some surge protector manufacturers 
include warranty coverage for certain types of damage. Carefully read the device 
warranty when choosing a surge protector. A device with a higher joule rating 
offers more protection. Compare joule ratings to determine the relative 
effectiveness of different devices.

 NOTICE: Most surge protectors do not protect against power fluctuations or 

power interruptions caused by nearby lightning strikes. When lightning occurs in 

your area, disconnect the telephone line from the telephone wall jack and 

disconnect your computer from the electrical outlet.

Many surge protectors have a telephone jack for modem protection. See the 
surge protector documentation for modem connection instructions.

 NOTICE: Not all surge protectors offer network adapter protection. Disconnect the 

network cable from the network wall jack during electrical storms.

Line Conditioners

 NOTICE: Line conditioners do not protect against power interruptions.

Line conditioners are designed to maintain AC voltage at a fairly constant level.
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Uninterruptible Power Supplies

 NOTICE: Loss of power while data is being saved to the hard drive may result in 

data loss or file damage.

 NOTE: To ensure maximum battery operating time, connect only your computer to 

a UPS. Connect other devices, such as a printer, to a separate power strip that 

provides surge protection.

A UPS protects against power fluctuations and interruptions. UPS devices 
contain a battery that provides temporary power to connected devices when 
AC power is interrupted. The battery charges while AC power is available. 
See the UPS manufacturer documentation for information on battery 
operating time and to ensure that the device is approved by Underwriters 
Laboratories (UL).
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Using the Display

Adjusting Brightness
When a Dell™ computer is running on battery power, you can conserve power 
by setting the display brightness to the lowest comfortable setting by pressing 
<Fn> and the up- or down-arrow key on the keyboard.

 NOTE: Brightness key combinations only affect the display on your portable 

computer, not monitors or projectors that you attach to your portable computer. 

If your computer is connected to an external monitor and you try to change the 

brightness level, the Brightness Meter may appear, but the brightness level on the 

external device does not change.

You can press the following keys to adjust display brightness:

• Press <Fn> and the up-arrow key to increase brightness on the integrated 
display only (not on an external monitor).

• Press <Fn> and the down-arrow key to decrease brightness on the 
integrated display only (not on an external monitor).

Using a Projector
When you start the computer with an external device (such as an external 
monitor or projector) attached and turned on, the image may appear on 
either the computer display or the external device.

Press <Fn><F8> to switch the video image between the display only or the 
external device only.
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Making Images and Text Look Bigger or Sharper
 NOTE: If you change the display resolution from the current settings, the image 

may appear blurry or text may be hard to read if you change the resolution to one 

not supported by your computer and display. Before you change any of the display 

settings, make a note of the current settings so you can change back to the 

previous settings if you need to.

You can enhance the legibility of text and change the appearance of images on 
the screen by adjusting display resolution. As you increase resolution, items 
appear smaller on the screen. In contrast, lower resolution causes text and 
images to appear larger and can benefit people with vision impairments. To 
display a program at a specific resolution, both the video card and the display 
must support the program, and the necessary video drivers must be installed.

 NOTE: Use only the Dell-installed video drivers, which are designed to offer the 

best performance with your Dell-installed operating system.

If you choose a resolution or color palette that is higher than the display 
supports, the settings adjust automatically to the closest supported values.

To set the display resolution and refresh rate for your display, perform the 
steps in the following section that corresponds to the operating system your 
computer is using.

Microsoft® Windows® XP

1 Click Start→ Settings→ Control Panel.
2 Under Pick a category, click Appearance and Themes.

3 Under Pick a task..., click the area you want to change, or under or pick a 
Control Panel icon, click Display.

4 In the Display Properties window, click the Settings tab.

5 Try different settings for Color quality and Screen resolution. 

 NOTE: As the resolution increases, icons and text appear smaller on the screen.
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Windows Vista™

1 Click the Windows Vista Start button , and click Control Panel.

2 Under Appearance and Personalization, click Adjust screen resolution.

3 In the Display Settings window, under Resolution, slide the slide bar to 
the left/right to decrease/increase the screen resolution.

4 Click How do I get the best display? for further instructions.

Setting Display Resolution and Refresh Rate
 NOTE: If you change the display resolution from the current settings, the image 

may appear blurry or text may be hard to read if you change the resolution to one 

not supported by your computer and display. Before you change any of the display 

settings, make a note of the current settings so you can change back to the 

previous settings if needed.

You can enhance the legibility of text and change the appearance of images 
on the screen by adjusting display resolution. As you increase resolution, 
items appear smaller on the screen. In contrast, lower resolution causes text 
and images to appear larger and can benefit people with vision impairments. 
To display a program at a specific resolution, both the video card and the display 
must support the program, and the necessary video drivers must be installed.

 NOTE: Use only the Dell-installed video drivers, which are designed to offer the 

best performance with your Dell-installed operating system.

If you choose a resolution or color palette that is higher than the display 
supports, the settings adjust automatically to the closest supported values.

To set the display resolution and refresh rate for your display, perform the 
steps in the following section that corresponds to the operating system your 
computer is using.
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Microsoft Windows XP

1 Click Start→ Settings→ Control Panel.
2 Under Pick a category, click Appearance and Themes.

3 Under Pick a task..., click the area you want to change, or under or pick a 
Control Panel icon, click Display.

4 In the Display Properties window, click the Settings tab.

5 Try different settings for Color quality and Screen resolution. 

 NOTE: As the resolution increases, icons and text appear smaller on the screen.

Windows Vista

1 Click the Windows Vista Start button  and click Control Panel.

2 Under Appearance and Personalization, click Adjust screen resolution.

3 In the Display Settings window, under Resolution, move the slide bar to 
the left or right to decrease or increase the screen resolution.

 NOTE: For additional instructions, click How do I get the best display?
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Using the Keyboard

Numeric Keypad
The numeric keypad functions like the numeric keypad on an external keyboard.

• To enable the keypad, press <Num Lk>. The  light indicates that the 
keypad is active.

• To disable the keypad, press <Num Lk> again. 

Keyboard Illumination
Your computer features keyboard illumination. It has several LEDs built into 
the LCD lid that project light onto the keyboard. By pressing the 
<Fn><→> keys, you may cycle through the following keyboard 
illumination options: 

• Always On

• Always Off 

• Auto Mode

In Auto Mode, the keyboard illumination LEDs automatically turn on or off, 
depending on the ambient light level.

Key Combinations

Keyboard Illumination

System Functions

<Fn> and right-arrow key Toggles the keyboard illumination lights 
on and off

<Ctrl><Shift><Esc> Opens the Task Manager window.

9
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Battery

Power Management

Microsoft® Windows® Logo Key Functions

To adjust keyboard operation, such as the character repeat rate, open the 
Control Panel, click Hardware and Sound, and click Keyboard. 
For information about the Control Panel, see the Windows Help and Support 
Center.

<Fn><F3> Displays the Dell™ QuickSet Battery 
Meter.

<Fn><Esc> Activates a power management mode. 
You can reprogram this keyboard shortcut 
to activate a different power management 
mode using the Advanced tab in the 
Power Options Properties window.

<Fn><F1> Puts the computer into hibernate mode. 
Dell QuickSet is required.

Windows logo key and <m> Minimizes all open windows

Windows logo key and <Shift><m> Restores all minimized windows. This key 
combination functions as a toggle to 
restore minimized windows following the 
use of the Windows logo key and <m> 
key combination. 

Windows logo key and <e> Runs Windows Explorer.

Windows logo key and <r> Opens the Run dialog box.

Windows logo key and <f> Opens the Search Results dialog box.

Windows logo key and <Ctrl><f> Opens the Search Results-Computer 
dialog box (if the computer is connected 
to a network).

Windows logo key and <Pause> Opens the System Properties dialog box.
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Touch Pad
The touch pad detects the pressure and movement of your finger to allow you 
to move the cursor on the display. Use the touch pad and touch pad buttons 
as you would use a mouse.

• To move the cursor, lightly slide your finger over the touch pad.

• To select an object, lightly tap once on the surface of the touch pad or use 
your thumb to press the left touch-pad button.

• To select and move (or drag) an object, position the cursor on the object 
and tap twice on the touch pad. On the second tap, leave your finger on 
the touch pad and move the selected object by sliding your finger over the 
surface. 

• To double-click an object, position the cursor on the object and tap twice on 
the touch pad or use your thumb to press the left touch-pad button twice.

1 touch pad 2 scroll zones

1

2
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Using a Battery

Battery Performance
 NOTE: For information about the Dell warranty for your computer, see the 

Product Information Guide or separate paper warranty document that shipped with 

your computer.

For optimal computer performance and to help preserve BIOS settings, 
operate your Dell™ portable computer with the main battery installed at all 
times. One battery is supplied as standard equipment in the battery bay.

 NOTE: Because the battery may not be fully charged, use the AC adapter to 

connect your new computer to an electrical outlet the first time you use the 

computer. For best results, operate the computer with the AC adapter until the 

battery is fully charged. To view battery charge status, check the Power Meter in 

Power Options Properties (see "Accessing Power Options Properties" on page 52).

Battery operating time varies depending on operating conditions. 

 NOTE: Battery operating time (the time the battery can hold a charge) decreases 

over time. Depending on how often the battery is used and the conditions under 

which it is used, you may need to purchase a new battery during the life of 

your computer.

 NOTE: It is recommended that you connect your computer to an electrical outlet 

when writing to a CD or DVD.

Operating time is significantly reduced when you perform operations 
including, but not limited to, the following:

• Using optical drives.

• Using wireless communications devices, Express Cards, media memory 
cards, or USB devices.

• Using high-brightness display settings, 3D screen savers, or other 
power-intensive programs such as complex 3D graphics applications.

• Running the computer in maximum performance mode. See "Configuring 
Power Management Settings" on page 52 for information about accessing 
Windows Power Options Properties or Dell QuickSet, which you can use 
to configure power management settings.
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You can check the battery charge before you insert the battery into the 
computer. You can also set power management options to alert you when the 
battery charge is low.

 CAUTION: Using an incompatible battery may increase the risk of fire or 
explosion. Replace the battery only with a compatible battery purchased from 
Dell. The battery is designed to work with your Dell computer. Do not use a battery 
from other computers with your computer. 

 CAUTION: Do not dispose of batteries with household waste. When your battery 
no longer holds a charge, call your local waste disposal or environmental agency 
for advice on disposing of a lithium-ion battery. See "Battery Disposal" in the 
Product Information Guide.

 CAUTION: Misuse of the battery may increase the risk of fire or chemical burn. 
Do not puncture, incinerate, disassemble, or expose the battery to temperatures 
above 65°C (149°F). Keep the battery away from children. Handle damaged or 
leaking batteries with extreme care. Damaged batteries may leak and cause 
personal injury or equipment damage. 

Checking the Battery Charge
The Dell QuickSet Battery Meter, the Microsoft Windows Battery Meter window 
and  icon, the battery charge gauge and health gauge, and the low-battery 
warning provide information on the battery charge.

Dell™ QuickSet Battery Meter

If Dell QuickSet is installed, press <Fn><F3> to display the QuickSet 
Battery Meter. The Battery Meter displays status, battery health, charge level, 
and charge completion time for the battery in your computer. 

For more information about QuickSet, right-click the QuickSet icon in the 
taskbar, and click Help.

Microsoft® Windows® Battery Meter

The battery meter indicates the remaining battery charge. To check the Power 
Meter, double-click the  icon on the taskbar. 

If the computer is connected to an electrical outlet, a  icon appears.
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Charge Gauge

By either pressing once or pressing and holding the status button on the 
charge gauge on the battery, you can check:

• Battery charge (check by pressing and releasing the status button)

• Battery health (check by pressing and holding the status button)

The battery operating time is largely determined by the number of times it is 
charged. After hundreds of charge and discharge cycles, batteries lose some 
charge capacity—or battery health. That is, a battery can show a status of 
"charged" but maintain a reduced charge capacity (health). 

Check the Battery Charge

To check the battery charge, press and release the status button on the battery 
charge gauge to illuminate the charge-level lights. Each light represents 
approximately 20 percent of the total battery charge. For example, if the 
battery has 80 percent of its charge remaining, four of the lights are on. If no 
lights appear, the battery has no charge.

Check the Battery Health

 NOTE: You can check battery health in one of two ways: by using the charge gauge 

on the battery as described below and by using the Battery Meter in Dell QuickSet. 

For information about QuickSet, right-click the icon in the taskbar, and click Help.

To check the battery health using the charge gauge, press and hold the status 
button on the battery charge gauge for at least 3 seconds. If no lights appear, 
the battery is in good condition, and more than 80 percent of its original 
charge capacity remains. Each light represents incremental degradation. If 
five lights appear, less than 60 percent of the charge capacity remains, and you 
should consider replacing the battery. 

Low-Battery Warning

 NOTICE: To avoid losing or corrupting data, save your work immediately after a 

low-battery warning. Then connect the computer to an electrical outlet. If the 

battery runs completely out of power, hibernate mode begins automatically.

A pop-up window warns you when the battery charge is approximately 90 percent 
depleted. The computer enters hibernate mode when the battery charge is at 
a critically low level.
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You can change the settings for the battery alarms in QuickSet or the 
Power Options Properties window. See "Configuring Power Management 
Settings" on page 52 for information about accessing QuickSet or the 
Power Options Properties window.

Conserving Battery Power
Perform the following actions to conserve battery power:

• Connect the computer to an electrical outlet when possible because 
battery life is largely determined by the number of times the battery is 
used and recharged.

• Place the computer in standby mode or hibernate mode when you leave 
the computer unattended for long periods of time. See "Power 
Management Modes" on page 50.

• Use the Power Management Wizard or the Power Options Properties 
window to select options to optimize your computer’s power usage. These 
options can also be set to change when you press the power button, close 
the display, or press <Fn><Esc>.

 NOTE: See "Configuring Power Management Settings" on page 52 for information 

on conserving battery power.

Power Management Modes

Standby and Sleep Mode

Standby mode (sleep mode in Microsoft Windows Vista™) conserves power 
by turning off the display and the hard drive after a predetermined period of 
inactivity (a time-out). When the computer exits standby or sleep mode, it 
returns to the same operating state it was in before entering standby or 
sleep mode.

 NOTICE: If your computer loses AC and battery power while in standby or sleep 

mode, it may lose data.

To enter standby mode in Windows XP, click Start→ Turn off computer→ 
Stand by. 
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To enter sleep mode in Windows Vista, click the Windows Vista Start button 
, and then click Sleep.

 NOTE: If your computer is not responding, pressing and holding the power button 

for more than 10 seconds turns it off.

Depending on how you set the power management options in the 
Power Options Properties window or the QuickSet Power Management 
Wizard, you may also use one of the following methods:

• Close the display.

• Press <Fn><Esc>.

To exit standby or sleep mode, press the power button or open the display, 
depending on how you set the power management options. You cannot make the 
computer exit standby or sleep mode by pressing a key or touching the touch pad.

Hibernate Mode

Hibernate mode conserves power by copying system data to a reserved area on 
the hard drive and then completely turning off the computer. When the 
computer exits hibernate mode, it returns to the same operating state it was 
in before entering hibernate mode.

 NOTICE: You cannot remove devices or undock your computer while your 

computer is in hibernate mode.

Your computer enters hibernate mode if the battery charge level becomes 
critically low.

To enter hibernate mode in Windows XP, click the Start button, click Turn off 
computer, press and hold <Shift>, and then click Hibernate.

To enter hibernate mode in Windows Vista, click the Windows Vista Start 
button , and then click Hibernate.

Depending on how you set the power management options in the 
Power Options Properties window or the QuickSet Power Management 
Wizard, you may also use one of the following methods to enter hibernate mode:

• Press the power button.

• Close the display.

• Press <Fn><Esc>.
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 NOTE: Some PC Cards or Express Cards may not operate correctly after the 

computer exits hibernate mode. Remove and reinsert the card (see "Removing an 

ExpressCard or Blank" on page 87), or simply restart (reboot) your computer.

To exit hibernate mode, press the power button. The computer may take a 
short time to exit hibernate mode. You cannot make the computer exit 
hibernate mode by pressing a key or touching the touch pad. For more 
information on hibernate mode, see the documentation that came with your 
operating system.

Configuring Power Management Settings
You can use the QuickSet Power Management Wizard or Windows Power 
Options Properties to configure the power management settings on your 
computer. For more information about QuickSet, right-click the QuickSet 
icon in the taskbar and click Help.

Accessing Power Options Properties

Windows XP

Click Start→ Control Panel→ Performance and Maintenance, and then 
click Power Options

Windows Vista

Click the Windows Vista Start button , click Control Panel, click System 
and Maintenance, and then click Power Options.

Charging the Battery
When you connect the computer to an electrical outlet or install a battery 
while the computer is connected to an electrical outlet, the computer checks 
the battery charge and temperature. If necessary, the AC adapter then charges 
the battery and maintains the battery charge.

 NOTE: You can leave the battery in the computer for as long as you like. The battery’s 

internal circuitry prevents the battery from overcharging.

If the battery is hot from being used in your computer or being in a hot 
environment, the battery may not charge when you connect the computer to 
an electrical outlet.
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The battery is too hot to start charging if the  light flashes alternately blue 
and orange. Disconnect the computer from the electrical outlet and allow the 
computer and the battery to cool to room temperature. Then connect the 
computer to an electrical outlet to continue charging the battery.

For information about resolving problems with a battery, see "Power Problems" 
on page 128.

Removing the Battery
 CAUTION: Using an incompatible battery may increase the risk of fire or 

explosion. Replace the battery only with a compatible battery purchased from 
Dell. The battery is designed to work with your Dell™ computer. Do not use a 
battery from other computers with your computer. 

 CAUTION: Before performing these procedures, turn off the computer, disconnect 
the AC adapter from the electrical outlet and the computer, disconnect the modem 
from the wall connector and computer, and remove any other external cables from 
the computer.

 NOTICE: You must remove all external cables from the computer to avoid possible 

connector damage.

 NOTICE: Do not replace the battery with the computer in standby mode. If you do, 

the computer shuts down and loses any unsaved data.

To remove the battery:

1 Ensure that the computer is turned off.

2 Slide the battery-bay latch release on the bottom of the computer, and 
then remove the battery from the bay.

To replace the battery, follow the removal procedure in reverse order.

Storing a Battery
Remove the battery when you store your computer for an extended period of 
time. A battery discharges during prolonged storage. After a long storage 
period, recharge the battery fully (see "Charging the Battery" on page 52) 
before you use it.
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Using the Camera
The camera is integrated in the computer display. The camera and its 
integrated digital microphones allow you to take photos and videos and to 
communicate visually and verbally with other computer users. The blue 
camera light appears when the camera is turned on. For more information 
about camera features, see "Specifications" on page 171. 

 NOTE: It is normal for the camera to feel warm to the touch when the computer is 

running and when the camera is in use.

Accessing the Camera’s Help File
To access the camera’s Video Software Help file, right-click the icon in the 
notification area and click Launch Webcam Center. Click Help from the 
menu and select Contents.

1 camera 2 camera indicator 3 digital microphones (2)

1

3

2
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Manually Adjusting the Camera Settings
If you do not want the camera to use automatic settings, you can manually 
adjust the camera settings.

1 Right-click the icon in the notification area and click 
Launch Webcam Console.

2 In the Webcam Console window:

• Click the Camera tab to adjust video settings, such as contrast and 
brightness.

• Click the Effects tab to adjust audio settings, such as the volume level.

For more information about camera settings and other camera-related topics, 
see the camera’s Video Software Help file (see "Accessing the Camera’s Help 
File" on page 55).

Creating a Picture or a Video
1 Click the icon in the notification area and click QuickCapture.

The QuickCapture window appears and the blue camera light turns on. 
You can now direct the camera to point at the object or person that you 
want to record. The QuickCapture window on the screen shows you the 
camera target view.

2 To take a picture, click Take a Picture.

To record a video, click Record a Video. 

Unless you designate a different location, the picture or video is 
automatically saved to the My Pictures folder on your hard drive. 

For more information about creating pictures or videos, see the camera’s 
Video Software Help file (see "Accessing the Camera’s Help File" on page 55).
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Using GamePanel
The Logitech® GamePanel™ is a small secondary monochrome LCD for 
displaying text and graphical information located at the top right hand corner 
of the dashboard. This shows important gaming information such as frames 
per second, health and so on, without cluttering the main display. It can also 
display non-gaming information such as memory utilization, CPU utilization, 
and so on.

You can modify the GamePanel settings through the LCD Manager. To access 
the LCD Manager, click Start  → All Programs →Logitech → Launch 
LCD Manager.

1 GamePanel 2 GamePanel toggle button 3 GamePanel control buttons

2

1

3
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The GamePanel toggle button lets you toggle among the various applications 
provided by the GamePanel.

You can use the first two buttons of the GamePanel control buttons to navigate 
between values and options in the LCD Manager tabs.The third and fourth 
buttons are used for confirming and cancelling the value selections respectively.

For more information on using the GamePanel, see the Help in the LCD 
Manager interface.

GamePanel Applications
The GamePanel has the following applications:

• A clock with integrated counter for unread mail

• A multimedia display which shows the track/artist/URL of currently 
playing multimedia for Windows Media Player, iTunes and Winamp.

• A countdown application, which offers stopwatch and egg timer functionality.

• A performance monitor, which graphs the CPU and memory utilization.

• A POP3 email application, which periodically checks the content of a 
POP3 mail account and allows a preview of new/unread email.
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Using Multimedia

Playing Media
 NOTICE: Do not press down on the optical drive tray when you open or close it. 

Keep the tray closed when you are not using the drive.

 NOTICE: Do not move the computer while playing media.

1 Press the eject button on the front of the drive.

2 Place the disc, label side up, in the center of the tray and snap the disc 
onto the spindle.

3 Push the tray back into the drive.
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To format media for storing or copying data, see the media software that 
came with your computer.

 NOTE: Ensure that you follow all copyright laws when copying media.

A CD player includes the following basic buttons:

A DVD player includes the following basic buttons:

For more information on playing media, click Help on the media player 
(if available).

Play.

Move backward within the current track.

Pause.

Move forward within the current track.

Stop.

Go to the previous track.

Eject.

Go to the next track.

Stop.

Restart the current chapter.

Play.

Fast forward.

Pause.

Fast reverse.

Advance a single frame while in pause mode.

Go to the next title or chapter.

Continuously play the current title or chapter.

Go to the previous title or chapter.

Eject.
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Playing Media Using Dell Express Card 
Remote Control (Optional)
The Dell Express Card remote control is designed to control Dell Media 
Direct and Windows Vista™ Media Center. It can work only with specified 
computers. For more details, refer to the Dell Support website at 
support.dell.com.

To play media using Dell Express Card remote control:

1 Install a coin-cell battery into your Express Card remote control.

2 Launch Windows Vista™ Media Center from Start  → Programs.

3 Use the remote control buttons to play media.
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Copying CD, DVD, and Blu-ray Disc™ (BD) Media
 NOTE: Ensure that you observe all copyright laws while copying media.

 NOTE: The types of optical drives offered by Dell may vary by country.

This section applies only to computers that have a DVD+/-RW, Combo, or 
BD-RE drive.

The following instructions explain how to make an exact copy of a CD, DVD or 
BD using Roxio Creator. You can also use Roxio Creator for other purposes, such 
as creating music CDs from audio files stored on your computer or backing up 
important data. For help, open Roxio Creator, and then press <F1>.

The DVD drives and BD drives installed in Dell computers do not support 
HD-DVD media. For a list of supported media formats, see "Using Blank CD, 
DVD, and BD Media" on page 63.

1 Infrared Transmitter 2 Arrow Up

3 OK/Enter/Select 4 Arrow Right

5 Arrow Down 6 Play/Pause

7 Forward 8 Skip Forward

9 Stop 10 Skip Back

11 Reverse 12 Back

13 Arrow Left 14 Mute 

15 Volume Down 16 Page Down

17 Volume Up 18 Page Up
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How to Copy a CD, DVD or BD

 NOTE: Most commercial DVDs and BDs have copyright protection and cannot be 

copied using Roxio Creator Plus.

 NOTE: BD media can only be copied to other BD media.

 NOTE: Copying a BD-R to BD-RE does not produce an exact copy.

1 Click Start  → All Programs → Roxio Creator→ Projects → Copy.
2 Under the Copy tab, click Copy Disc.

3 To copy the CD, DVD or BD:

• If you have one optical drive, insert the source disc into the drive, 
ensure that the settings are correct, and then click the Copy Disc 
button to continue. The computer reads your source disc and copies 
the data to a temporary folder on your computer hard drive.

When prompted, insert a blank disc into the drive and click OK.

• If you have two optical drives, select the drive into which you have 
inserted your source disc and click the Copy Disc button to continue. 
The computer copies the data from the source disc to the blank disc.

Once you have finished copying the source disc, the disc that you have 
created automatically ejects.

Using Blank CD, DVD, and BD Media

DVD-writable drives can write to both CD and DVD recording media. 
BD-writable drives can write to CD, DVD and BD recording media.

Use blank CD-Rs to record music or permanently store data files. After 
creating a CD-R, you cannot write to that CD-R again (see the Sonic 
documentation for more information). Use a blank CD-RW if you plan to 
erase, rewrite, or update information on that disc later.

Blank DVD+/-R or BD-R media can be used to permanently store large 
amounts of information. After you create a DVD+/-R or BD-R, you may not 
be able to write to that disc again if the disc is finalized or closed during the 
final stage of the disc creation process. Use blank DVD+/-RW or BD-RE 
media if you plan to erase, rewrite, or update information on that disc later.
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DVD-Writable and Combo Drives

Blu-Ray Drives

Helpful Tips

• Use Microsoft® Windows® Explorer to drag and drop files to a CD-R or 
CD-RW only after you start Roxio Creator and open a Creator project.

• Do not burn a blank CD-R or CD-RW to its maximum capacity; for 
example, do not copy a 650-MB file to a blank 650-MB CD. The CD-RW 
drive needs 1–2 MB of the blank space to finalize the recording. 

Media Type Read Write Rewritable

CD-R Yes Yes No

CD-RW Yes Yes Yes

DVD+R Yes Yes No

DVD-R Yes Yes No

DVD+RW Yes Yes Yes

DVD-RW Yes Yes Yes

DVD+R DL Yes Yes No

DVD-R DL Yes Yes No

Media Type Read Write Rewritable

CD-R Yes Yes No

CD-RW Yes Yes Yes

DVD+R Yes Yes No

DVD-R Yes Yes No

DVD+RW Yes Yes Yes

DVD-RW Yes Yes Yes

DVD+R DL Yes Yes No

DVD-R DL Yes No No

BD-R Yes Yes No

BD-RE Yes Yes Yes
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• Use CD-Rs to burn music CDs that you want to play in regular stereos. 
CD-RWs do not play in most home or car stereos.

• Music MP3 files can be played only on MP3 players or on computers that 
have MP3 software installed.

• Use a blank CD-RW to practice CD recording until you are familiar with 
CD recording techniques. If you make a mistake, you can erase the data on 
the CD-RW and try again. You can also use blank CD-RWs to test music 
file projects before you record the project permanently to a blank CD-R.

• You cannot create audio DVDs with Roxio Creator.

• Commercially available DVD players used in home theater systems may 
not support all available DVD formats. For a list of formats supported by 
your DVD player, see the documentation provided with your DVD player 
or contact the manufacturer.

• Commercially available BD players used in home theater systems may not 
support all available BD formats. For a list of formats supported by your 
BD player, see the documentation provided with your BD player or contact 
the manufacturer.

• See the Roxio website at www.sonic.com.

Adjusting the Volume
 NOTE: When the speakers are muted, you do not hear the media playing.

1 Right-click the volume icon in the notification area.

2 Click Open Volume Mixer.

3 Click and drag the bar to slide it up or down to increase or decrease the volume.

For more information on volume control options, click Help in the 
Volume Mixer window.

The Volume Meter displays the current volume level, including mute, on your 
computer. Either click the QuickSet icon in the notification area and select or 
deselect Disable On Screen Volume Meter, or press the volume control 
buttons to enable or disable the Volume Meter on the screen.

You can also use the media control buttons on the front of the computer to 
adjust the volume (see "Media control buttons" on page 22).
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Adjusting the Picture
If an error message notifies you that the current resolution and color depth 
are using too much memory and preventing media playback, adjust the 
display properties:

Windows XP 

1 Click Start→ Control Panel→ Appearance and Themes.

2 Under Pick a task..., click Change the screen resolution.
3 Under Screen resolution, click and drag the bar to reduce the 

resolution setting.

4 In the drop-down menu under Color quality, click Medium (16 bit) and 
click OK.

Windows Vista™

1 Click the Windows Vista Start button , click Control Panel, and then 
click Appearance and Personalization.

2 Under Personalization, click Adjust Screen Resolution.

The Display Properties window appears.

3 Under Resolution: click and drag the bar to reduce the resolution setting.

4 In the drop-down menu under Colors:, click Medium (16 bit).

5 Click OK.
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Using Dell MediaDirect™ 

Dell MediaDirect is an instant-on multimedia playback mode for digital 
media. Press the Dell MediaDirect button, located on the hinge cover, to 
launch Dell MediaDirect. 

If the computer is turned on or in standby or sleep mode

If you press the Dell MediaDirect button while the computer is turned on or 
in standby (Windows XP) or sleep (Windows Vista) mode, either Windows 
Media Center Manager or Dell Media Experience launches, depending on 
your system setup. If both applications are present, Windows Media Center 
Manager launches.

If the computer is turned off or in hibernate mode

When your computer is turned off or in hibernate mode, you can press the 
Dell MediaDirect button to start the computer and automatically launch the 
Dell MediaDirect application. 

1 Dell MediaDirect button

1
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 NOTE: If you voluntarily reformat the hard drive, reinstall Dell MediaDirect using 

the MediaDirect re-installation media that was shipped with your computer. For 

more information, see the Reinstalling Dell MediaDirect techsheet that 

accompanied your computer.

For more information on using Dell MediaDirect, use the Help menu in the 
Dell MediaDirect application.

Connecting Your Computer to a TV or 
Audio Device

 NOTE: Video and audio cables for connecting your computer to a TV or other audio 

device may not be included with your computer. Cables and TV/digital audio 

adapter cables are available for purchase from Dell.

Your computer has an S-video TV-out and DVI-I connector that, together 
with a standard S-video cable, a composite video adapter cable, a component 
video adapter cable (available from Dell), or a DVI to HDMI adaptor cable 
(available from Dell), enable you to connect the computer to a TV.

Your TV has either an S-video input connector, a composite video-input 
connector, a component video-input connector, or an HDMI connector. 
Depending on what type of connector is available on your TV, you can use a 
commercially available S-video cable, composite video cable, component video 
cable, or DVI to HDMI adaptor cable to connect your computer to your TV. 
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1 S-video TV-out connector 2 S-video connector

1 S-video TV-out connector 2 composite video adapter

3 S/PDIF digital audio connector 4 composite video-output connector

5 S-video connector

1 S-video TV-out connector 2 component video adapter

3 S/PDIF digital audio connector 4 Pr (red) component video-output 

connector

5 Pb (blue) component video-output 

connector

6 Y (green) component video-output 

connector

1 2

5

4

3
21

5

4

3

1 2

6
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If you want to connect your computer to a TV or audio device, it is 
recommended that you connect video and audio cables to your computer in 
one of the following combinations:

• S-video and standard audio

• Composite video and standard audio

• Component-out video and standard audio

• DVI to HDMI adaptor cable and standard audio

 NOTE: See the diagrams at the beginning of each subsection to help you determine 

which method of connection you should use.

When you finish connecting the video and audio cables between your 
computer and your TV, you must enable your computer to work with the TV. 
See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV. Additionally, if you are 
using S/PDIF digital audio, see "Enabling S/PDIF Digital Audio" on page 82.

S-Video and Standard Audio

1 audio connector 2 S-video TV-out connector

1

2
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

 NOTE: If your TV or audio device supports S-video but not S/PDIF digital 

audio, you can connect an S-video cable directly to the S-video TV-out 

connector on the computer (without the TV/digital audio adapter cable).

2 Plug one end of the S-video cable into the S-video output connector on 
the computer.

3 Plug the other end of the S-video cable into the S-video input connector 
on your TV.

4 Plug the single-connector end of the audio cable into the headphone 
connector on your computer.

5 Plug the two RCA connectors on the other end of the audio cable into the 
audio input connectors on your TV or other audio device.

6 Turn on the TV and any audio device that you connected (if applicable), 
and then turn on the computer.

7 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

1 standard S-video cable 2 standard audio cable

1

2
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S-Video and S/PDIF Digital Audio

1 S-video TV-out connector 2 composite video adapter

1 composite video adapter 2 S-video cable 3 S/PDIF digital audio cable

1 2

1

2

3

72 Using Multimedia

Download from Www.Somanuals.com. All Manuals Search And Download.



book.book  Page 73  Monday, April 14, 2008  4:23 PM
1 Turn off the computer and the TV and/or the audio device that you want 
to connect.

2 Connect the composite video adapter to the S-video TV-out connector on 
your computer.

3 Plug one end of the S-video cable into the S-video output connector on 
the composite video adapter.

4 Plug the other end of the S-video cable into the S-video input connector 
on the TV.

5 Plug one end of the S/PDIF digital audio cable into the digital audio 
connector on the composite video adapter cable.

6 Plug the other end of the S/PDIF digital audio cable into the audio input 
connector on your TV or audio device.

7 Turn on the TV, turn on any audio device that you connected (if 
applicable), and then turn on the computer.

8 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

1 composite video adapter 2 S-video cable

1 composite video adapter 2 S/PDIF digital audio cable

1 2

1 2
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Composite Video and Standard Audio

1 audio input connector 2 S-video TV-out connector

3 composite video adapter

1 composite video adapter 2 composite video cable

3 standard audio cable

2

1

3

1

2

3
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

2 Connect the composite video adapter to the S-video TV-out connector on 
your computer.

3 Plug one end of the composite video cable into the composite video-output 
connector on the composite video adapter.

4 Plug the other end of the composite video cable into the composite 
video-input connector on the TV.

5 Plug the single-connector end of the audio cable into the headphone 
connector on the computer.

6 Plug the two RCA connectors on the other end of the audio cable into the 
audio input connectors on your TV or other audio device.

7 Turn on the TV, turn on any audio device that you connected (if applicable), 
and then turn on the computer.

8 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

1 composite video adapter 2 composite video cable

2

1
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Composite Video and S/PDIF Digital Audio

1 S-video TV-out connector 2 composite video adapter

1 composite video adapter 2 composite video cable

3 standard audio cable

1 2

1

2

3
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

2 Connect the composite video adapter to the S-video TV-out connector on 
the computer.

3 Plug one end of the composite video cable into the composite video-input 
connector on the composite video adapter.

4 Plug the other end of the composite video cable into the composite 
video-input connector on the TV.

5 Plug one end of the S/PDIF digital audio cable into the S/PDIF audio 
connector on the composite video adapter.

6 Plug the other end of the digital audio cable into the S/PDIF input 
connector on your TV or other audio device.

7 Turn on the TV, turn on any audio device that you connected (if applicable), 
and then turn on the computer.

8 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

1 composite video adapter 2 composite video cable

1 composite video adapter 2 S/PDIF digital audio cable

2

1

1 2
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Component Video and Standard Audio

1 S-video TV-out connector 2 component video adapter 

1 component video adapter 2 component video cable

3 standard audio cable

21

1

2

3
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

2 Connect the component video adapter to the S-video TV-out connector on 
your computer.

3 Plug all three ends of the component video cable into the component 
video-output connectors on the component video adapter. Make sure that 
the red, green, and blue colors of the cable match the corresponding 
adapter ports.

4 Plug all three connectors from the other end of the component video cable 
into the component video-input connectors on the TV. Make sure that the 
red, green, and blue colors of the cable match the colors of the TV input 
connectors.

5 Plug the single-connector end of the audio cable into the headphone 
connector on the computer. 

6 Plug the two RCA connectors on the other end of the audio cable into the 
audio input connectors on your TV or audio device.

7 Turn on the TV, turn on any audio device that you connected (if applicable), 
and then turn on the computer.

8 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

1 component video adapter 2 component video cable

21
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Component Video and S/PDIF Digital Audio

1 S-video TV-out connector 2 component video adapter 

1 component video adapter 2 component video cable

3 standard audio cable

1 2

1

2

3
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

2 Connect the component video adapter to the S-video TV-out connector on 
the computer.

3 Plug all three ends of the component video cable into the component 
video-output connectors on the component video adapter. Make sure that the 
red, green, and blue colors of the cable match the corresponding adapter ports.

4 Plug all three connectors from the other end of the component video cable 
into the component video-input connectors on the TV. Make sure that 
the red, green, and blue colors of the cable match the colors of the 
TV input connectors.

5 Plug one end of the S/PDIF digital audio cable into the S/PDIF audio 
connector on the component video adapter.

6 Plug the other end of the digital audio cable into the S/PDIF input 
connector on your TV or other audio device.

1 component video adapter 2 component video-output connectors

3 component video cable

1 component video adapter 2 S/PDIF digital audio cable

31

2

2

1
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7 Turn on the TV, turn on any audio device that you connected (if applicable), 
and then turn on the computer.

8 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

Enabling S/PDIF Digital Audio

1 Double-click the speaker icon in the Windows notification area.

2 Click the Options menu and then click Advanced Controls.

3 Click Advanced.

4 Click S/PDIF Interface.

5 Click Close.

6 Click OK.

DVI to HDMI and Standard Audio

1 audio connector 2 DVI connector

1 DVI connector 2 HDMI connector

1

2

2
1
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1 Turn off the computer and the TV and/or audio device that you want to 
connect.

2 Plug the DVI end of the DVI to HDMI adaptor cable into the DVI-I 
connector on the computer.

3 Plug the other end of the DVI to HDMI adaptor cable into the HDMI 
connector on your TV.

4 Plug the single-connector end of the audio cable into the headphone 
connector on your computer.

5 Plug the two RCA connectors on the other end of the audio cable into the 
audio input connectors on your TV or other audio device.

6 Turn on the TV and any audio device that you connected (if applicable), 
and then turn on the computer.

7 See "Enabling the Display Settings for a TV" on page 83 to ensure that the 
computer recognizes and works properly with the TV.

Enabling the Display Settings for a TV

 To ensure that the display options appear correctly, connect the TV to the computer 

before you enable the display settings.

Windows XP 

1 Click the Start button, point to Settings, and then click Control Panel.

2 Double-click Display and click the Settings tab. 

3 Click Advanced.

4 Click the tab for your video card.

 NOTE: To determine the type of video card installed in your computer, see the 

Windows Help and Support Center. To access the Help and Support Center, click 

Start→ Help and Support. Under Pick a Task, click Use Tools to view your computer 

information and diagnose problems. Then, under My Computer Information, select 

Hardware. 

5 In the display devices section, select the appropriate option for using 
either a single display or multiple displays, ensuring that the display 
settings are correct for your selection.
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Windows Vista

1 Click the Windows Vista Start button , click Control Panel, and then 
click Appearance and Personalization.

2 Under Personalization, click Adjust Screen Resolution.

The Display Properties window appears.

3 Click Advanced.

4 Click the tab for your video card.

 NOTE: To determine the type of video card installed in your computer, see the 

Windows Help and Support Center. To access the Help and Support Center in 

Windows Vista, click the Windows Vista Start button  → Help and Support. 

Under Pick a Task, click Use Tools to view your computer information and diagnose 

problems. Then, under My Computer Information, select Hardware. 

5 In the display devices section, select the appropriate option for using 
either a single display or multiple displays, ensuring that the display 
settings are correct for your selection.
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Using Cards

ExpressCards
ExpressCards provide additional memory, wired and wireless communications, 
multimedia and security features. For example, you can add an ExpressCard 
to make wireless wide area network (WWAN) connectivity available on your 
computer.

ExpressCards support two form factors:

• ExpressCard/34 (34 mm wide)

• ExpressCard/54 (54 mm wide in an L-shape with a 34 mm connector)

The 34 mm card fits into both the 34 mm and 54 mm card slots. The 54 mm 
card only fits into a 54 mm card slot.

See "Specifications" on page 171 for information on supported ExpressCards.

 NOTE: An ExpressCard is not a bootable device.

1 ExpressCard/34 2 ExpressCard/54

1 2
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ExpressCard Blanks

Your computer shipped with a plastic blank installed in the ExpressCard slot. 
Blanks protect unused slots from dust and other particles. Save the blank for 
use when no ExpressCard is installed in the slot; blanks from other computers 
may not fit your computer.

Remove the blank before installing an ExpressCard. To remove the blank, see 
"Removing an ExpressCard or Blank" on page 87.

Installing an ExpressCard

You can install an ExpressCard while the computer is running. The computer 
automatically detects the card.

ExpressCards are generally marked with a symbol (such as a triangle or an 
arrow) or a label to indicate which end to insert into the slot. The cards are 
keyed to prevent incorrect insertion. If card orientation is not clear, see the 
documentation that came with the card. 

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

To install an ExpressCard:

1 Hold the card with the top side of the card facing up.

2 Slide the card into the slot until the card is completely seated in its 
connector. 

If you encounter too much resistance, do not force the card. Check the 
card orientation and try again.
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The computer recognizes the ExpressCard and automatically loads the 
appropriate device driver. If the configuration program tells you to load the 
manufacturer's drivers, use the media that came with the ExpressCard.

Removing an ExpressCard or Blank

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

Press the latch and remove the card or blank. For some latches, you must press 
the latch twice, once to pop the latch out, and then a second time to pop the 
card out.

Save a blank to use when no ExpressCard is installed in a slot. Blanks protect 
unused slots from dust and other particles.
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Memory Card Reader
The memory card reader provides a fast and convenient way to view and share 
digital photos, music, and videos stored on a memory card.

 NOTE: A memory card is not a bootable device.

The 8-in-1 memory card reader reads the following memory cards:

• Secure Digital (SD)

• SDIO

• MultiMediaCard (MMC)

• Memory Stick

• Memory Stick PRO

• xD-Picture Card

• Hi Speed-SD

• Hi Density-SD
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Memory Card Blanks

Your computer shipped with a plastic blank installed in the memory card 
reader. Blanks protect unused slots from dust and other particles. Save the 
blank for use when no media memory card is installed in the slot; blanks from 
other computers may not fit your computer.

Remove the blank before installing a media memory card. To remove the 
blank, see "Removing a Memory Card or Blank" on page 90.

Installing a Memory Card

You can install a media memory card in the computer while the computer is 
running. The computer automatically detects the card.

Memory cards are generally marked with a symbol (such as a triangle or an 
arrow) or a label to indicate which end to insert into the slot. The cards are 
keyed to prevent incorrect insertion. If card orientation is not clear, see the 
documentation that came with the card. 

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

To install a memory card:

1 Hold the card with the top side of the card facing up. 

2 Slide the card into the slot until the card is completely seated in its 
connector. 

If you encounter too much resistance, do not force the card. Check the 
card orientation and try again. 
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The computer recognizes the memory card and automatically loads the 
appropriate device driver. If the configuration program tells you to load the 
manufacturer's drivers, use the media that came with the memory card, 
if applicable. 

Removing a Memory Card or Blank

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTICE: Use the memory card configuration utility (click the  icon in the 

notification area) to select a card and stop it from functioning before you remove it 

from the computer. If you do not stop the card in the configuration utility, you could 

lose data. 

Press the card into the slot to release it from the card reader. When it is 
partially ejected, remove the card. 
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Setting Up and Using Networks
Setting up a computer network provides connectivity between your computer 
and the Internet, another computer, or a network. For example, with a 
network set up in a home or small office you can print to a shared printer, 
access drives and files on another computer, browse other networks, or access 
the Internet. You can set up a local area network (LAN) using a network or 
broadband modem cable or set up a wireless LAN (WLAN). 

The Microsoft® Windows® XP and Microsoft Windows Vista™ operating 
systems provide wizards to help guide you through the process of networking 
computers. For more information about Networking, see the Windows Help 
and Support Center (see "Microsoft Windows XP and Windows Vista Help 
and Support Center" on page 16).

Connecting a Network or Broadband 
Modem Cable
Before you connect your computer to a network, the computer must have a 
network adapter installed and a network cable connected to it.

1 Connect the network cable to the network adapter connector on the back 
of your computer.

 NOTE: Insert the cable connector until it clicks into place, and then gently 

pull on the cable to ensure that it is securely attached.

2 Connect the other end of the network cable to a network connection 
device or a network wall connector.

 NOTE: Do not use a network cable with a telephone wall connector.
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Setting Up a Network

Windows XP

1 Click Start→ All Programs→ Accessories→ Communications→ Network 
Setup Wizard→ Next→ Checklist for creating a network.

 NOTE: Selecting the connection method labeled This computer connects 

directly to the Internet enables the integrated firewall provided with 

Windows XP Service Pack 2 (SP2).

2 Complete the checklist.

3 Return to the Network Setup Wizard and follow the instructions in the 
wizard.
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Windows Vista

1 Click the Windows Vista Start button ,  and then click Connect To→ 
Set up a connection or network.

2 Select an option under Choose a connection option.

3 Click Next, and then follow the instructions in the wizard.

Wireless Local Area Network
A wireless local area network (WLAN) is a series of interconnected computers 
that communicate with each other over the air waves rather than through a 
network cable connected to each computer. In a WLAN, a radio 
communications device called an access point or wireless router connects 
network computers and provides Internet, or network access. The access 
point or wireless router and the wireless network card in the computer 
communicate by broadcasting data from their antennas over the air waves.

What You Need to Establish a WLAN Connection

Before you can set up a WLAN, you need:

• High-speed (broadband) Internet access (such as cable or DSL)

• A broadband modem that is connected and working

• A wireless router or access point

• A wireless network card for each computer that you want to connect to 
your WLAN

Checking Your Wireless Network Card

Depending on what you selected when you purchased your computer, the 
computer has a variety of configurations. To confirm that your computer has 
a wireless network card and to determine the type of card:

• Start button and Connect To option

• Check the order confirmation for your computer
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Start Button and Connect To Option

In Microsoft Windows XP, click Start→ Connect To→ Show all connections.

 NOTE: If your computer is set to the Classic Start menu option, click Start→ 

Settings→ Network Connections to view your network connections. 

In Microsoft Windows Vista, click → Connect To→ View network 
computers and devices.

If Wireless Network Connection does not appear under LAN or High-Speed 
Internet, you may not have a wireless network card.

If Wireless Network Connection appears, you have a wireless network card. 
To view detailed information about the wireless network card:

1 Right-click Wireless Network Connection.

2 Click Properties.

The Wireless Network Connection Properties window appears. 
The wireless network card’s name and model number are listed on the 
General tab.

 NOTE: If Wireless Network Connection does not appear, you may not have a 

wireless network card. 

The Order Confirmation for Your Computer

The order confirmation that you received when you ordered your computer 
lists the hardware and software that shipped with your computer.

Setting Up a New WLAN Using a Wireless Router and a 
Broadband Modem

1 Contact your Internet service provider (ISP) to obtain specific information 
about the connection requirements for your broadband modem.

2 Ensure that you have wired Internet access through your broadband 
modem before you attempt to set up a wireless Internet connection (see 
"Connecting a Network or Broadband Modem Cable" on page 91).

3 Install any software required for your wireless router. Your wireless router 
may have been shipped with installation media. Installation media usually 
contains installation and troubleshooting information. Install the required 
software according to the instructions provided by the router 
manufacturer. 
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4 Shut down your computer and any other wireless-enabled computers in the 
vicinity through the Windows Vista Start button , or Start→ Shutdown 
in Windows XP.

5 Disconnect your broadband modem power cable from the electrical outlet.

6 Disconnect the network cable from the computer and the modem.

7 Disconnect the AC adapter cable from your wireless router to ensure that 
there is no power connected to the router.

 NOTE: Wait for a minimum of 5 minutes after disconnecting your broadband 

modem before continuing with the network setup.

8 Insert a network cable into the network (RJ-45) connector on the 
unpowered broadband modem.

9 Connect the other end of the network cable into the Internet network (RJ-45) 
connector on the unpowered wireless router.

10 Ensure that no network or USB cables, other than the network cable 
connecting the modem and the wireless router, are connected to the 
broadband modem.

 NOTE: Restart your wireless equipment in the order described below to 

prevent a potential connection failure.

11 Turn on only your broadband modem and wait for at least 2 minutes for 
the broadband modem to stabilize. After 2 minutes, proceed to step 12.

12 Turn on your wireless router and wait for at least 2 minutes for the wireless 
router to stabilize. After 2 minutes, proceed to the step 13.

13 Start your computer and wait until the boot process completes.

14 See the documentation that came with your wireless router to do the 
following in order to set up the wireless router:

• Establish communication between your computer and your wireless router.

• Configure your wireless router to communicate with your broadband 
router.

• Find out your wireless router’s broadcast name. The technical term for 
the name of your router’s broadcast name is Service Set Identifier (SSID) 
or network name.

15 If necessary, configure your wireless network card to connect to the wireless 
network (see "Connecting to a WLAN" on page 96).
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Connecting to a WLAN

 NOTE: Before you connect to a WLAN, ensure that you have followed the 

instructions in "Wireless Local Area Network" on page 93.

 NOTE: The following networking instructions do not apply to internal cards with 

Bluetooth® wireless technology or cellular products.

This section provides general procedures for connecting to a network using 
wireless technology. Specific network names and configuration details vary. 
See "Wireless Local Area Network" on page 93 for more information about 
how to prepare for connecting your computer to a WLAN. 

Your wireless network card requires specific software and drivers for 
connecting to a network. The software is already installed. 

 NOTE: If the software is removed or corrupted, follow the instructions in the user 

documentation for your wireless network card. Verify the type of wireless network 

card installed in your computer and then search for that name on the Dell™ Support 

website at support.dell.com. For information on the type of wireless network card that 

is installed in your computer, see "Checking Your Wireless Network Card" on page 93.

When you turn on your computer and a network (for which your computer is 
not configured) is detected in the area, a pop-up appears near the network 
icon in the Windows notification area. 

To connect to the network:

1 Click Start , and then click Network.

2 Click Network and Sharing on the navigation bar at the top of the 
Network folder.

3 Click Connect to a network under Tasks.

4 Select your network from the list and click Connect.

Once you have configured your computer for a wireless network, another pop-up 
notifies you that your computer is connected to that network.

Thereafter, whenever you log on to your computer within the range of the 
wireless network that you selected, the same pop-up notifies you of the 
wireless network connection. 

 NOTE: If you select a secure network, you must enter a WEP or WPA key when 

prompted. Network security settings are unique to your network. Dell cannot 

provide this information. 

 NOTE: Your computer can take up to 1 minute to connect to the network. 
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Determining the Wireless Network Device Manager

Depending on the software installed on your computer, different wireless 
configuration utilities may manage your network devices:

• Your wireless network card’s client utility

• The Windows XP or Windows Vista operating system

To determine which wireless configuration utility is managing your wireless 
network card in Windows XP: 

1 Click Start→ Settings→ Control Panel→ Network Connections.
2 Right-click the Wireless Network Connection icon, and then click View 

Available Wireless Networks.

If the Choose a wireless network window states Windows cannot configure 
this connection, the wireless network card’s client utility is managing the 
wireless network card.

If the Choose a wireless network window states Click an item in the list 
below to connect to a wireless network in range or to get more information, 
the Windows XP operating system is managing the wireless network card.

To determine which wireless configuration utility is managing your wireless 
network card in Windows Vista: 

1 Click → Connect To→ Manage wireless networks.

2 Double-click a profile to open the wireless network properties screen.

For specific information about the wireless configuration utility installed on 
your computer, see your wireless network documentation in the Windows 
Help and Support Center (see "Microsoft Windows XP and Windows Vista 
Help and Support Center" on page 16).

Completing the Connection to the WLAN

When you turn on your computer and a network (for which your computer is 
not configured) is detected in the area, a pop-up appears near the network 
icon in the notification area (in the lower-right corner of the Windows desktop). 

Follow the instructions provided in any utility prompts that appear on 
your screen.

Once you have configured your computer for the wireless network that you 
selected, another pop-up notifies you that your computer is connected to that 
network. 
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Thereafter, whenever you log on to your computer within the range of the 
wireless network that you selected, the same pop-up notifies you of the 
wireless network connection. 

 NOTE: If you select a secure network, you must enter a WEP or WPA key when 

prompted. Network security settings are unique to your network. Dell cannot 

provide this information. 

 NOTE: Your computer can take up to 1 minute to connect to the network. 

Monitoring the Status of the Wireless Network Card Through Dell QuickSet

The wireless activity indicator provides you with an easy way to monitor the 
status of your computer’s wireless devices. To turn the wireless activity indicator 
on or off, click the QuickSet icon in the taskbar and select Hotkey Popups. 
IfWireless Activity Indicator Off is not checked, the indicator is on. If 
Wireless Activity Indicator Off is checked, the indicator is off.

The wireless activity indicator displays whether your computer’s integrated 
wireless devices are enabled or disabled. When you turn the wireless networking 
function on or off, the wireless activity indicator changes to display the status. 

For more information about the Dell QuickSet wireless activity indicator, 
right-click the QuickSet icon in the taskbar, and then select Help.

Mobile Broadband (or Wireless Wide Area 
Network)
A Mobile Broadband network, also known as a Wireless Wide Area Network 
(WWAN), is a high-speed digital cellular network that provides Internet 
access over a much wider geographical area than a WLAN, which typically 
covers only from 100 to 1000 feet. Your computer can maintain Mobile 
Broadband network access as long as the computer is within a cellular-data 
coverage zone. Contact your service provider for coverage of a high-speed 
digital cellular network.

 NOTE: Even if you are able to make a call from your cellular phone in a specific 

geographical location, that location may not necessarily be within a cellular-data 

coverage zone.
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What You Need to Establish a Mobile Broadband Network Connection

 NOTE: Depending on your computer, you can use either a Mobile Broadband 

ExpressCard or Mini Card, but not both, to establish a Mobile Broadband 

network connection.

To set up a Mobile Broadband network connection, you need: 

• A Mobile Broadband ExpressCard or Mini Card (depending on your 
computer’s configuration)

 NOTE: For instructions on using ExpressCards, see "ExpressCards" on page 85.

• An activated Mobile Broadband ExpressCard or activated Subscriber 
Identity Module (SIM) for your service provider

• The Dell Mobile Broadband Card Utility (already installed on your computer 
if you purchased the card when you purchased your computer, or on the media 
that accompanied your card if purchased separately from your computer)

If the utility is corrupted or deleted from your computer, see the Dell Mobile 
Broadband Card Utility user’s guide in Windows Help and Support (click 
Start , and then click Help and Support) or on the media that 
accompanied your card if you purchased it separately from your computer.

Checking Your Dell Mobile Broadband Card

Depending on what you selected when you purchased your computer, the 
computer has a variety of configurations. To determine your computer 
configuration, see one of the following:

• Your order confirmation

• Microsoft Windows Help and Support 

To check your Mobile Broadband card in Windows Help and Support:

1 Click Start  → Help and Support→ Use Tools to view your computer 
information and diagnose problems.

2 Under Tools, click My Computer Information→ Find information about 
the hardware installed on this computer.

On the My Computer Information - Hardware screen, you can view the type 
of Mobile Broadband card installed in your computer as well as other 
hardware components.

 NOTE: The Mobile Broadband card is listed under Modems.
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Connecting to a Mobile Broadband Network

 NOTE: These instructions only apply to Mobile Broadband ExpressCards or 

Mini-Cards. They do not apply to internal cards with other wireless technology.

 NOTE: Before you connect to the Internet, you must activate Mobile Broadband 

service through your cellular service provider. For instructions and for additional 

information about using the Dell Mobile Broadband Card Utility, see the user's guide 

available through Windows Help and Support (click Start , and then click 

Help and Support). The user's guide is also available on the Dell Support website at 

support.dell.com and on the media included with your Mobile Broadband card if 

you purchased the card separately from your computer.

Use the Dell Mobile Broadband Card Utility to establish and manage a 
Mobile Broadband network connection to the Internet:

1 Click the Dell Mobile Broadband Card Utility icon in the Windows 
notification area to run the utility.

2 Click Connect. 

 NOTE: The Connect button changes to the Disconnect button. 

3 Follow the instructions on the screen to manage the network connection 
with the utility.

or

1 Click Start  → All Programs → Dell Wireless.

2 Click Dell Wireless Broadband and follow the instructions on the screen.

Enabling/Disabling the Dell Mobile Broadband Card

 NOTE: If you are unable to connect to a Mobile Broadband network, ensure that 

you have all the components for establishing a Mobile Broadband connection (see 

"What You Need to Establish a Mobile Broadband Network Connection" on page 99), 

and then verify that your Mobile Broadband card is enabled by verifying the setting 

of the wireless switch.

You can turn your Mobile Broadband card on and off using the wireless switch 
on your computer. 

You can turn your computer’s wireless devices on and off with the wireless 
switch on the right side of the computer (see "Right Side View" on page 27). 
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If the switch is in the on position, move the switch to the off position to 
disable the switch and the Mobile Broadband card. If the switch is in the off 
position, move the switch to the on position to enable the switch and the 
Dell Mobile Broadband card. 

To monitor the status of your wireless device, see "Monitoring the Status of 
the Wireless Network Card Through Dell QuickSet" on page 98.

Dell Wi-Fi Catcher™ Network Locator
You can use the wireless switch to rapidly turn off or on any wireless devices 
such as WLAN cards and internal cards with Bluetooth wireless technology. 
The wireless switch on your Dell computer uses the Dell Wi-Fi Catcher 
Network Locator to scan specifically for wireless networks in your vicinity.

To scan for a wireless network, push the Wi-Fi Catcher Network Locator 
button. It functions regardless of whether your computer is turned on or off, 
or in Sleep state, as long as the switch is configured through Dell QuickSet or 
the BIOS (system setup program) to control WiFi network connections. 

Because the Wi-Fi Catcher Network Locator is disabled and not configured 
for use when your computer is shipped to you, you must first use Dell 
QuickSet to enable and configure the switch to control WiFi network 
connections. For more information on the Wi-Fi Catcher Network Locator 
and to enable the feature through Dell QuickSet, right-click the QuickSet 
icon in the notification area, and then select Help.
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Securing Your Computer

Security Cable Lock
 NOTE: Your computer does not ship with a security cable lock.

A security cable lock is a commercially available antitheft device. To use the 
lock, attach it to the security cable slot on your Dell™ computer. For more 
information, see the instructions included with the device.

 NOTICE: Before you buy an antitheft device, ensure that it will work with the 

security cable slot on your computer.
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Passwords
Passwords prevent unauthorized access to your computer. When using 
passwords, observe the following guidelines:

• Choose a password that you can remember, but not one that is easy to 
guess. For example, do not use the names of family members or pets for 
passwords.

• It is recommended that you do not write down your password. If you do 
write it down, however, ensure that the password is stored in a secure place.

• Do not share your password with other people.

• Ensure that people are not watching you when you type your password.

 NOTICE: Passwords provide a high level of security for data in your computer or 

hard drive. However, they are not foolproof. If you require more security, obtain and 

use additional forms of protection, such as smart cards, data encryption programs, 

or PC Cards with encryption features. 

Use the User Accounts option in the Control Panel in the Microsoft® 
Windows® operating system to create user accounts or to change passwords. 
Once you create a user password, you must enter it each time you turn on or 
unlock your computer. If you do not enter a password within 2 minutes, the 
computer returns to its previous operating state. 

For more information, see your Windows documentation.
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Cleaning Your Computer
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

Computer, Keyboard, and Display

 CAUTION: Before you clean your computer, disconnect the computer from the 
electrical outlet and remove any installed batteries. Clean your computer with a 
soft cloth dampened with water. Do not use liquid or aerosol cleaners, which may 
contain flammable substances.

 NOTICE: Do not use cleaning agents with ammonia as an ingredient.

• Use a can of compressed air to remove dust from between the keys on the 
keyboard.

 NOTICE: To avoid damaging the computer or display, do not spray cleaning solution 

directly onto the display. Only use products specifically designed for cleaning 

displays, and follow the instructions that are included with the product.

• Moisten a soft, lint-free cloth with either water or a display cleaner, and 
wipe the display until it is clean.

• Moisten a soft, lint-free cloth with water and wipe the computer and 
keyboard. Do not allow water from the cloth to seep between the touch 
pad and the surrounding palm rest.
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CDs, DVDs and BDs

 NOTICE: Always use compressed air to clean the lens in the CD/DVD and BD drive, 

and follow the instructions that come with the compressed-air product. Never 

touch the lens in the drive.

If you notice problems, such as skipping, with the playback quality of your 
CDs, DVDs or BDs, try cleaning the discs.

1 Hold the disc by its outer edge. You can also touch the inside edge of the 
center hole.

 NOTICE: To avoid damaging the surface, do not wipe in a circular motion around 

the disc.

2 With a soft, lint-free cloth, gently wipe the bottom of the disc (the 
unlabeled side) in a straight line from the center to the outer edge of the disc.

For stubborn dirt, try using water or a diluted solution of water and mild 
soap. You can also purchase commercial products that clean discs and 
provide some protection from dust, fingerprints, and scratches. Cleaning 
products for CDs are also safe to use on DVDs and BDs.
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Troubleshooting

Dell Technical Update Service
The Dell Technical Update service provides proactive e-mail notification of 
software and hardware updates for your computer. The service is free and can 
be customized for content, format, and how frequently you receive notifications.

To enroll for the Dell Technical Update service, go to 
support.dell.com/technicalupdate.

Dell Diagnostics
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

When to Use the Dell Diagnostics

If you experience a problem with your computer, perform the checks in 
"Lockups and Software Problems" on page 123 and run the Dell Diagnostics 
before you contact Dell for technical assistance.

It is recommended that you print these procedures before you begin.

 NOTE: The Dell Diagnostics only operate on Dell computers.

Enter system setup, review your computer’s configuration information, and 
ensure that the device you want to test displays in system setup and is active 
(see "System Setup Screens" on page 180).

Start the Dell Diagnostics from your hard drive or from your Drivers and 
Utilities media (see "Drivers and Utilities Media" on page 13).
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Starting the Dell Diagnostics From Your Hard Drive

The Dell Diagnostics is located on a hidden diagnostic utility partition on 
your hard drive.

 NOTE: If your computer cannot display a screen image, contact Dell (see 

"Contacting Dell" on page 170).

1 Ensure that the computer is connected to an electrical outlet that is 
known to be working properly.

2 Turn on (or restart) your computer.

3 Start the Dell Diagnostics in one of the following two ways:

a When the DELL™ logo appears, press <F12> immediately. Select 
Diagnostics from the boot menu, and then press <Enter>.

 NOTE: If you wait too long and the operating system logo appears, 

continue to wait until you see the Microsoft® Windows® desktop, then 

shut down your computer and try again.

 NOTE: Before attempting option B, the computer must be powered 

down completely.

b Press and hold the <Fn> key while powering the computer on.

 NOTE: If you see a message stating that no diagnostics utility partition has 

been found, run the Dell Diagnostics from your Drivers and Utilities media.

The computer runs the Pre-boot System Assessment, a series of initial 
tests of your system board, keyboard, hard drive, and display.

• During the assessment, answer any questions that appear.

• If a failure is detected, the computer stops and beeps. To stop the 
assessment and restart the computer, press <n>; to continue to the 
next test, press <y>; to retest the component that failed, press <r>. 

• If failures are detected during the Pre-boot System Assessment, write 
down the error code(s) and contact Dell.

If the Pre-boot System Assessment completes successfully, you receive the 
message Booting Dell Diagnostic Utility Partition. 
Press any key to continue.

4 Press any key to start the Dell Diagnostics from the diagnostics utility 
partition on your hard drive.
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Starting the Dell Diagnostics From the Drivers and Utilities Media

1 Insert your Drivers and Utilities media.

2 Shut down and restart the computer.

3 When the DELL logo appears, press <F12> immediately.

 NOTE: Keyboard failure may result when a key on the keyboard is held down 

for extended periods of time. To avoid possible keyboard failure, press and 

release <F12> in even intervals until the boot device menu appears.

4 At the boot device menu, use the up- and down-arrow keys to highlight 
CD/DVD/CD-RW, and then press <Enter>.

 NOTE: The Quickboot feature changes the boot sequence for the current 

boot only. Upon restart, the computer boots according to the boot sequence 

specified in system setup.

5 Select the Boot from CD-ROM option from the menu that appears, and 
then press <Enter>.

6 Type 1 to start the Drivers and Utilities menu, and then press <Enter>.

7 Select Run the 32 Bit Dell Diagnostics from the numbered list. If 
multiple versions are listed, select the version appropriate for your 
computer.

8 At the Dell Diagnostics Main Menu, select the test you want to run.

 NOTE: Write down any error codes and problem descriptions exactly as they 

appear and follow the instructions on the screen.

9 After all tests have completed, close the test window to return to the Dell 
Diagnostics Main Menu.

10 Remove your Drivers and Utilities media, then close the Main Menu 
window to exit the Dell Diagnostics and restart the computer.
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Dell Diagnostics Main Menu

After the Dell Diagnostics loads and the Main Menu screen appears, click the 
button for the option you want.

 NOTE: It is recommended that you select Test System to run a complete test 

on your computer.

After you have selected the Test System option from the main menu, the 
following menu appears.

 NOTE: It is recommended that you select Extended Test from the menu 

below to run a more thorough check of the devices in the computer.

For any problem encountered during a test, a message appears with an error 
code and a description of the problem. Write down the error code and problem 
description exactly as it appears and follow the instructions on the screen. If 
you cannot resolve the problem, contact Dell (see "Contacting Dell" on page 170).

 NOTE: The Service Tag for your computer is located at the top of each test screen. 

When contacting Dell support, have your Service Tag ready.

Option Function

Test Memory Run the stand-alone memory test

Test System Run System Diagnostics

Exit Exit the Diagnostics

Option Function

Express Test Performs a quick test of system devices. The test typically 
takes 10 to 20 minutes and requires no interaction on your 
part. Run Express Test first to increase the possibility of 
tracing the problem quickly.

Extended Test Performs a thorough check of system devices. The test 
typically takes an hour or more and periodically requires your 
input to answer specific questions.

Custom Test Tests a specific device in the system and can be used to 
customize the tests you want to run.

Symptom Tree Lists a number of common symptoms and allows you to select 
a test based on the symptom of the problem you are having.
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The following tabs provide additional information for tests run from the 
Custom Test or Symptom Tree option:

Dell Support Utility
The Dell Support Utility is customized for your computing environment. 
This utility provides self-support information, software updates, and health 
scans for your computer. Use this utility to do the following:

• Check your computing environment 

• View the Dell Support Utility settings

• Access the help file for the Dell Support Utility

• View frequently asked questions

• Learn more about the Dell Support Utility

• Turn the Dell Support Utility off

For more information about the Dell Support Utility, click the question mark 
(?) at the top of the Dell Support window.

Tab Function

Results Displays the results of the test and any error conditions 
encountered.

Errors Displays error conditions encountered, error codes, and the 
problem description.

Help Describes the test and any requirements for running the test.

Configuration Displays your hardware configuration for the selected device.

The Dell Diagnostics obtains configuration information for 
all devices from system setup, memory, and various internal 
tests, and it displays the information in the device list in the 
left pane of the screen. The device list may not display the 
names of all the components installed on your computer or all 
devices attached to your computer.

Parameters Allows you to customize the test by changing the test settings.
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To access the Dell Support Utility:

• Click the Dell Support icon  in the notification area.

 NOTE: The  icon functions vary when clicking, double-clicking, or 

right-clicking.

Or

• Click the Start → All Programs→ Dell Support→ Dell Support Settings. 
Ensure that the Show icon on the taskbar option is checked. 

 NOTE: If the Dell Support Utility is not available from the Start menu, go to 

support.dell.com and download the software. 

Drive Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

ENSURE  THAT  M ICROSOFT
®  W INDOWS

®  RECOGNIZES  THE  DRIVE —

Windows XP

Click Start→ My Computer.

Windows Vista™

Click Start → Computer.

If the drive is not listed, perform a full scan with your antivirus software to 
check for and remove viruses. Viruses can sometimes prevent Windows from 
recognizing the drive.

TEST  THE  DRIVE —

• Insert another floppy disk, CD, DVD, or BD to eliminate the possibility 
that the original media is defective.

• Insert a bootable floppy disk and restart the computer.

CLEAN  THE  DRIVE  OR  DISK — See "Cleaning Your Computer" on page 105.
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ENSURE  THAT  THE  CD,  DVD,  OR  BD MEDIA  I S  SNAPPED  ONTO  THE  SPINDLE

CHECK  THE  CABLE  CONNECT IONS

CHECK  FOR  HARDWARE  INCOMPATIB IL IT IES — See "Troubleshooting Software 
and Hardware Problems in the Microsoft® Windows® XP and Microsoft 
Windows Vista™ Operating Systems" on page 139.

RUN  THE  DELL  D IAGNOST ICS — See "Dell Diagnostics" on page 107.

Optical drive problems

 NOTE: High-speed optical drive vibration is normal and may cause noise, which 

does not indicate a defect in the drive or the media.

 NOTE: Because of different regions worldwide and different disc formats, not all 

DVD titles work in all DVD drives.

Problems writing to a CD-RW, DVD+/-RW, or BD-RE drive

CLOSE  OTHER  PROGRAMS — CD-RW, DVD+/-RW, and BD-RE drives must 
receive a steady stream of data when writing. If the stream is interrupted, an 
error occurs. Try closing all programs before you write to the drive.

TURN  OFF  SLEEP  STATE  IN  W INDOWS  BEFORE  WRIT ING  TO  A  CD/DVD/BD 
DISC — See "Standby and Sleep Mode" on page 50 for information on Sleep state.

CHANGE  THE  WRITE  SPEED  TO  A  SLOWER  RATE — See the help files for your 
CD, DVD, or BD creation software.

The drive tray cannot eject

1 Ensure that the computer is shut down.

2 Straighten a paper clip and insert one end into the eject hole at the front 
of the drive, then push firmly until the tray is partially ejected.

3 Gently pull out the tray until it stops.

The drive makes an unfamiliar scraping or grinding sound

• Ensure that the sound is not caused by the program that is running.

• Ensure that the disc is inserted properly.
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Hard drive problems

ALLOW  THE  COMPUTER  TO  COOL  BEFORE  TURNING  I T  ON — A hot hard drive may 
prevent the operating system from starting. Try allowing the computer to 
return to room temperature before turning it on.

RUN  CHECK  D ISK —

Windows XP

1 Click Start and click My Computer. 

2 Right-click Local Disk C:.

3 Click Properties→ Tools→ Check Now.
4 Click Scan for and attempt recovery of bad sectors and click Start.

Windows Vista

1 Click Start  and click Computer.

2 Right-click Local Disk C:.

3 Click Properties→ Tools→ Check Now.
The User Account Control window may appear. If you are an 
administrator on the computer, click Continue; otherwise, contact your 
administrator to continue the desired action.

4 Follow the instructions on the screen.

E-Mail and Internet Problems 
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

CHECK  THE  W INDOWS  MAIL  SECURITY  SETT INGS — If you cannot open your 
e-mail attachments:

1 In Windows Mail, click Tools, click Options, and then click Security.

2 Click Do not allow attachments to remove the checkmark.

ENSURE  THAT  YOU  ARE  CONNECTED  TO  THE  INTERNET

Ensure that you have subscribed to an Internet service provider. With the 
Windows Mail open, click File. If Work Offline has a checkmark next to it, 
click the checkmark to remove it, and then connect to the Internet. For help, 
contact your Internet service provider.
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SCAN  THE  COMPUTER  FOR  SPYWARE — If you are experiencing slow computer 
performance, you frequently receive pop-up advertisements, or you are having 
problems connecting to the Internet, your computer might be infected with 
spyware. Use an anti-virus program that includes anti-spyware protection 
(your program may require an upgrade) to scan the computer and remove 
spyware. For more information, go to support.dell.com and search for the 
keyword spyware.

Error Messages
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

If the message is not listed, see the documentation for the operating system 
or the program that was running when the message appeared.

AUXIL IARY  DEVICE  FA ILURE — The touch pad or external mouse may be faulty. 
For an external mouse, check the cable connection. Enable the Pointing 
Device option in the system setup program (see "System Setup Screens" on 
page 180). If the problem persists, contact Dell (see "Contacting Dell" on 
page 170).

BAD  COMMAND  OR  F I LE  NAME — Ensure that you have spelled the command 
correctly, put spaces in the proper place, and used the correct pathname.

CACHE  DISABLED  DUE  TO  FA ILURE — The primary cache internal to the 
microprocessor has failed. Contact Dell (see "Contacting Dell" on page 170).

CD DRIVE  CONTROLLER  FA ILURE — The CD drive does not respond to 
commands from the computer (see "Drive Problems" on page 112).

DATA  ERROR — The hard drive cannot read the data (see "Drive Problems" on 
page 112).

DECREASING  AVAILABLE  MEMORY — One or more memory modules may be 
faulty or improperly seated. Reinstall the memory modules and, if necessary, 
replace them (see "Memory" on page 155).

D I SK  C :  FA ILED  IN IT IAL IZAT ION — The hard drive failed initialization. Run the 
hard drive tests in the Dell Diagnostics (see "Dell Diagnostics" on page 107). 

DRIVE  NOT  READY — The operation requires a hard drive in the bay before it 
can continue. Install a hard drive in the hard drive bay (see "Hard Drive" on 
page 152). 
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ERROR  READING  PCMCIA CARD — The computer cannot identify the 
ExpressCard. Reinsert the card or try another card (see "ExpressCards" on 
page 85). 

EXTENDED  MEMORY  SIZE  HAS  CHANGED — The amount of memory recorded in 
NVRAM does not match the memory installed in the computer. Restart the 
computer. If the error appears again, contact Dell (see "Contacting Dell" on 
page 170).

THE  F I LE  BEING  COPIED  IS  TOO  LARGE  FOR  THE  DEST INAT ION  DRIVE — The file 
that you are trying to copy is too large to fit on the disk, or the disk is full. Try 
copying the file to a different disk or use a larger capacity disk.

A F I LENAME  CANNOT  CONTAIN  ANY  OF  THE  FOLLOWING  CHARACTERS :  \  /  :  *  ?  “  <  
>  | —  Do not use these characters in filenames.

GATE  A20  FA ILURE — A memory module may be loose. Reinstall the memory 
modules and, if necessary, replace them (see "Memory" on page 155). 

GENERAL  FA ILURE — The operating system is unable to carry out the 
command. The message is usually followed by specific information—for 
example, Printer out of paper. Take the appropriate action.

HARD -DISK  DRIVE  CONF IGURAT ION  ERROR — The computer cannot identify the 
drive type. Shut down the computer, remove the hard drive (see "Hard Drive" 
on page 152), and boot the computer from a CD. Then, shut down the 
computer, reinstall the hard drive, and restart the computer. Run the Hard 
Disk Drive tests in the Dell Diagnostics (see "Dell Diagnostics" on page 107).

HARD -DISK  DRIVE  CONTROLLER  FA ILURE  0 — The hard drive does not respond 
to commands from the computer. Shut down the computer, remove the hard 
drive (see "Hard Drive" on page 152), and boot the computer from a CD. 
Then, shut down the computer, reinstall the hard drive, and restart the 
computer. If the problem persists, try another drive. Run the Hard Disk Drive 
tests in the Dell Diagnostics (see "Dell Diagnostics" on page 107).

HARD -DISK  DRIVE  FA ILURE — The hard drive does not respond to commands 
from the computer. Shut down the computer, remove the hard drive (see 
"Hard Drive" on page 152), and boot the computer from a CD. Then, shut 
down the computer, reinstall the hard drive, and restart the computer. If the 
problem persists, try another drive. Run the Hard Disk Drive tests in the Dell 
Diagnostics (see "Dell Diagnostics" on page 107). 
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HARD -DISK  DRIVE  READ  FA ILURE — The hard drive may be defective. Shut 
down the computer, remove the hard drive (see "Hard Drive" on page 152), 
and boot the computer from a CD. Then, shut down the computer, reinstall 
the hard drive, and restart the computer. If the problem persists, try another 
drive. Run the Hard Disk Drive tests in the Dell Diagnostics (see "Dell 
Diagnostics" on page 107).

INSERT  BOOTABLE  MEDIA — The operating system is trying to boot to 
nonbootable media, such as a floppy disk or CD. Insert bootable media.

INVAL ID  CONF IGURAT ION  INFORMATION -PLEASE  RUN  SYSTEM  SETUP  
PROGRAM — The system configuration information does not match the 
hardware configuration. The message is most likely to occur after a memory 
module is installed. Correct the appropriate options in the system setup 
program (see "System Setup Screens" on page 180).

KEYBOARD  CLOCK  L INE  FA ILURE — For external keyboards, check the cable 
connection. Run the Keyboard Controller test in the Dell Diagnostics 
(see "Dell Diagnostics" on page 107).

KEYBOARD  CONTROLLER  FA ILURE — For external keyboards, check the cable 
connection. Restart the computer, and avoid touching the keyboard or the 
mouse during the boot routine. Run the Keyboard Controller test in the 
Dell Diagnostics (see "Dell Diagnostics" on page 107).

KEYBOARD  DATA  L INE  FA ILURE — For external keyboards, check the cable 
connection. Run the Keyboard Controller test in the Dell Diagnostics (see 
"Dell Diagnostics" on page 107).

KEYBOARD  STUCK  KEY  FA ILURE — For external keyboards or keypads, check the 
cable connection. Restart the computer, and avoid touching the keyboard or 
keys during the boot routine. Run the Stuck Key test in the Dell Diagnostics 
(see "Dell Diagnostics" on page 107).

L ICENSED  CONTENT  I S  NOT  ACCESS IBLE  IN  MEDIAD IRECT — Dell MediaDirect™ 
cannot verify the Digital Rights Management (DRM) restrictions on the file, 
so the file cannot be played (see "Dell MediaDirect problems" on page 124).

MEMORY  ADDRESS  L INE  FA ILURE  AT  ADDRESS ,  READ  VALUE  EXPECT ING  VALUE —

A memory module may be faulty or improperly seated. Reinstall the memory 
modules and, if necessary, replace them (see "Memory" on page 155).
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MEMORY  ALLOCAT ION  ERROR — The software you are attempting to run is 
conflicting with the operating system, another program, or a utility. Shut 
down the computer, wait 30 seconds, and then restart it. Try to run the 
program again. If the error message still appears, see the software 
documentation.

MEMORY  DATA  L INE  FA ILURE  AT  ADDRESS ,  READ  VALUE  EXPECT ING  VALUE — A 
memory module may be faulty or improperly seated. Reinstall the memory 
modules and, if necessary, replace them (see "Memory" on page 155).

MEMORY  DOUBLE  WORD  LOGIC  FA ILURE  AT  ADDRESS ,  READ  VALUE  EXPECT ING  
VALUE — A memory module may be faulty or improperly seated. Reinstall the 
memory modules and, if necessary, replace them (see "Memory" on page 155).

MEMORY  ODD /EVEN  LOGIC  FA ILURE  AT  ADDRESS ,  READ  VALUE  EXPECT ING  
VALUE — A memory module may be faulty or improperly seated. Reinstall the 
memory modules and, if necessary, replace them (see "Memory" on page 155).

MEMORY  WRITE /READ  FA ILURE  AT  ADDRESS ,  READ  VALUE  EXPECT ING  VALUE — A 
memory module may be faulty or improperly seated. Reinstall the memory 
modules and, if necessary, replace them (see "Memory" on page 155).

NO  BOOT  DEV ICE  AVAILABLE — The computer cannot find the hard drive. If 
the hard drive is your boot device, ensure that the drive is installed, properly 
seated, and partitioned as a boot device.

NO  BOOT  SECTOR  ON  HARD  DRIVE — The operating system may be corrupted. 
Contact Dell (see "Contacting Dell" on page 170).

NO  T IMER  T ICK  INTERRUPT — A chip on the system board may be 
malfunctioning. Run the System Set tests in the Dell Diagnostics (see "Dell 
Diagnostics" on page 107). 

NOT  ENOUGH  MEMORY  OR  RESOURCES .  EXIT  SOME  PROGRAMS  AND  TRY  AGAIN —

You have too many programs open. Close all windows and open the program 
that you want to use.

OPERAT ING  SYSTEM  NOT  FOUND — Reinstall the hard drive (see "Hard Drive" 
on page 152). If the problem persists, contact Dell (see "Contacting Dell" on 
page 170). 

OPT IONAL  ROM BAD  CHECKSUM — The optional ROM has failed. Contact 
Dell (see "Contacting Dell" on page 170).

A REQUIRED  .DLL  F I LE  WAS  NOT  FOUND — The program that you are trying to 
open is missing an essential file. Remove and then reinstall the program.
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Windows XP

1 Click Start→ Control Panel→ Add or Remove Programs→ Programs and 
Features.

2 Select the program you want to remove.

3 Click Uninstall.

4 See the program documentation for installation instructions.

Windows Vista

1 Click Start  → Control Panel→ Programs→ Programs and Features.

2 Select the program you want to remove.

3 Click Uninstall.

See the program documentation for installation instructions.

SECTOR  NOT  FOUND — The operating system cannot locate a sector on the 
hard drive. You may have a defective sector or corrupted FAT on the hard 
drive. Run the Windows error-checking utility to check the file structure on 
the hard drive. See Windows Help and Support for instructions (click Start 

→ Help and Support). If a large number of sectors are defective, back up 
the data (if possible), and then reformat the hard drive.

SEEK  ERROR — The operating system cannot find a specific track on the 
hard drive. 

SHUTDOWN  FA ILURE — A chip on the system board may be malfunctioning. 
Run the System Set tests in the Dell Diagnostics (see "Dell Diagnostics" on 
page 107).

TIME-OF-DAY  CLOCK  LOST  POWER — System configuration settings are 
corrupted. Connect your computer to an electrical outlet to charge the 
battery. If the problem persists, try to restore the data by entering the system 
setup program, then immediately exit the program (see "System Setup 
Screens" on page 180). If the message reappears, contact Dell (see 
"Contacting Dell" on page 170).

TIME-OF-DAY  CLOCK  STOPPED — The reserve battery that supports the system 
configuration settings may require recharging. Connect your computer to an 
electrical outlet to charge the battery. If the problem persists, contact Dell 
(see "Contacting Dell" on page 170).
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TIME-OF -DAY  NOT  SET -PLEASE  RUN  THE  SYSTEM  SETUP  PROGRAM — The time 
or date stored in the system setup program does not match the system clock. 
Correct the settings for the Date and Time options (see "System Setup 
Screens" on page 180).

TIMER  CHIP  COUNTER  2  FA ILED — A chip on the system board may be 
malfunctioning. Run the System Set tests in the Dell Diagnostics (see "Dell 
Diagnostics" on page 107).

UNEXPECTED  INTERRUPT  IN  PROTECTED  MODE — The keyboard controller may 
be malfunctioning, or a memory module may be loose. Run the System 
Memory tests and the Keyboard Controller test in the Dell Diagnostics (see 
"Dell Diagnostics" on page 107).

X : \  IS  NOT  ACCESS IBLE .  THE  DEVICE  I S  NOT  READY — Insert a disk into the 
drive and try again.

WARNING :  BATTERY  IS  CRIT ICALLY  LOW — The battery is running out of 
charge. Replace the battery, or connect the computer to an electrical outlet; 
otherwise, activate hibernate mode or shut down the computer.

ExpressCard Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

CHECK  THE  EXPRESSCARD — Ensure that the ExpressCard is properly inserted 
into the connector.

CHECK  THAT  THE  CARD  IS  RECOGNIZED  BY  W INDOWS — Double-click the Safely 
Remove Hardware icon in the Windows taskbar. Some cards do not support 
this feature. If the card supports this Windows feature, the card will be listed.

IF  YOU  HAVE  PROBLEMS  WITH  A  DELL -PROVIDED  EXPRESSCARD — Contact Dell 
(see "Contacting Dell" on page 170). Also, for Mobile Broadband (WWAN) 
ExpressCards, see "Mobile Broadband (Wireless Wide Area Network 
[WWAN])" on page 127.

IF  YOU  HAVE  PROBLEMS  WITH  AN  EXPRESSCARD  NOT  PROVIDED  BY  DELL —

Contact the ExpressCard manufacturer.
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IEEE 1394 Device Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

ENSURE  THAT  THE  IEEE 1394  DEV ICE  IS  RECOGNIZED  BY  W INDOWS —

Windows XP

Click Start and click Control Panel.

1 Under Pick a Category, click Performance and Maintenance→ System→ 
System Properties→ Hardware→ Device Manager.

Windows Vista

1 Click Start  → Control Panel→ Hardware and Sound.

2 Click Device Manager.

If your IEEE 1394 device is listed, Windows recognizes the device.

IF  YOU  HAVE  PROBLEMS  WITH  A  DELL-PROVIDED  IEEE 1394  DEVICE — Contact 
Dell or the IEEE 1394 device manufacturer (see "Contacting Dell" on page 170). 

IF  YOU  HAVE  PROBLEMS  WITH  AN  IEEE 1394 DEVICE  NOT  PROVIDED  BY  DELL —

Contact Dell or the IEEE 1394 device manufacturer (see "Contacting Dell" on 
page 170). 

Ensure that the IEEE 1394 device is properly inserted into the connector.

Keyboard Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

Fill out the "Diagnostics Checklist" on page 169 as you perform the various 
checks.

 NOTE: Use the integrated keyboard when running the Dell Diagnostics or the 

system setup program. When you attach an external keyboard, the integrated 

keyboard remains fully functional.
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External Keyboard problems

 NOTE: When you attach an external keyboard, the integrated keyboard remains 

fully functional.

CHECK  THE  KEYBOARD  CABLE — Shut down the computer, disconnect the 
keyboard cable and check it for damage, then firmly reconnect the cable.

If you are using a keyboard extension cable, disconnect it and connect the 
keyboard directly to the computer.

CHECK  THE  EXTERNAL  KEYBOARD —

1 Shut down the computer, wait 1 minute, and then turn it on again.

2 Verify that the numbers, capitals, and scroll lock lights on the keyboard 
blink during the boot routine.

3 From the Windows desktop, click Start → All Programs→ 
Accessories→ Notepad. 

4 Type some characters on the external keyboard and verify that they appear 
on the display.

If you cannot verify these steps, you may have a defective external keyboard. 

TO  VER IFY  THAT  THE  PROBLEM  I S  WITH  THE  EXTERNAL  KEYBOARD ,  CHECK  THE  
INTEGRATED  KEYBOARD —

1 Shut down the computer.

2 Disconnect the external keyboard.

3 Turn on the computer. 

4 From the Windows desktop, click Start → All Programs→ 
Accessories→ Notepad. 

5 Type some characters on the internal keyboard and verify that they appear 
on the display.

If the characters appear now, but did not with the external keyboard, you 
may have a defective external keyboard. Contact Dell (see "Contacting 
Dell" on page 170).

RUN  THE  KEYBOARD  DIAGNOST ICS  TESTS — Run the PC-AT Compatible 
Keyboards tests in the Dell Diagnostics (see "Dell Diagnostics" on page 107). 
If the tests indicate a defective external keyboard, contact Dell (see 
"Contacting Dell" on page 170).
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Unexpected characters

D I SABLE  THE  NUMERIC  KEYPAD — Press <Num Lk> to disable the numeric 
keypad if numbers are displayed instead of letters. Verify that the numbers 
lock light is not lit.

Lockups and Software Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

The computer does not start

CHECK  THE  AC  ADAPTER — Ensure that the AC adapter is firmly connected to 
the computer and to the electrical outlet.

The computer stops responding

 NOTICE: You might lose data if you are unable to perform an operating system 

shutdown.

TURN  THE  COMPUTER  OFF — If you are unable to get a response by pressing a key 
on your keyboard or moving your mouse, press and hold the power button for 
at least 8 to 10 seconds until the computer turns off, then restart your computer. 

A program stops responding or crashes repeatedly

END  THE  PROGRAM —

1 Press <Crtl><Shift><Esc> simultaneously.

2 Click the Applications tab and select the program that is no longer responding.

3 Click End Task.

 NOTE: The chkdsk program may run when you restart the computer. Follow the 

instructions on the screen. 

CHECK  THE  SOFTWARE  DOCUMENTAT ION — If necessary, uninstall and then 
reinstall the program. Software usually includes installation instructions in its 
documentation or on a floppy disk or CD.
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A program is designed for an earlier Microsoft® Windows® 
operating system

RUN  THE  PROGRAM  COMPATIB IL ITY  W I ZARD

Windows XP

The Program Compatibility Wizard configures a program so that it runs in an 
environment similar to non-XP operating system environments.

1 Click Start→ All Programs→ Accessories→ Program Compatibility 
Wizard→ Next.

2 Follow the instructions on the screen.

Windows Vista

The Program Compatibility Wizard configures a program so that it runs in an 
environment similar to non-Windows Vista operating system environments.

1 Click Start  → Control Panel→ Programs→ Use an older program 
with this version of Windows.

2 In the welcome screen, click Next.

Follow the instructions on the screen.

A solid blue screen appears

TURN  THE  COMPUTER  OFF — If you are unable to get a response by pressing a key 
on your keyboard or moving your mouse, press and hold the power button for 
at least 8 to 10 seconds until the computer turns off, then restart your computer. 

Dell MediaDirect problems

CHECK  THE  DELL  MEDIAD IRECT  HELP  F I LE  FOR  INFORMATION — Use the Help 
menu to access Dell MediaDirect Help. 

TO  PLAY  MOVIES  WITH  DELL  MEDIAD IRECT ,  YOU  MUST  HAVE  A  DVD DRIVE  AND  
THE  DELL  DVD PLAYER — If you purchased a DVD drive with your computer, 
this software should already be installed. 

V IDEO  QUAL ITY  PROBLEMS — Turn off the Use Hardware Acceleration option. 
This feature takes advantage of the special processing in some graphics cards 
to reduce processor requirements when playing DVDs and certain types of 
video files. 
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CANNOT  PLAY  SOME  MEDIA  F I LES — Because Dell MediaDirect provides access 
to media files outside the Windows operating system environment, access to 
licensed content is restricted. Licensed content is digital content that has 
Digital Rights Management (DRM) applied to it. The Dell MediaDirect 
environment cannot verify the DRM restrictions, so the licensed files cannot 
be played. Licensed music and video files have a lock icon next to them. You 
can access licensed files in the Windows operating system environment. 

ADJUST ING  THE  COLOR  SETT INGS  FOR  MOVIES  THAT  CONTAIN  SCENES  THAT  ARE  
TOO  DARK  OR  TOO  BRIGHT — Click EagleVision to use a video enhancement 
technology that detects video content and dynamically adjusts the 
brightness/contrast/saturation ratios. 

 NOTICE: You cannot reinstall the Dell MediaDirect feature if you voluntarily 

reformat the hard drive. Contact Dell for assistance (see "Contacting Dell" on 

page 170). 

Other software problems

CHECK  THE  SOFTWARE  DOCUMENTAT ION  OR  CONTACT  THE  SOFTWARE  
MANUFACTURER  FOR  TROUBLESHOOT ING  INFORMATION —

• Ensure that the program is compatible with the operating system installed 
on your computer.

• Ensure that your computer meets the minimum hardware requirements 
needed to run the software. See the software documentation for information.

• Ensure that the program is installed and configured properly.

• Verify that the device drivers do not conflict with the program.

• If necessary, uninstall and then reinstall the program.

BACK  UP  YOUR  F I LES  IMMEDIATELY

USE  A  VIRUS-SCANNING  PROGRAM  TO  CHECK  THE  HARD  DRIVE ,  FLOPPY  DISKS ,  OR CDS

SAVE  AND  CLOSE  ANY  OPEN  F I LES  OR  PROGRAMS  AND  SHUT  DOWN  YOUR  
COMPUTER  THROUGH  THE  START  MENU

SCAN  THE  COMPUTER  FOR  SPYWARE — If you are experiencing slow computer 
performance, you frequently receive pop-up advertisements, or you are having 
problems connecting to the Internet, your computer might be infected with 
spyware. Use an anti-virus program that includes anti-spyware protection 
(your program may require an upgrade) to scan the computer and remove spyware. 
For more information, go to support.dell.com and search for the keyword spyware.
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RUN  THE  DELL  D IAGNOST ICS — If all tests run successfully, the error condition 
is related to a software problem (see "Dell Diagnostics" on page 107).

Memory Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these 
checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

IF  YOU  RECE IVE  AN  INSUFF IC IENT  MEMORY  MESSAGE —

• Save and close any open files and exit any open programs you are not using 
to see if that resolves the problem.

• See the software documentation for minimum memory requirements. If 
necessary, install additional memory (see "Memory" on page 155).

• Reseat the memory modules to ensure that your computer is successfully 
communicating with the memory (see "Memory" on page 155).

• Run the Dell Diagnostics (see "Dell Diagnostics" on page 107). 

IF  YOU  EXPER IENCE  OTHER  MEMORY  PROBLEMS —

• Reseat the memory modules to ensure that your computer is successfully 
communicating with the memory (see "Memory" on page 155).

• Ensure that you are following the memory installation guidelines (see 
"Memory" on page 155).

• Run the Dell Diagnostics (see "Dell Diagnostics" on page 107). 

Network Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

CHECK  THE  NETWORK  CABLE  CONNECTOR — Ensure that the network cable is 
firmly inserted into both the network connector on the back of the computer 
and the network jack.

CHECK  THE  NETWORK  L IGHTS  ON  THE  NETWORK  CONNECTOR — No light 
indicates that no network communication exists. Replace the network cable.
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RESTART  THE  COMPUTER  AND  LOG  ON  TO  THE  NETWORK  AGAIN

CHECK  YOUR  NETWORK  SETT INGS — Contact your network administrator or 
the person who set up your network to verify that your network settings are 
correct and that the network is functioning.

Mobile Broadband (Wireless Wide Area Network [WWAN])

 NOTE: The Dell Mobile Broadband Card Utility user’s guide and the Mobile 

Broadband ExpressCard user’s guide are available through Windows Help and 

Support (click Start → Help and Support). You can also download the Dell 

Mobile Broadband Card Utility user’s guide from support.dell.com.

 NOTE: The  icon appears in the notification area if the computer has a Dell 

WWAN device installed. Double-click the icon to launch the utility.

ACT IVATE  THE  MOBILE  BROADBAND  EXPRESSCARD — You must activate the 
Mobile Broadband ExpressCard before you can connect to the network. 
Position the mouse over the  icon in the notification area to verify the 
status of the connection. If the card is not activated, follow the card 
activation instructions located within the Dell Mobile Broadband Card 
Utility. To access the utility, double-click the icon located in the taskbar, 
at the lower-right corner of your screen. If your ExpressCard is not a Dell-
branded card, see the manufacturer’s instructions for your card.

CHECK  NETWORK  CONNECT ION  STATUS  IN  THE  DELL  MOBILE  BROADBAND  CARD  
UT IL ITY — Double-click the  icon to launch the Dell Mobile Broadband 
Card Utility. Check the status in the main window:

• No card detected — Restart the computer, and launch the Dell Mobile 
Broadband Card Utility again. 

• Check your WWAN service — Contact your cellular service provider to 
verify your plan coverage and supported services.
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Power Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

CHECK  THE  POWER  L IGHT — When the power light is lit or blinking, the 
computer has power. If the power light is blinking, the computer is in Sleep 
state—press the power button to exit Sleep state. If the light is off, press the 
power button to turn on the computer.

 NOTE: For information on Sleep power state, see "Standby and Sleep Mode" on 

page 50.

CHARGE  THE  BATTERY — The battery charge may be depleted.

1 Reinstall the battery.

2 Use the AC adapter to connect the computer to an electrical outlet.

3 Turn on the computer.

 NOTE: Battery operating time (the time the battery can hold a charge) decreases 

over time. Depending on how often the battery is used and the conditions under 

which it is used, you may need to purchase a new battery during the life of 

your computer.

CHECK  THE  BATTERY  STATUS  L IGHT — If the battery status light flashes amber 
or is a steady amber, the battery charge is low or depleted. Connect the 
computer to an electrical outlet.

If the battery status light flashes blue and amber, the battery is too hot to 
charge. Shut down the computer, disconnect the computer from the electrical 
outlet, and then let the battery and computer cool to room temperature.

If the battery status light rapidly flashes amber, the battery may be defective. 
Contact Dell (see "Contacting Dell" on page 170).

CHECK  THE  BATTERY  TEMPERATURE — If the battery temperature is below 
0°C (32°F), the computer will not start.

TEST  THE  ELECTR ICAL  OUTLET — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.

CHECK  THE  AC ADAPTER — Check the AC adapter cable connections. If the 
AC adapter has a light, ensure that the light is on.
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CONNECT  THE  COMPUTER  DIRECTLY  TO  AN  ELECTR ICAL  OUTLET — Bypass power 
protection devices, power strips, and extension cables to verify that the 
computer turns on.

EL IMINATE  POSSIBLE  INTERFERENCE — Turn off nearby fans, fluorescent lights, 
halogen lamps, or other appliances.

ADJUST  THE  POWER  PROPERT IES — See "Configuring Power Management 
Settings" on page 52.

RESEAT  THE  MEMORY  MODULES — If the computer power light turns on, but 
the display remains blank, reinstall the memory modules (see "Memory" on 
page 155).

Printer Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTE: If you need technical assistance for your printer, contact the printer’s 

manufacturer.

CHECK  THE  PRINTER  DOCUMENTAT ION — See the printer documentation for 
setup and troubleshooting information.

ENSURE  THAT  THE  PRINTER  IS  TURNED  ON

CHECK  THE  PRINTER  CABLE  CONNECT IONS —

• See the printer documentation for cable connection information.

• Ensure that the printer cables are securely connected to the printer and 
the computer. 

TEST  THE  ELECTR ICAL  OUTLET — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.
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VER IFY  THAT  THE  PRINTER  IS  RECOGNIZED  BY  W INDOWS —

Windows XP

1 Click Start→ Control Panel→ Printers and Other Hardware→ 
View installed printers or fax printers.

2 If the printer is listed, right-click the printer icon.

3 Click Properties→ Ports. For a parallel printer, ensure that the Print to the 
following port(s): setting is LPT1 (Printer Port). For a USB printer, ensure 
that the Print to the following port(s): setting is USB.

Windows Vista

1 Click Start  → Control Panel→ Hardware and Sound→ Printer.
2 If the printer is listed, right-click the printer icon.

3 Click Properties and click Ports.

4 Adjust the settings, as needed.

RE INSTALL  THE  PRINTER  DRIVER — See the printer documentation for 
instructions.

Scanner Problems
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

 NOTE: If you need technical assistance for your scanner, contact the scanner’s 

manufacturer.

CHECK  THE  SCANNER  DOCUMENTAT ION — See the scanner documentation for 
setup and troubleshooting information.

UNLOCK  THE  SCANNER — Ensure that your scanner is unlocked.

RESTART  THE  COMPUTER  AND  TRY  THE  SCANNER  AGAIN

CHECK  THE  CABLE  CONNECT IONS —

• See the scanner documentation for cable connection information.

• Ensure that the scanner cables are securely connected to the scanner and 
the computer.
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VER IFY  THAT  THE  SCANNER  IS  RECOGNIZED  BY  M ICROSOFT  W INDOWS —

Windows XP

1 Click Start→ Control Panel→ Printers and Other Hardware→ Scanners 
and Cameras.

2 If your scanner is listed, Windows recognizes the scanner.

Windows Vista

1 Click Start  → Control Panel→ Hardware and Sound→ Scanners and 
Cameras.

If the scanner is listed, Windows recognizes the scanner.

RE INSTALL  THE  SCANNER  DRIVER — See the scanner documentation for 
instructions.

Sound and Speaker Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

No sound from integrated speakers

ADJUST  THE  W INDOWS  VOLUME  CONTROL — Double-click the speaker icon in 
the lower-right corner of your screen. Ensure that the volume is turned up and 
that the sound is not muted. Adjust the volume, bass, or treble controls to 
eliminate distortion.

ADJUST  THE  VOLUME  USING  KEYBOARD  SHORTCUTS — Press <Fn><End> to 
disable (mute) or re-enable the integrated speakers.

RE INSTALL  THE  SOUND  (AUDIO )  DRIVER — See "Reinstalling Drivers and 
Utilities" on page 136.

No sound from external speakers

ENSURE  THAT  THE  SUBWOOFER  AND  THE  SPEAKERS  ARE  TURNED  ON — See the 
setup diagram supplied with the speakers. If your speakers have volume 
controls, adjust the volume, bass, or treble to eliminate distortion.

ADJUST  THE  W INDOWS  VOLUME  CONTROL — Click or double-click the speaker 
icon in the lower-right corner of your screen. Ensure that the volume is turned 
up and that the sound is not muted.
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D I SCONNECT  HEADPHONES  FROM  THE  HEADPHONE  CONNECTOR — Sound from 
the speakers is automatically disabled when headphones are connected to the 
headphone connector.

TEST  THE  ELECTR ICAL  OUTLET — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.

EL IMINATE  POSSIBLE  INTERFERENCE — Turn off nearby fans, fluorescent lights, 
or halogen lamps to check for interference.

RE INSTALL  THE  AUDIO  DRIVER — See "Reinstalling Drivers and Utilities" on 
page 136. 

RUN  THE  DELL  D IAGNOST ICS — See "Dell Diagnostics" on page 107.

 NOTE: The volume control in some MP3 players overrides the Windows volume 

setting. If you have been listening to MP3 songs, ensure that you did not turn the 

player volume down or off.

No sound from headphones

CHECK  THE  HEADPHONE  CABLE  CONNECT ION — Ensure that the headphone 
cable is securely inserted into the headphone connector.

ADJUST  THE  W INDOWS  VOLUME  CONTROL — Click or double-click the speaker 
icon in the lower-right corner of your screen. Ensure that the volume is turned 
up and that the sound is not muted.

Touch Pad or Mouse Problems
CHECK  THE  TOUCH  PAD  SETT INGS —

Windows XP

1 Click Start→ Control Panel→ Printers and Other Hardware→ Mouse.

2 Try adjusting the settings.

Windows Vista

1 Click Start → Control Panel→ Hardware and Sound→ Mouse.

2 Adjust the settings, as needed.

CHECK  THE  MOUSE  CABLE — Shut down the computer, disconnect the mouse 
cable and check it for damage, then firmly reconnect the cable.

If you are using a mouse extension cable, disconnect it and connect the 
mouse directly to the computer.
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TO  VER IFY  THAT  THE  PROBLEM  IS  WITH  THE  MOUSE ,  CHECK  THE  TOUCH  PAD —

1 Shut down the computer.

2 Disconnect the mouse.

3 Turn on the computer. 

4 At the Windows desktop, use the touch pad to move the cursor around, 
select an icon, and open it.

If the touch pad operates correctly, the mouse may be defective.

CHECK  THE  SYSTEM  SETUP  PROGRAM  SETT INGS — Verify that the system setup 
program lists the correct device for the pointing device option (the computer 
automatically recognizes a USB mouse without making any setting adjustments).

TEST  THE  MOUSE  CONTROLLER — To test the mouse controller (which affects 
pointer movement) and the operation of the touch pad or mouse buttons, 
run the Mouse test in the Pointing Devices test group in the "Dell 
Diagnostics" on page 107. 

RE INSTALL  THE  TOUCH  PAD  DRIVER — See "Reinstalling Drivers and Utilities" 
on page 136.

Video and Display Problems
Fill out the "Diagnostics Checklist" on page 169 as you complete these checks.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

If the display is blank

 NOTE: If you are using a program that requires a higher resolution than your 

computer supports, it is recommended that you attach an external monitor to your 

computer.

CHECK  THE  BATTERY — If you are using a battery to power your computer, the 
battery charge may be depleted. Connect the computer to an electrical outlet 
using the AC adapter, and then turn on the computer.

TEST  THE  ELECTR ICAL  OUTLET — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.

CHECK  THE  AC ADAPTER — Check the AC adapter cable connections. If the 
AC adapter has a light, ensure that the light is on.
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CONNECT  THE  COMPUTER  DIRECTLY  TO  AN  ELECTR ICAL  OUTLET — Bypass power 
protection devices, power strips, and extension cables to verify that the 
computer turns on.

ADJUST  THE  POWER  PROPERT IES — Search for the keyword sleep in Windows 
Help and Support.

SWITCH  THE  VIDEO  IMAGE — If your computer is attached to an external 
monitor, press <Fn><F8> to switch the video image to the display.

If the display is difficult to read

ADJUST  THE  BRIGHTNESS — Press <Fn> and the up- or down-arrow key.

EL IMINATE  POSSIBLE  INTERFERENCE — Turn off nearby fans, fluorescent lights, 
halogen lamps, or other appliances.

ROTATE  THE  COMPUTER  TO  FACE  A  DIFFERENT  DIRECT ION — Eliminate sunlight 
glare, which can cause poor picture quality.

ADJUST  THE  W INDOWS  DISPLAY  SETT INGS —

Windows XP

1 Click Start→ Control Panel→ Appearance and Themes.

2 Click the area you want to change or click the Display icon.

3 Try different settings for Color quality and Screen resolution.

Windows Vista

1 Click Start  → Control Panel→ Hardware and Sound→ 
Personalization→ Display Settings.

2 Adjust Resolution and Colors settings, as needed.

RUN  THE  V IDEO  DIAGNOST ICS  TESTS — If no error message appears and you 
still have a display problem, but the display is not completely blank, run the 
Video device group in the "Dell Diagnostics" on page 107, then contact Dell 
(see "Contacting Dell" on page 170).

SEE  "ERROR  MESSAGES " — If an error message appears, see "Error Messages" 
on page 115.
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If only part of the display is readable

CONNECT  AN  EXTERNAL  MONITOR —

1 Shut down your computer and connect an external monitor to the computer.

2 Turn on the computer and the monitor, and then adjust the monitor 
brightness and contrast controls.

If the external monitor works, the computer display or video controller 
may be defective. Contact Dell (see "Contacting Dell" on page 170).

Drivers

What Is a Driver?

A driver is a program that controls a device such as a printer, mouse, or 
keyboard. All devices require a driver program.

A driver acts like a translator between the device and any other programs that 
use the device. Each device has its own set of specialized commands that only 
its driver recognizes.

Dell ships your computer to you with required drivers already installed—no 
further installation or configuration is needed.

 NOTICE: Your Drivers and Utilities media may contain drivers for operating systems 

that are not on your computer. Ensure that you are installing software appropriate 

for your operating system.

Many drivers, such as the keyboard driver, come with your Microsoft® Windows® 
operating system. You may need to install drivers if you:

• Upgrade your operating system.

• Reinstall your operating system.

• Connect or install a new device.
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Identifying Drivers

If you experience a problem with any device, identify whether the driver is the 
source of your problem and, if necessary, update the driver.

Windows XP

1 Click Start→ Control Panel.
2 Under Pick a Category, click Performance and Maintenance, and click System.

3 In the System Properties window, click the Hardware tab, and click 
Device Manager.

Windows Vista

1 Click the Windows Vista start button , and right-click Computer.

2 Click Properties→ Device Manager.

 NOTE: The User Account Control window may appear. If you are an 

administrator on the computer, click Continue; otherwise, contact your 

administrator to continue.

Scroll down the list of devices and check for an exclamation point (a circle with a 
[!]) next to the device name. If an exclamation point is next to the device 
name, you may need to reinstall the driver or install a new driver (see 
"Reinstalling Drivers and Utilities" on page 136).

Reinstalling Drivers and Utilities

 NOTICE: The Dell Support website at support.dell.com and your Drivers and 
Utilities media provide approved drivers for Dell computers. If you install drivers 

obtained from other sources, your computer might not work correctly.

Using Windows Device Driver Rollback

If a problem occurs on your computer after you install or update a driver, use 
Windows Device Driver Rollback to replace the driver with the previously 
installed version.

Windows XP

1 Click Start→ My Computer→ Properties→ Hardware→ Device Manager.

2 Right-click the device for which the new driver was installed and click Properties.

3 Click the Drivers tab→ Roll Back Driver.
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Windows Vista

1 Click the Windows Vista start button , and right-click Computer.

2 Click Properties→ Device Manager.

 NOTE: The User Account Control window may appear. If you are an 

administrator on the computer, click Continue; otherwise, contact your 

administrator to enter the Device Manager.

3 Right-click the device for which the new driver was installed and click 
Properties.

4 Click the Drivers tab→ Roll Back Driver.

If Device Driver Rollback does not resolve the problem, use System Restore 
(see "Restoring Your Operating System" on page 140) to return your computer 
to the operating state that existed before you installed the new driver.

Using the Drivers and Utilities Media

If using Device Driver Rollback or System Restore (see "Restoring Your 
Operating System" on page 140) does not resolve the problem, reinstall the 
driver from your Drivers and Utilities media.

1 With the Windows desktop displayed, insert your Drivers and Utilities media.

If this is your first time to use your Drivers and Utilities media, continue 
to step 2. If not, proceed to step 5.

2 When the Drivers and Utilities installation program starts, follow the 
prompts on the screen.

 NOTE: In most cases, the Drivers and Utilities program starts running 

automatically. If it does not, start Windows Explorer, click your media drive 

directory to display the media contents, and then double-click the autorcd.exe file.

3 When the InstallShield Wizard Complete window appears, remove the 
Drivers and Utilities disc and click Finish to restart the computer.

4 When you see the Windows desktop, reinsert the Drivers and Utilities disc.
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5 At the Welcome Dell System Owner screen, click Next.

 NOTE: The Drivers and Utilities program displays drivers only for hardware 

that came installed in your computer. If you installed additional hardware, the 

drivers for the new hardware might not be displayed. If those drivers are not 

displayed, exit the Drivers and Utilities program. For drivers information, see 

the documentation that came with the device.

A message stating that the Drivers and Utilities program is detecting 
hardware in your computer appears.

The drivers that are used by your computer are automatically displayed in 
the My Drivers—The ResourceDVD has identified these components in 
your system window.

6 Click the driver that you want to reinstall and follow the instructions on 
the screen. 

If a particular driver is not listed, then that driver is not required by your 
operating system.

Manually Reinstalling Drivers 

 NOTE: If your computer has a Consumer IR port and you are reinstalling a 

Consumer IR driver, you must first enable the Consumer IR port in the system setup 

program (see "System Setup Screens" on page 180) before continuing with the 

driver installation (see "Reinstalling Drivers and Utilities" on page 136). For 

information about components installed on your computer, see "Front View" on page 19.

After extracting the driver files to your hard drive, as described in the previous 
section:

Windows XP

1 Click Start→ My Computer→ Properties→ Hardware→ Device Manager.

2 Double-click the type of device for which you are installing the driver 
(for example, Audio or Video).

3 Double-click the name of the device for which you are installing the driver.

4 Click the Driver tab→ Update Driver.

5 Click Install from a list or specific location (Advanced)→ Next.
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6 Click Browse and browse to the location to which you previously copied 
the driver files.

7 When the name of the appropriate driver appears, click Next.

8 Click Finish and restart your computer.

Windows Vista

1 Click the Windows Vista start button , and right-click Computer.

2 Click Properties→ Device Manager.

 NOTE: The User Account Control window may appear. If you are an 

administrator on the computer, click Continue; otherwise, contact your 

administrator to enter the Device Manager.

3 Double-click the type of device for which you are installing the driver 
(for example, Audio or Video).

4 Double-click the name of the device for which you are installing the driver.

5 Click the Driver tab→ Update Driver→ Browse my computer for driver 
software.

6 Click Browse and browse to the location to which you previously copied 
the driver files.

7 When the name of the appropriate driver appears, click the name of the 
driver→ OK→ Next.

8 Click Finish and restart your computer.

Troubleshooting Software and Hardware 
Problems in the Microsoft® Windows® XP and 
Microsoft Windows Vista™ Operating Systems
If a device is either not detected during the operating system setup or is 
detected but incorrectly configured, use Windows Vista Help and Support to 
resolve the incompatibility:

If a device is either not detected during the operating system setup or is 
detected but incorrectly configured, you can use the Hardware 
Troubleshooter to resolve the incompatibility.
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To start the Hardware Troubleshooter:

Windows XP

1 Click Start→ Help and Support.

2 Type hardware troubleshooter in the search field and press 
<Enter> to start the search.

3 In the Fix a Problem section, click Hardware Troubleshooter.

4 In the Hardware Troubleshooter list, select the option that best describes 
the problem and click Next to follow the remaining troubleshooting steps.

Windows Vista

1 Click the Windows Vista start button , and click Help and Support.

2 Type hardware troubleshooter in the search field and press 
<Enter> to start the search.

3 In the search results, select the option that best describes the problem and 
follow the remaining troubleshooting steps.

Restoring Your Operating System
You can restore your operating system in the following ways:

• Microsoft Windows Vista System Restore returns your computer to an 
earlier operating state without affecting data files. Use System Restore as 
the first solution for restoring your operating system and preserving data 
files. For instructions, see "Using Microsoft Windows System Restore" on 
page 141.

• Dell PC Restore by Symantec (available in Windows XP) and Dell Factory 
Image Restore (available in Windows Vista) returns your hard drive to the 
operating state it was in when you purchased the computer. Both 
permanently delete all data on the hard drive and remove any programs 
installed after you received the computer. Use Dell PC Restore or Dell 
Factory Image Restore only if System Restore did not resolve your 
operating system problem.

• If you received Operating System media with your computer, you can use it 
to restore your operating system. However, using the Operating System 
media also deletes all data on the hard drive. Use the media only if System 
Restore did not resolve your operating system problem. For instructions, 
see "Using the Operating System Media" on page 146.
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Using Microsoft Windows System Restore

The Windows operating system provides System Restore to allow you to 
return your computer to an earlier operating state (without affecting data 
files) if changes to the hardware, software, or other system settings have left 
the computer in an undesirable operating state. Any changes that System 
Restore makes to your computer are completely reversible.

 NOTICE: Make regular backups of your data files. System Restore does not 

monitor your data files or recover them.

 NOTE: The procedures in this document were written for the Windows default view, 

so they may not apply if you set your Dell computer to the Windows Classic view.

1 Click Start → Help and Support.

2 Type System Restore in the search field, then press <Enter>.

 NOTE: The User Account Control window may appear. If you are an 

administrator on the computer, click Continue; otherwise, contact your 

administrator to continue the desired action.

3 Click Next and follow the remaining prompts on the screen.

In the event that System Restore did not resolve the issue, you may undo the 
last system restore.

Starting System Restore

Windows XP

 NOTICE: Before you restore the computer to an earlier operating state, save and 

close any open files and exit any open programs. Do not alter, open, or delete any 

files or programs until the system restoration is complete.

1 Click Start→ All Programs→ Accessories→ System Tools→ System Restore.

2 Click either Restore my computer to an earlier time or Create a restore point.

3 Click Next and follow the remaining on-screen prompts.
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Windows Vista

1 Click Start .

2 In the Start Search box, type System Restore and press <Enter>.

 NOTE: The User Account Control window may appear. If you are an 

administrator on the computer, click Continue; otherwise, contact your 

administrator to continue the desired action.

3 Click Next and follow the remaining prompts on the screen.

In the event that System Restore did not resolve the issue, you may undo the 
last system restore.

Undoing the Last System Restore

 NOTICE: Before you undo the last system restore, save and close all open files and 

exit any open programs. Do not alter, open, or delete any files or programs until the 

system restoration is complete.

Windows XP

1 Click Start→ All Programs→ Accessories→ System Tools→ System Restore.

2 Click Undo my last restoration and click Next.

Windows Vista

1 Click Start .

2 In the Start Search box, type System Rest.

Enabling System Restore

 NOTE: Windows Vista does not disable System Restore; regardless of low disk 

space. Therefore, the steps below apply only to Windows XP.

If you reinstall Windows XP with less than 200 MB of free hard-disk space 
available, System Restore is automatically disabled. 

To see if System Restore is enabled:

1 Click Start→ Control Panel→ Performance and Maintenance→ System.

2 Click the System Restore tab and ensure that Turn off System Restore is 
unchecked.
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Using Dell™ PC Restore and Dell Factory Image Restore

 NOTICE: Using Dell PC Restore or Dell Factory Image Restore permanently deletes 

all data on the hard drive and removes any programs or drivers installed after you 

received your computer. If possible, back up the data before using these options. 

Use PC Restore or Dell Factory Image Restore only if System Restore did not resolve 

your operating system problem.

 NOTE: Dell PC Restore by Symantec and Dell Factory Image Restore may not be 

available in certain countries or on certain computers.

Use Dell PC Restore (Windows XP) or Dell Factory Image Restore 
(Windows Vista) only as the last method to restore your operating system. 
These options restore your hard drive to the operating state it was in when you 
purchased the computer. Any programs or files added since you received your 
computer—including data files—are permanently deleted from the hard drive. 
Data files include documents, spreadsheets, e-mail messages, digital photos, 
music files, and so on. If possible, back up all data before using PC Restore or 
Factory Image Restore.

Dell PC Restore

Using PC Restore:

1 Turn on the computer.

During the boot process, a blue bar with www.dell.com appears at the top 
of the screen.

2 Immediately upon seeing the blue bar, press <Ctrl><F11>.

If you do not press <Ctrl><F11> in time, let the computer finish 
starting, and then restart the computer again.

 NOTICE: If you do not want to proceed with PC Restore, click Reboot.

3 Click Restore and click Confirm.

The restore process takes approximately 6 to 10 minutes to complete.

4 When prompted, click Finish to reboot the computer.

 NOTE: Do not manually shut down the computer. Click Finish and let the computer 

completely reboot.
Troubleshooting 143

Download from Www.Somanuals.com. All Manuals Search And Download.



1

book.book  Page 144  Monday, April 14, 2008  4:23 PM
5 When prompted, click Yes.

The computer restarts. Because the computer is restored to its original 
operating state, the screens that appear, such as the End User License 
Agreement, are the same ones that appeared the first time the computer 
was turned on. 

6 Click Next.

The System Restore screen appears and the computer restarts. 

7 After the computer restarts, click OK.

Removing PC Restore

 NOTICE: Removing Dell PC Restore from the hard drive permanently deletes the PC 

Restore utility from your computer. After you have removed Dell PC Restore, you will 

not be able to use it to restore your computer operating system.

Dell PC Restore enables you to restore your hard drive to the operating state 
it was in when you purchased your computer. It is recommended that you do 
not remove PC Restore from your computer, even to gain additional hard-drive 
space. If you remove PC Restore from the hard drive, you cannot ever recall it, 
and you will never be able to use PC Restore to return your computer 
operating system to its original state.

1 Log on to the computer as a local administrator.

2 In Microsoft Windows Explorer, go to c:\dell\utilities\DSR.

3 Double-click the filename DSRIRRemv2.exe.

 NOTE: If you do not log on as a local administrator, a message appears 

stating that you must log on as administrator. Click Quit, and then log on as a 

local administrator.

 NOTE: If the partition for PC Restore does not exist on your computer hard 

drive, a message appears stating that the partition was not found. Click Quit; 

there is no partition to delete.

4 Click OK to remove the PC Restore partition on the hard drive.

5 Click Yes when a confirmation message appears.

The PC Restore partition is deleted and the newly available disk space is 
added to the free space allocation on the hard drive. 
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6 Right-click Local Disk (C) in Windows Explorer, click Properties, and 
verify that the additional disk space is available as indicated by the 
increased value for Free Space.

7 Click Finish to close the PC Restore Removal window and restart the 
computer.

Windows Vista: Dell Factory Image Restore

1 Turn on the computer. When the Dell logo appears, press <F8> several 
times to access the Vista Advanced Boot Options Window.

2 Select Repair Your Computer.

The System Recovery Options window appears.

3 Select a keyboard layout and click Next.

4 To access the recovery options, log on as a local user. To access the 
command prompt, type administrator in the User name field, then 
click OK.

5 Click Dell Factory Image Restore.

 NOTE: Depending upon your configuration, you may need to select 

Dell Factory Tools, then Dell Factory Image Restore.

The Dell Factory Image Restore welcome screen appears.

6 Click Next.

The Confirm Data Deletion screen appears. 

 NOTICE: If you do not want to proceed with Factory Image Restore, click Cancel.

7 Click the checkbox to confirm that you want to continue reformatting the 
hard drive and restoring the system software to the factory condition, then 
click Next.

The restore process begins and may take five or more minutes to complete. 
A message appears when the operating system and factory-installed 
applications have been restored to factory condition. 

8 Click Finish to reboot the system.
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Using the Operating System Media

Before You Begin

If you are considering reinstalling the Windows operating system to correct a 
problem with a newly installed driver, first try using Windows Device Driver 
Rollback (see "Using Windows Device Driver Rollback" on page 136). If 
Device Driver Rollback does not resolve the problem, then use System 
Restore to return your operating system to the operating state it was in before 
you installed the new device driver (see "Using Microsoft Windows System 
Restore" on page 141).

 NOTICE: Before performing the installation, back up all data files on your primary 

hard drive. For conventional hard drive configurations, the primary hard drive is the 

first drive detected by the computer.

To reinstall Windows, you need the following items:

• Dell Operating System media

• Dell Drivers and Utilities media

 NOTE: Your Drivers and Utilities media contains drivers that were installed during 

assembly of the computer. Use your Drivers and Utilities media to load any required 

drivers, including the drivers required if your computer has a RAID controller. 

Reinstalling Windows XP or Windows Vista

The reinstallation process can take 1 to 2 hours to complete. After you 
reinstall the operating system, you must also reinstall the device drivers, virus 
protection program, and other software.

 NOTICE: The Operating System media provides options for reinstalling Windows XP. 

The options can overwrite files and possibly affect programs that are installed on 

your hard drive. Therefore, do not reinstall Windows XP unless a Dell technical 

support representative instructs you to do so.

1 Save and close any open files and exit any open programs.

2 Insert the Operating System disc.

3 Click Exit if the Install Windows message appears.
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4 Restart the computer.

When the DELL logo appears, press <F12> immediately.

 NOTE: If you wait too long and the operating system logo appears, continue 

to wait until you see the Microsoft® Windows® desktop; then, shut down your 

computer and try again.

 NOTE: The next steps change the boot sequence for one time only. On the 

next start-up, the computer boots according to the devices specified in the 

system setup program.

5 When the boot device list appears, highlight CD/DVD/CD-RW Drive 
and press <Enter>.

6 Press any key to Boot from CD-ROM.

7 Follow the instructions on the screen to complete the installation.
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Adding and Replacing Parts

Before You Begin
This chapter provides procedures for removing and installing the components 
in your computer. Unless otherwise noted, each procedure assumes that the 
following conditions exist:

• You have performed the steps in "Turning Off Your Computer" (see "Turning 
Off Your Computer" on page 150) and "Before Working Inside Your 
Computer" (see "Before Working Inside Your Computer" on page 150).

• You have read the safety information in your Dell™ Product Information Guide.

• A component can be replaced or—if purchased separately—installed by 
performing the removal procedure in reverse order.

Recommended Tools

The procedures in this document may require the following tools:

• Small flat-blade screwdriver

• Phillips screwdriver

• Small plastic scribe

• Flash BIOS update program (see the Dell Support website at 
support.dell.com)
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Turning Off Your Computer

 NOTICE: To avoid losing data, save and close any open files and exit any open 

programs before you turn off your computer.

1 Shut down the operating system:

Windows® XP:

Click Start→ Shut Down→ Shut down.

Windows Vista™:

Click the Windows Vista Start button , click the arrow in the 
lower-right corner of the Start menu as shown below, and then click 
Shut Down.

The computer turns off after the operating system shutdown process 
is complete.

2 Ensure that the computer and any attached devices are turned off. If your 
computer and attached devices did not automatically turn off when you 
shut down your operating system, press and hold the power button for at 
least 8 to 10 seconds until the computer turns off.

Before Working Inside Your Computer

Use the following safety guidelines to help protect your computer from 
potential damage and to help ensure your own personal safety.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 CAUTION: Handle components and cards with care. Do not touch the components 
or contacts on a card. Hold a card by its edges or by its metal mounting bracket. 
Hold a component such as a processor by its edges, not by its pins.

 NOTICE: Damage due to servicing that is not authorized by Dell is not covered by 

your warranty.

 NOTICE: When you disconnect a cable, pull on its connector, not on the cable itself. 

Some cables have a connector with locking tabs; if you are disconnecting this type 

of cable, press in on the locking tabs before you disconnect the cable. As you pull 

connectors apart, keep them evenly aligned to avoid bending any connector pins. 

Also, before you connect a cable, ensure that both connectors are correctly 

oriented and aligned. 
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 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 

grounding strap or by periodically touching an unpainted metal surface (such as a 

connector on the back of the computer).

 NOTICE: To avoid damaging the computer, perform the following steps before you 

begin working inside the computer. 

1 Ensure that the work surface is flat and clean to prevent the computer 
cover from being scratched.

2 Turn off your computer. See "Turning Off Your Computer" on page 150. 

 NOTICE: To disconnect a network cable, first unplug the cable from your computer 

and then unplug it from the network wall jack.

3 Disconnect any network cables from the computer.

4 Disconnect your computer and all attached devices from their electrical outlets.

 NOTICE: To avoid damaging the system board, you must remove the battery before 

you service the computer. 

5 Remove the battery. Slide and hold the battery-bay latch release on the 
bottom of the computer, and then remove the battery from the bay.

6 Press the power button to ground the system board. 

7 Remove any installed ExpressCards from the ExpressCard slot.

1 battery-bay latch release 2 battery

2

1
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Hard Drive
 CAUTION: If you remove the hard drive from the computer when the drive is hot, 

do not touch the metal housing of the hard drive.

 CAUTION: Before working inside your computer, follow the safety instructions 
located in the Product Information Guide.

 NOTICE: To prevent data loss, turn off your computer before removing the hard 

drive. Do not remove the hard drive while the computer is on, in standby mode, or in 

hibernate mode.

 NOTICE: Hard drives are extremely fragile; even a slight bump can damage the drive.

 NOTE: Dell does not guarantee compatibility or provide support for hard drives 

from sources other than Dell.

Your computer can accommodate up to two hard drives. The hard drives are 
installed in trays labeled 0 and 1 in the hard drive cage and the cage is 
installed in the hard drive bay. To replace a hard drive or install a second one, 
you must first remove the hard drive cage from the hard drive bay.

Removing the Hard Drive Cage

1 Follow the procedures in "Before You Begin" on page 149.

2 Turn the computer over, loosen the two captive screws on the hard drive 
cover, and then remove the cover.

1 captive screws (2)

1
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3 Loosen the four captive screws on the hard drive cage and then lift the 
pull-tab to flip the cage towards the center of the computer so that the 
SATA cables and connectors are accessible.

4 Carefully remove the SATA cables from the hard drive or drives that are 
installed in the cage. 

1 captive screws (4)

1
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Replacing a Hard Drive in the Hard Drive Cage

1 Remove two screws on each side of the hard drive cage to free the hard 
drive, then lift the drive out of its tray in the cage.

 NOTICE: When a hard drive is not in the computer, store it in protective antistatic 

packaging. See “Protecting Against Electrostatic Discharge” in the Product 
Information Guide.

2 Remove the new hard drive from its packaging.

Save the original packaging for storing or shipping the hard drive.

3 Place the new hard drive into the drive cage tray and secure it with two 
screws on each side.

a Install the hard drive so that the manufacturer’s label faces the 
bottom of the drive cage and the SATA connectors are at the open end 
of the cage.

b Install the primary hard drive in the tray labeled 0. You can install a 
secondary hard drive in the tray labeled 1.

1 screws 2 hard drive cage

1

2
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Replacing the Hard Drive Cage

1 Place the hard drive cage upside down on the bottom of the computer with 
the SATA connectors and cables aligned, and then firmly press the cables 
onto the hard drives’ connectors.

2 Flip the hard drive cage over and into the hard drive bay.

3 Tighten the screws on the drive cage.

4 Replace the hard drive cover and tighten the screws.

5 If you have replaced the primary hard drive with a new hard drive that is 
not already pre-imaged, install the operating system and drivers for your 
computer. See "Restoring Your Operating System" on page 140 and 
"Reinstalling Drivers and Utilities" on page 136.

Memory
You can increase your computer memory by installing memory modules on 
the system board. See "Specifications" on page 171 for information on the 
memory supported by your computer. Install only memory modules that are 
intended for your computer.

 NOTE: In order to take advantage of the dual channel bandwidth capability, both 

memory slots must be populated and must match in size.

 NOTE: Memory modules purchased from Dell are covered under your computer 

warranty.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions located in the Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 

grounding strap or by periodically touching an unpainted metal surface (such as a 

connector on the back of the computer).

 NOTICE: To avoid damaging the system board, you must remove the battery before 

you begin working inside the computer.

1 Follow the procedures in"Before You Begin" on page 149.

2 Ground yourself by touching one of the metal connectors on the back of 
the computer.

 NOTE: If you leave the area, ground yourself again when you return to 

the computer.
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3 Turn the computer over, loosen the captive screws on the memory module 
cover, and then remove the cover.

 NOTICE: To prevent damage to the memory module connector, do not use tools to 

spread the memory-module securing clips.

4 If you are replacing a memory module, remove the existing module:

a Use your fingertips to carefully spread apart the securing clips on each 
end of the memory module connector until the module pops up. 

b Remove the module from the connector.

1 captive screws (2) 2 memory module cover

1

2
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 NOTICE: If you need to install memory modules in two connectors, install a 

memory module in the connector labeled “DIMMA” before you install a module in 

the connector labeled “DIMMB.” Insert memory modules at a 45-degree angle to 

avoid damaging the connector.

5 Ground yourself and install the new memory module:

 NOTE: If the memory module is not installed properly, the computer may not 

boot properly. No error message indicates this failure.

a Align the notch in the module edge connector with the tab in the 
connector slot.

b Slide the module firmly into the slot at a 45-degree angle, and rotate 
the module down until it clicks into place. If you do not feel the click, 
remove the module and reinstall it.

1 memory module 2 securing clip

1

2
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6 Replace the memory module cover.

 NOTICE: If the cover is difficult to close, remove the module and reinstall it. Forcing 

the cover to close may damage your computer.

7 Insert the battery into the battery bay, or connect the AC adapter to your 
computer and an electrical outlet.

8 Turn on the computer.

As the computer boots, it detects the additional memory and automatically 
updates the system configuration information. If prompted, press <F1> to 
continue.

Confirm the amount of memory installed in the computer:

• Windows® XP

– Right-click the My Computer icon on your desktop, then click 
Properties→ General.

• Windows Vista™

– Click the Windows Vista Start button , right-click Computer, and 
then click Properties.

1 memory module 2 securing clip

1

2
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Subscriber Identity Module
Subscriber Identity Modules (SIM) identify users uniquely through an 
International Mobile Subscriber Identity.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTE: Only GSM (HSDPA) type cards need a SIM. EVDO cards do not use a SIM.

1 Follow the procedures in "Before You Begin" on page 149.

2 In the battery bay, locate the SIM compartment.

3 Slide in the SIM into the compartment as indicated on the battery bay.

1 SIM

1
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Internal Card With Bluetooth™ Wireless Technology
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

If you ordered a card with Bluetooth wireless technology with your computer, 
it is already installed. The Bluetooth wireless technology card is located in the 
battery compartment. 

1 Follow the procedures in "Before You Begin" on page 149.

2 Ground yourself by touching one of the metal connectors on the back of 
the computer. 

 NOTE: If you leave the area, ground yourself again when you return to the 

computer. 

3 Pull the card out of the battery compartment so that you can disconnect 
the card from its cable and remove it from the computer. 

4 To replace the card, connect the card to the cable and insert it into the 
compartment. 

5 Replace the battery. 

1 internal card with Bluetooth™ Wireless technology 2 cable

3 bluetooth compartment

21
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Optical Drive
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

1 Follow the procedures in "Before You Begin" on page 149.

2 Save and close any open files, exit any open programs, and shut down the 
computer.

3 Remove the optical-drive locking screw.

4 Insert a scribe into the notch and push it to the side to release the drive 
from the bay. 

5 Slide the drive out of the bay.

To reinstall the optical drive, slide the drive into the drive bay and snap it into 
place. Then replace the optical-drive security screw.

1 optical drive 2 locking screw

3 notch

1

2
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Traveling With Your Computer

Identifying Your Computer
• Attach a name tag or business card to the computer.

• Write down your Service Tag and store it in a safe place away from the 
computer or carrying case. Use the Service Tag if you need to report a loss 
or theft to law enforcement officials and to Dell.

• Create a file on the Microsoft® Windows® desktop called if_found. Place 
information such as your name, address, and phone number in this file.

• Contact your credit card company and ask if it offers coded 
identification tags.

Packing the Computer
• Remove any external devices attached to the computer and store them in a 

safe place. Remove any cables attached to installed PC Cards, and remove 
any extended PC Cards.

• To make the computer as light as possible, replace any devices installed in 
the module bay with the Dell TravelLite™ module.

• Fully charge the main battery and any spare batteries that you plan to carry 
with you.

• Shut down the computer.

• Disconnect the AC adapter.

 NOTICE: When the display is closed, extraneous items on the keyboard or palm 

rest could damage the display.

• Remove any extraneous items, such as paper clips, pens, and paper, from 
the keyboard and palm rest and close the display.

• Use the optional Dell™ carrying case to pack the computer and its 
accessories together safely.
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• Avoid packing the computer with items such as shaving cream, colognes, 
perfumes, or food.

 NOTICE: If the computer has been exposed to extreme temperatures, allow it to 

acclimate to room temperature for 1 hour before turning it on.

• Protect the computer, the batteries, and the hard drive from hazards such as 
extreme temperatures and overexposure to sunlight, dirt, dust, or liquids.

• Pack the computer so that it does not slide around in the trunk of your car 
or in an overhead storage compartment.

Travel Tips
 NOTICE: Do not move the computer while using the optical drive to prevent loss 

of data.

 NOTICE: Do not check the computer as baggage.

• Consider changing your power management options to maximize battery 
operating time.

• If you are traveling internationally, carry proof of ownership—or of your 
right to use the computer if it is company-owned—to speed your passage 
through customs. Investigate the customs regulations of the countries you 
plan to visit, and consider acquiring an international carnet (also known as 
a merchandise passport) from your government.

• Find out what type of electrical outlets are used in the countries you will 
visit, and have appropriate power adapters.

• Check with your credit card company for information about the kinds of 
emergency travel assistance it offers to users of portable computers.

Traveling by Air

 NOTICE: Do not walk the computer through a metal detector. Send the computer 

through an X-ray machine or have it hand-inspected.

• Ensure that you have a charged battery available in case you are asked to 
turn on the computer.

• Prior to entering the airplane, verify that using a computer is permitted. 
Some airlines forbid the use of electronic devices during flight. All airlines 
forbid the use of electronic devices during takeoff and landing.
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Getting Help

Obtaining Assistance
 CAUTION: If you need to remove the computer cover, first disconnect the 

computer power and modem cables from all electrical outlets.

If you experience a problem with your computer, you can complete the 
following steps to diagnose and troubleshoot the problem:

1 See "Troubleshooting" on page 107 for information and procedures that 
pertain to the problem your computer is experiencing.

2 See "Dell Diagnostics" on page 107 for procedures on how to run 
Dell Diagnostics.

3 Fill out the "Diagnostics Checklist" on page 169.

4 Use Dell's extensive suite of online services available at Dell Support 
(support.dell.com) for help with installation and troubleshooting 
procedures. See "Online Services" on page 166 for a more extensive list of 
Dell Support online.

5 If the preceding steps have not resolved the problem, see "Contacting 
Dell" on page 170.

 NOTE: Call Dell Support from a telephone near or at the computer so that the 

support staff can assist you with any necessary procedures.

 NOTE: Dell's Express Service Code system may not be available in all countries.

When prompted by Dell's automated telephone system, enter your Express 
Service Code to route the call directly to the proper support personnel. If you 
do not have an Express Service Code, open the Dell Accessories folder, 
double-click the Express Service Code icon, and follow the directions.

For instructions on using the Dell Support, see "Technical Support and 
Customer Service" on page 166.

 NOTE: Some of the following services are not always available in all locations 

outside the continental U.S. Call your local Dell representative for information 

on availability.
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Technical Support and Customer Service

Dell's support service is available to answer your questions about Dell™ hardware. 
Our support staff uses computer-based diagnostics to provide fast, accurate 
answers.

To contact Dell's support service, see "Before You Call" on page 168, and then 
see the contact information for your region or go to support.dell.com.

DellConnect

DellConnect is a simple online access tool that allows a Dell service and support 
associate to access your computer through a broadband connection, diagnose 
your problem and repair it all under your supervision. For more information, 
go to support.dell.com and click DellConnect.

Online Services

You can learn about Dell products and services on the following websites:

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

You can access Dell Support through the following websites and e-mail addresses:

• Dell Support websites

support.dell.com

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Dell Support e-mail addresses

mobile_support@us.dell.com

support@us.dell.com 

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)
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• Dell Marketing and Sales e-mail addresses

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your e-mail address as your password.

AutoTech Service

Dell's automated support service—AutoTech—provides recorded answers to 
the questions most frequently asked by Dell customers about their portable 
and desktop computers.

When you call AutoTech, use your touch-tone telephone to select the 
subjects that correspond to your questions. For the telephone number to call 
for your region, see "Contacting Dell" on page 170.

Automated Order-Status Service

To check on the status of any Dell products that you have ordered, you can go 
to support.dell.com, or you can call the automated order-status service. 
A recording prompts you for the information needed to locate and report on 
your order. For the telephone number to call for your region, see "Contacting 
Dell" on page 170.

Problems With Your Order
If you have a problem with your order, such as missing parts, wrong parts, or 
incorrect billing, contact Dell for customer assistance. Have your invoice or 
packing slip handy when you call. For the telephone number to call for your 
region, see "Contacting Dell" on page 170.

Product Information
If you need information about additional products available from Dell, or if 
you would like to place an order, visit the Dell website at www.dell.com. For 
the telephone number to call for your region or to speak to a sales specialist, 
see the "Contacting Dell" on page 170.
Getting Help 167

Download from Www.Somanuals.com. All Manuals Search And Download.



1

book.book  Page 168  Monday, April 14, 2008  4:23 PM
Returning Items for Warranty Repair or Credit
Prepare all items being returned, whether for repair or credit, as follows:

1 Call Dell to obtain a Return Material Authorization Number, and write it 
clearly and prominently on the outside of the box.

For the telephone number to call for your region, see "Contacting Dell" on 
page 170.

2 Include a copy of the invoice and a letter describing the reason for the return.

3 Include a copy of the Diagnostics Checklist (see "Diagnostics Checklist" on 
page 169), indicating the tests that you have run and any error messages 
reported by the Dell Diagnostics (see "Dell Diagnostics" on page 107).

4 Include any accessories that belong with the item(s) being returned (power 
cables, software floppy disks, guides, and so on) if the return is for credit.

5 Pack the equipment to be returned in the original (or equivalent) packing 
materials.

You are responsible for paying shipping expenses. You are also responsible for 
insuring any product returned, and you assume the risk of loss during 
shipment to Dell. Collect On Delivery (C.O.D.) packages are not accepted.

Returns that are missing any of the preceding requirements will be refused at 
Dell’s receiving dock and returned to you.

Before You Call
 NOTE: Have your Express Service Code ready when you call. The code helps Dell’s 

automated-support telephone system direct your call more efficiently. You may also 

be asked for your Service Tag (located in the battery bay of your computer).

Remember to fill out the Diagnostics Checklist (see "Diagnostics Checklist" 
on page 169). If possible, turn on your computer before you call Dell for 
assistance and call from a telephone at or near the computer. You may be 
asked to type some commands at the keyboard, relay detailed information 
during operations, or try other troubleshooting steps possible only at the 
computer itself. Ensure that the computer documentation is available. 

 CAUTION: Before working inside your computer, follow the safety instructions in 
your Product Information Guide.
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Diagnostics Checklist

Name:

Date:

Address:

Phone number:

Service Tag (bar code in the battery bay of the computer):

Express Service Code:

Return Material Authorization Number (if provided by Dell support technician):

Operating system and version:

Devices:

Expansion cards:

Are you connected to a network? Yes No

Network, version, and network adapter:

Programs and versions:

See your operating system documentation to determine the contents of the 
system’s start-up files. If the computer is connected to a printer, print each file. 
Otherwise, record the contents of each file before calling Dell.

Error message, beep code, or diagnostic code:

Description of problem and troubleshooting procedures you performed:
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Contacting Dell
 NOTE: If you do not have an active Internet connection, you can find contact 

information on your purchase invoice, packing slip, bill, or Dell product catalog. 

Dell provides several online and telephone-based support and service options. 
Because availability varies by country and product, some services may not be 
available in your area. To contact Dell for sales, technical support, or 
customer service issues:

1 Visit www.support.dell.com.

2 At the bottom of the page, verify your country or region. 

3 Locate and click Contact Us on the left side of the page. 

4 Select the appropriate service or support link based on your need.

5 Choose the method of contacting Dell that is convenient for you.
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Specifications
 NOTE: Offerings may vary by region. For more information regarding the 

configuration of your computer, click Start→ Help and Support and select the 

option to view information about your computer.

Processor

Processor type Intel® Core™ 2 Duo processor 

Intel® 45 nm Core™ 2 Duo processor 

L1 cache 64 KB 

L2 cache 2 MB or 4 MB (Intel Core 2 Duo processor)

6 MB (Intel 45 nm Core 2 Duo processor)

External bus frequency (front 
side bus)

800 MHz (Intel Core 2 Duo processor)

1066 MHz (Intel 45 nm Core 2 Duo 
processor)

System Information

System chip set Mobile Intel 965PM

Data bus width 64 bits

DRAM bus width dual channel bus

Processor address bus width 32 bits

Flash EPROM 2 MB

PCI bus
(PCI-Express used for video 
controllers)

32 bits
x16
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ExpressCard

NOTE: The ExpressCard slot is designed only for ExpressCards. It does NOT support 

PC Cards.

ExpressCard connector one ExpressCard slot (54 mm)

1.5 V and 3.3 V

Cards supported ExpressCard/34 (34 mm) and 
ExpressCard/54 (54 mm)

ExpressCard connector size 26 pins

Memory

Memory module connector two user-accessible SODIMM connectors

Memory module capacities 512 MB, 1 GB, 2 GB, and 4 GB

Memory type 1.8 V SODIMM DDR-II

supports DDR-II up to 667 MHz

Minimum memory 1 GB (via 2 x 512 MB SODIMM DDR-II 
modules)

Maximum memory 4 GB (via 2 x 2 GB SODIMM DDR-II 
modules)

NOTE: In order to take advantage of the dual channel bandwidth capability, both 

memory slots must be populated and must match in size.

8-in-1 Media Memory card Reader

8-in-1 media memory card controller Ricoh R5C833

8-in-1 media memory card connector 8-in-1 combo card connector

Cards supported • Secure Digital (SD)

• SDIO

• MultiMediaCard (MMC)

• Memory Stick

• Memory Stick PRO

• xD-Picture Card

• Hi Speed-SD

• Hi Density-SD
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Ports and Connectors

Audio microphone-in connector, two stereo 
headphones/speakers connector

IEEE 1394a 4-pin mini, nonpowered connector

Consumer IR sensor compatible with Philips RC6 
(receive only)

Network adapter RJ-45 port

S-video TV-out 7-pin mini-DIN connector (optional S-video 
to composite video adapter cable; optional 
S-video to component video adapter cable)

USB four 4-pin USB 2.0-compliant connectors

Dual link DVI-I (Digital Video 
Interface)

29-pin connector

Communications

Network adapter 10/100/1000 Mbps Ethernet LAN on system 
board

Wireless internal PCI-e Mini-Card WLAN and 
WWAN support; internal card with 
Bluetooth® wireless technology support

Video

NOTE: Your computer comes in different configurations with different video controller 

cards.

Video controller: NVIDIA GeForce 8800 GS

Video type discrete video adapter

Data bus PCI Express x16

Video memory 256 MB

LCD interface LVDS

TV support NTSC or PAL in S-video, component, and 
composite modes
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Audio

Audio type High Definition Audio (HDA) codec

Stereo conversion 24-bit (analog-to-digital and digital-to-analog)

Interfaces:

Internal HDA bus

External microphone-in connector, two stereo 
headphones/speakers connector

Speaker stereo 8-ohm main speakers with two 18 mm 
transducers

bluetooth speaker adapter

Internal speaker amplifier Class D Stereo 5W per channel

Volume controls program menus, media control buttons

Audio controller Sigmatel STAC9228 High Definition Audio 
codec

Headphones bluetooth stereo headphones (optional)

Media

Drive DVD combo, DVD+RW, Blu-ray®

Interface Roxio® Creator Plus®, 
Dell MediaDirect™ 3.3

Display

Type (active-matrix TFT) WUXGA

Dimensions:

Height 245.0 mm (9.64 inches)

Width 383.0 mm (15 inches)

Diagonal 431.8 mm (17 inches)

Maximum resolution 1920 x 1200

Refresh rate 60 Hz

Operating angle 0°  (closed) to 142°
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Viewing angle (typical):

Horizontal ±60°

Vertical ±45° 

Pixel pitch 0.191 mm (17-inch display)

Power consumption (panel with 
backlight) (typical): 7.54 W

Controls brightness can be controlled through 
keyboard shortcuts

Keyboard

Number of keys 101 (U.S. and Canada); 88 (Europe); 
91 (Japan)

Layout QWERTY/AZERTY/Kanji

Type LED backlit

Camera

Pixel 2.0 mega pixel

Video Resolution 640x480 at 30fps

Diagonal Viewing Angle 60°

Touch Pad

X/Y position resolution 
(graphics table mode) 240 cpi

Size:

Width 73.0-mm (2.88-inch) sensor-active area

Height 42.9-mm (1.69-inch) rectangle

Display (continued)
Specifications 175

Download from Www.Somanuals.com. All Manuals Search And Download.



1

book.book  Page 176  Monday, April 14, 2008  4:23 PM
Battery

Type 9-cell "smart" lithium ion 

Dimensions:

Depth 88.5 mm (3.48 inches)

Height 21.5 mm (0.83 inch)

Width 139.0 mm (5.47 inches)

Weight 0.48 kg (1.1 lb) (9 cell)

Voltage 10.8 VDC 

Charge time (approximate):

Computer off 4 hours (at 100% in 4 hours)

2 hour (at 80% in 2 hours)

Operating time Battery operating time varies depending on 
operating conditions and can be significantly 
reduced under certain power-intensive 
conditions. 

See "Battery Performance" on page 47 for 
more information on battery life.

Life span (approximate) 300 discharge/charge cycles

Temperature range:

Operating 0° to 35°C (32° to 95°F)

Storage –40° to 65°C (–40° to 149°F)

AC Adapter

Input voltage 90–264 VAC

Input current (maximum) 3.2 A

Input frequency 47–63 Hz

Output current 11.8 A (continuous), 12.8A peak 4 second 
pulse

Output power 230 W 

Rated output voltage 19.5 VDC
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Dimensions:

Height 43 mm (1.7 inches)

Width 100 mm (3.93 inches)

Depth 200 mm (7.87 inches)

Weight (with cables) 1.3 kg (2.86 lb)

Temperature range:

Operating 0° to 40°C (32° to 104°F) 

Storage –40° to 65°C (–40° to 158°F)

Physical

Height 50.8 mm (2.0 inches)

Width 406 mm (16 inches)

Depth 302 mm (11.9 inches)

Weight (with 9-cell battery and 
optical drive)

4.81 kg (10.6 lb)

Environmental

Temperature range:

Operating 0° to 35°C (32° to 95°F)

Storage –40° to 65°C (–40° to 149°F)

Relative humidity:

Operating 10% to 90% (noncondensing)

Storage 5% to 95% (noncondensing)

Maximum vibration (using a 
random-vibration spectrum that 
simulates user environment):

Operating 0.66 GRMS

Storage 1.3 GRMS

AC Adapter (continued)
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Maximum shock (measured with a 
2-ms half-sine pulse):

Operating 143 G

Storage 163 G

Altitude (maximum):

Operating –15.2 to 3048 m (–50 to 10,000 ft)

Storage –15.2 to 10,668 m (–50 to 35,000 ft)

Environmental (continued)
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Appendix

Overview
 NOTE: Your operating system may automatically configure most of the options 

available in the system setup program, thus overriding options that you set through 

the system setup program. (An exception is the Fn Key Emulation option, which you 

can disable or enable only through the system setup program.) For more information 

on configuring features for your operating system, access the Help and Support 

Center (see "Microsoft Windows XP and Windows Vista Help and Support Center" 

on page 16).

You can use the system setup program as follows:

• To set or change user-selectable features—for example, your computer 
password

• To verify information about the computer's current configuration, such as 
the amount of system memory

After you set up the computer, run the system setup program to familiarize 
yourself with your system configuration information and optional settings. 
You may want to write down the information for future reference.

The system setup screens display the current setup information and settings 
for your computer, such as:

• System configuration

• Boot order

• Boot (start-up) configuration

• Basic device-configuration settings

• System security settings

 NOTE: Unless you are an expert computer user or are directed to do so by Dell 

technical support, do not change the system setup settings. Certain changes might 

make your computer work incorrectly. 
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Viewing the System Setup Screens
Verify the system setup entry procedure for your system (steps 1 and 2) with 
the project team. 

1 Turn on (or restart) your computer.

2 When the DELL™ logo appears, press <F2> immediately. If you wait too 
long and the Microsoft® Windows® logo appears, continue to wait until 
you see the Windows desktop. Then shut down your computer and 
try again.

System Setup Screens
 NOTE: For information about a specific item on a system setup screen, highlight the 

item and see the Help area on the screen.

On each screen, the system setup options are listed at the left. To the right of 
each option is the setting or value for that option. You can change settings 
that appear as white type on the screen. Options or values that you cannot 
change (because they are determined by the computer) appear less bright.

The upper-right corner of the screen displays help information for the 
currently highlighted option; the lower-right corner displays information 
about the computer. System-setup key functions are listed across the bottom 
of the screen.

Commonly Used Options
Certain options require that you reboot the computer for new settings to 
take effect.

Changing the Boot Sequence

The boot sequence, or boot order, tells the computer where to look to find the 
software needed to start the operating system. You can control the boot 
sequence and enable/disable devices using the Boot Order page of the system 
setup program.

 NOTE: To change the boot sequence on a one-time-only basis, see "Performing a 

One-Time Boot" on page 181.
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The Boot Order page displays a general list of the bootable devices that may 
be installed in your computer, including but not limited to the following:

• Diskette Drive

• Modular bay HDD

• Internal HDD

• Optical Drive

During the boot routine, the computer starts at the top of the list and scans 
each enabled device for the operating system start-up files. When the 
computer finds the files, it stops searching and starts the operating system. 

To control the boot devices, select (highlight) a device by pressing the down-arrow 
or up-arrow key, and then enable or disable the device or change its order in 
the list.

• To enable or disable a device, highlight the item and press the space bar. 
Enabled items appear as white and display a number next to them; 
disabled items appear blue or dimmed without a number.

• To reorder a device in the list, highlight the device and then press <u> or 
<d>(not case-sensitive) to move the highlighted device up or down.

Boot sequence changes take effect as soon as you save the changes and exit 
the system setup program.

Performing a One-Time Boot

You can set a one-time-only boot sequence without entering the system setup 
program. (You can also use this procedure to boot the Dell Diagnostics on the 
diagnostics utility partition on your hard drive.)

1 Shut down the computer through the Start menu.

2 Connect the computer to an electrical outlet.
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3 Turn on the computer. When the DELL logo appears, press <F12> 
immediately. 

If you wait too long and the Windows logo appears, continue to wait until 
you see the Windows desktop. Then shut down your computer and try 
again.

4 When the boot device list appears, highlight the device from which you 
want to boot and press <Enter>.

The computer boots to the selected device.

The next time you reboot the computer, the previous boot order is restored.

FCC Notice (U.S. Only)

FCC Class B

This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the manufacturer’s instruction 
manual, may cause interference with radio and television reception. This 
equipment has been tested and found to comply with the limits for a Class B 
digital device pursuant to Part 15 of the FCC Rules. 

This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 

1 This device may not cause harmful interference. 

2 This device must accept any interference received, including interference 
that may cause undesired operation. 

 NOTICE: The FCC regulations provide that changes or modifications not expressly 

approved by Dell Inc. could void your authority to operate this equipment. 

These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does 
cause harmful interference with radio or television reception, which can be 
determined by turning the equipment off and on, you are encouraged to try 
to correct the interference by one or more of the following measures: 

• Reorient the receiving antenna.

• Relocate the system with respect to the receiver.
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• Move the system away from the receiver.

• Plug the system into a different outlet so that the system and the receiver 
are on different branch circuits. 

If necessary, consult a representative of Dell Inc. or an experienced 
radio/television technician for additional suggestions. 

The following information is provided on the device or devices covered in this 
document in compliance with the FCC regulations: 

 NOTE: For further regulatory information, see your Product Information Guide. 

Macrovision Product Notice
This product incorporates copyright protection technology that is protected 
by U.S. patents and other intellectual property rights. Use of this copyright 
protection technology must be authorized by Macrovision, and is intended 
for home and other limited viewing uses only unless otherwise authorized by 
Macrovision. Reverse engineering or disassembly is prohibited.

Product name: Dell™ XPS™ M1730

Model number: PP06XA

Company name: Dell Inc.
Worldwide Regulatory Compliance & Environmental Affairs
One Dell Way
Round Rock, TX 78682 USA
512-338-4400
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Glossary
Terms in this Glossary are provided for informational purposes only and may 
or may not describe features included with your particular computer.

A
AC — alternating current — The form of electricity that powers your computer when 
you plug the AC adapter power cable in to an electrical outlet.

ACPI — advanced configuration and power interface — A power management 
specification that enables Microsoft® Windows® operating systems to put a computer 
in standby or hibernate mode to conserve the amount of electrical power allocated to 
each device attached to the computer.

AGP — accelerated graphics port — A dedicated graphics port that allows system 
memory to be used for video-related tasks. AGP delivers a smooth, true-color video 
image because of the faster interface between the video circuitry and the computer 
memory.

AHCI — Advanced Host Controller Interface — An interface for a SATA hard drive 
Host Controller which allows the storage driver to enable technologies such as Native 
Command Queuing (NCQ) and hot plug.

ALS — ambient light sensor — A feature that helps to control display brightness.

antivirus software — A program designed to identify, quarantine, and/or delete viruses 
from your computer.

ASF — alert standards format — A standard to define a mechanism for reporting 
hardware and software alerts to a management console. ASF is designed to be 
platform- and operating system-independent.

B
battery life span — The length of time (years) during which a portable computer 
battery is able to be depleted and recharged.

battery operating time — The length of time (minutes or hours) that a portable 
computer battery powers the computer.

BIOS — basic input/output system — A program (or utility) that serves as an 
interface between the computer hardware and the operating system. Unless you 
understand what effect these settings have on the computer, do not change them. 
Also referred to as system setup.
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bit — The smallest unit of data interpreted by your computer.

Blu-ray Disc™ (BD)— An optical storage technology offering storage capacity of up 
to 50 GB, full 1080p video resolution (HDTV required), and as many as 7.1 channels 
of native, uncompressed surround sound.

Bluetooth® wireless technology — A wireless technology standard for short-range 
(9 m [29 feet]) networking devices that allows for enabled devices to automatically 
recognize each other.

boot sequence — Specifies the order of the devices from which the computer 
attempts to boot.

bootable media — A CD, DVD, or floppy disk that you can use to start your 
computer. In case your hard drive is damaged or your computer has a virus, ensure that 
you always have a bootable CD, DVD, or floppy disk available. Your Drivers and 
Utilities media is an example of bootable media.

bps — bits per second — The standard unit for measuring data transmission speed.

BTU — British thermal unit — A measurement of heat output.

bus — A communication pathway between the components in your computer.

bus speed — The speed, given in MHz, that indicates how fast a bus can transfer 
information.

byte — The basic data unit used by your computer. A byte is usually equal to 8 bits.

C
C — Celsius — A temperature measurement scale where 0° is the freezing point and 
100° is the boiling point of water.

cache — A special high-speed storage mechanism which can be either a reserved 
section of main memory or an independent high-speed storage device. The cache 
enhances the efficiency of many processor operations.

L1 cache — Primary cache stored inside the processor.

L2 cache — Secondary cache which can either be external to the processor or 
incorporated into the processor architecture.

carnet — An international customs document that facilitates temporary imports into 
foreign countries. Also known as a merchandise passport.

CD-R — CD recordable — A recordable version of a CD. Data can be recorded only 
once onto a CD-R. Once recorded, the data cannot be erased or written over.

CD-RW — CD rewritable — A rewritable version of a CD. Data can be written to a 
CD-RW disc, and then erased and written over (rewritten).
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CD-RW drive — A drive that can read CDs and write to CD-RW (rewritable CDs) 
and CD-R (recordable CDs) discs. You can write to CD-RW discs multiple times, but 
you can write to CD-R discs only once.

CD-RW/DVD drive — A drive, sometimes referred to as a combo drive, that can read 
CDs and DVDs and write to CD-RW (rewritable CDs) and CD-R (recordable CDs) 
discs. You can write to CD-RW discs multiple times, but you can write to CD-R discs 
only once.

clock speed — The speed, given in MHz, that indicates how fast computer 
components that are connected to the system bus operate. 

CMOS — A type of electronic circuit. Computers use a small amount of 
battery-powered CMOS memory to hold date, time, and system setup options. 

COA — Certificate of Authenticity — The Windows alpha-numeric code located on a 
sticker on your computer. Also referred to as the Product Key or Product ID.

Control Panel — A Windows utility that allows you to modify operating system and 
hardware settings, such as display settings.

controller — A chip that controls the transfer of data between the processor and 
memory or between the processor and devices.

CRIMM — continuity rambus in-line memory module — A special module that has 
no memory chips and is used to fill unused RIMM slots.

cursor — The marker on a display or screen that shows where the next keyboard, touch 
pad, or mouse action will occur. It often is a blinking solid line, an underline character, 
or a small arrow.

D
DDR SDRAM — double-data-rate SDRAM — A type of SDRAM that doubles the 
data burst cycle, improving system performance.

DDR2 SDRAM — double-data-rate 2 SDRAM — A type of DDR SDRAM that uses a 
4-bit prefetch and other architectural changes to boost memory speed to over 400 MHz.

device — Hardware such as a disk drive, printer, or keyboard that is installed in or 
connected to your computer.

device driver — See driver.

DIMM — dual in-line memory module — A circuit board with memory chips that 
connects to a memory module on the system board.

DIN connector — A round, six-pin connector that conforms to DIN (Deutsche 
Industrie-Norm) standards; it is typically used to connect PS/2 keyboard or mouse 
cable connectors.
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disk striping — A technique for spreading data over multiple disk drives. Disk striping 
can speed up operations that retrieve data from disk storage. Computers that use disk 
striping generally allow the user to select the data unit size or stripe width. 

DMA — direct memory access — A channel that allows certain types of data transfer 
between RAM and a device to bypass the processor.

docking device — provides port replication, cable management, and security features 
to adapt your notebook to a desktop workspace.

DMTF — Distributed Management Task Force — A consortium of hardware and 
software companies who develop management standards for distributed desktop, 
network, enterprise, and Internet environments.

domain — A group of computers, programs, and devices on a network that are 
administered as a unit with common rules and procedures for use by a specific group 
of users. A user logs on to the domain to gain access to the resources.

DRAM — dynamic random-access memory — Memory that stores information in 
integrated circuits containing capacitors.

driver — Software that allows the operating system to control a device such as a printer. 
Many devices do not work properly if the correct driver is not installed in the computer.

DSL — Digital Subscriber Line — A technology that provides a constant, high-speed 
Internet connection through an analog telephone line. 

dual-core — A technology in which two physical computational units exist inside a 
single processor package, thereby increasing computing efficiency and multi-tasking 
ability.

dual display mode — A display setting that allows you to use a second monitor as an 
extension of your display. Also referred to as extended display mode.

DVD-R — DVD recordable — A recordable version of a DVD. Data can be recorded 
only once onto a DVD-R. Once recorded, the data cannot be erased or written over.

DVD+RW — DVD rewritable — A rewritable version of a DVD. Data can be written 
to a DVD+RW disc, and then erased and written over (rewritten). (DVD+RW 
technology is different from DVD-RW technology.)

DVD+RW drive — drive that can read DVDs and most CD media and write to 
DVD+RW (rewritable DVDs) discs.

DVI — digital video interface — A standard for digital transmission between a 
computer and a digital video display.
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E
ECC — error checking and correction — A type of memory that includes special 
circuitry for testing the accuracy of data as it passes in and out of memory.

ECP — extended capabilities port — A parallel connector design that provides 
improved bidirectional data transmission. Similar to EPP, ECP uses direct memory 
access to transfer data and often improves performance.

EIDE — enhanced integrated device electronics — An improved version of the IDE 
interface for hard drives and CD drives.

EMI — electromagnetic interference — Electrical interference caused by 
electromagnetic radiation.

ENERGY STAR® — Environmental Protection Agency requirements that decrease 
the overall consumption of electricity.

EPP — enhanced parallel port — A parallel connector design that provides 
bidirectional data transmission.

ESD — electrostatic discharge — A rapid discharge of static electricity. ESD can 
damage integrated circuits found in computer and communications equipment.

expansion card — A circuit board that installs in an expansion slot on the system 
board in some computers, expanding the capabilities of the computer. Examples 
include video, and sound cards.

expansion slot — A connector on the system board (in some computers) where you 
insert an expansion card, connecting it to the system bus.

ExpressCard — A removable I/O card adhering to the PCMCIA standard. Modems 
and network adapters are common types of ExpressCards. ExpressCards support both 
the PCI Express and USB 2.0 standard.

Express Service Code — A numeric code located on a sticker on your Dell™ 
computer. Use the Express Service Code when contacting Dell for assistance. Express 
Service Code service may not be available in some countries.

extended display mode — A display setting that allows you to use a second monitor as 
an extension of your display. Also referred to as dual display mode.

extended PC Card — A PC Card that extends beyond the edge of the PC Card slot 
when installed.
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F
Fahrenheit — A temperature measurement scale where 32° is the freezing point and 
212° is the boiling point of water.

FBD — fully-buffered DIMM — A DIMM with DDR2 DRAM chips and an 
Advanced Memory Buffer (AMB) that speeds communication between the DDR2 
SDRAM chips and the system.

FCC — Federal Communications Commission — A U.S. agency responsible for 
enforcing communications-related regulations that state how much radiation 
computers and other electronic equipment can emit.

fingerprint reader — A strip sensor that uses your unique fingerprint to authenticate 
your user identity to help secure your computer. 

folder — A term used to describe space on a disk or drive where files are organized and 
grouped. Files in a folder can be viewed and ordered in various ways, such as 
alphabetically, by date, and by size.

format — The process that prepares a drive or disk for file storage. When a drive or 
disk is formatted, the existing information on it is lost.

FSB — front side bus — The data path and physical interface between the processor 
and RAM.

FTP — file transfer protocol — A standard Internet protocol used to exchange files 
between computers connected to the Internet.

G
G — gravity — A measurement of weight and force.

GB — gigabyte — A measurement of data storage that equals 1024 MB 
(1,073,741,824 bytes). When used to refer to hard drive storage, the term is often 
rounded to 1,000,000,000 bytes.

GHz — gigahertz — A measurement of frequency that equals one thousand million 
Hz, or one thousand MHz. The speeds for computer processors, buses, and interfaces 
are often measured in GHz.

graphics mode — A video mode that can be defined as x horizontal pixels by y vertical 
pixels by z colors. Graphics modes can display an unlimited variety of shapes and 
fonts.

GUI — graphical user interface — Software that interacts with the user by means of 
menus, windows, and icons. Most programs that operate on the Windows operating 
systems are GUIs.
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H
hard drive — A drive that reads and writes data on a hard disk. The terms hard drive 
and hard disk are often used interchangeably.

HDMI — The High-Definition Multimedia Interface (HDMI) is an all-digital 
audio/video interface capable of transmitting uncompressed streams. 

heat sink — A metal plate on some processors that helps dissipate heat.

hibernate mode — A power management mode that saves everything in memory to a 
reserved space on the hard drive and then turns off the computer. When you restart 
the computer, the memory information that was saved to the hard drive is 
automatically restored.

HTTP — hypertext transfer protocol — A protocol for exchanging files between 
computers connected to the Internet. 

Hyper-Threading — Hyper-Threading is an Intel technology that can enhance overall 
computer performance by allowing one physical processor to function as two logical 
processors, capable of performing certain tasks simultaneously.

Hz — hertz — A unit of frequency measurement that equals 1 cycle per second. 
Computers and electronic devices are often measured in kilohertz (kHz), 
megahertz (MHz), gigahertz (GHz), or terahertz (THz).

I
IC — integrated circuit — A semiconductor wafer, or chip, on which thousands or 
millions of tiny electronic components are fabricated for use in computer, audio, and 
video equipment. 

IDE — integrated device electronics — An interface for mass storage devices in which 
the controller is integrated into the hard drive or CD drive.

IEEE 1394 — Institute of Electrical and Electronics Engineers, Inc. — A 
high-performance serial bus used to connect IEEE 1394-compatible devices, 
such as digital cameras and DVD players, to the computer. 

infrared sensor — Consumer Infrared sensor to operate the remote control.

integrated — Usually refers to components that are physically located on the 
computer’s system board. Also referred to as built-in.

I/O — input/output — An operation or device that enters and extracts data from your 
computer. Keyboards and printers are I/O devices. 

I/O address — An address in RAM that is associated with a specific device (such as a 
serial connector, parallel connector, or expansion slot) and allows the processor to 
communicate with that device.
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IrDA — Infrared Data Association — The organization that creates international 
standards for infrared communications.

IRQ — interrupt request — An electronic pathway assigned to a specific device so 
that the device can communicate with the processor. Each device connection must be 
assigned an IRQ. Although two devices can share the same IRQ assignment, you 
cannot operate both devices simultaneously.

ISP — Internet service provider — A company that allows you to access its host server 
to connect directly to the Internet, send and receive e-mail, and access websites. The 
ISP typically provides you with a software package, user name, and access phone 
numbers for a fee. 

K
Kb — kilobit — A unit of data that equals 1024 bits. A measurement of the capacity of 
memory integrated circuits.

KB — kilobyte — A unit of data that equals 1024 bytes but is often referred to as 
1000 bytes.

key combination — A command requiring you to press multiple keys at the same time.

kHz — kilohertz — A measurement of frequency that equals 1000 Hz.

L
LAN — local area network — A computer network covering a small area. A LAN 
usually is confined to a building or a few nearby buildings. A LAN can be connected to 
another LAN over any distance through telephone lines and radio waves to form a 
wide area network (WAN).

LCD — liquid crystal display — The technology used by portable computer and 
flat-panel displays.

LED — light-emitting diode — An electronic component that emits light to indicate 
the status of the computer.

local bus — A data bus that provides a fast throughput for devices to the processor.

LPT — line print terminal — The designation for a parallel connection to a printer or 
other parallel device. 
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M
Mb — megabit — A measurement of memory chip capacity that equals 1024 Kb.

Mbps — megabits per second — One million bits per second. This measurement is 
typically used for transmission speeds for networks and modems.

MB — megabyte — A measurement of data storage that equals 1,048,576 bytes. 1 MB 
equals 1024 KB. When used to refer to hard drive storage, the term is often rounded to 
1,000,000 bytes.

MB/sec — megabytes per second — One million bytes per second. This measurement 
is typically used for data transfer ratings.

media bay — A bay that supports devices such as optical drives, a second battery, or a 
Dell TravelLite™ module.

memory — A temporary data storage area inside your computer. Because the data in 
memory is not permanent, it is recommended that you frequently save your files while 
you are working on them, and always save your files before you shut down the computer. 
Your computer can contain several different forms of memory, such as RAM, ROM, and 
video memory. Frequently, the word memory is used as a synonym for RAM.

memory address — A specific location where data is temporarily stored in RAM.

memory mapping — The process by which the computer assigns memory addresses to 
physical locations at start-up. Devices and software can then identify information that 
the processor can access.

memory module — A small circuit board containing memory chips, which connects to 
the system board.

MHz — megahertz — A measure of frequency that equals 1 million cycles per second. 
The speeds for computer processors, buses, and interfaces are often measured in MHz.

Mini PCI — A standard for integrated peripheral devices with an emphasis on 
communications such as modems and NICs. A Mini PCI card is a small external card 
that is functionally equivalent to a standard PCI expansion card.

Mini-Card — A small card designed for integrated peripherals, such as 
communication NICs. The Mini-Card is functionally equivalent to a standard PCI 
expansion card.

module bay — See media bay.

MP — megapixel — A measure of image resolution used for digital cameras.

ms — millisecond — A measure of time that equals one thousandth of a second. 
Access times of storage devices are often measured in ms.
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N
network adapter — A chip that provides network capabilities. A computer may include a 
network adapter on its system board, or it may contain a PC Card with an adapter on it. 
A network adapter is also referred to as a NIC (network interface controller).

NIC — See network adapter.

notification area — The section of the Windows taskbar that contains icons for 
providing quick access to programs and computer functions, such as the clock, volume 
control, and print status. Also referred to as system tray.

ns — nanosecond — A measure of time that equals one billionth of a second.

NVRAM — nonvolatile random access memory — A type of memory that stores data 
when the computer is turned off or loses its external power source. NVRAM is used for 
maintaining computer configuration information such as date, time, and other system 
setup options that you can set.

O
optical drive — A drive that uses optical technology to read or write data from CDs, 
DVDs, or DVD+RWs. Example of optical drives include CD drives, DVD drives, 
CD-RW drives, and CD-RW/DVD combo drives. 

P
parallel connector — An I/O port often used to connect a parallel printer to your 
computer. Also referred to as an LPT port.

partition — A physical storage area on a hard drive that is assigned to one or more logical 
storage areas known as logical drives. Each partition can contain multiple logical drives.

PC Card — A removable I/O card adhering to the PCMCIA standard. Modems and 
network adapters are common types of PC Cards.

PCI — peripheral component interconnect — PCI is a local bus that supports 32-and 
64-bit data paths, providing a high-speed data path between the processor and devices 
such as video, drives, and networks.

PCI Express — A modification to the PCI interface that boosts the data transfer rate 
between the processor and the devices attached to it. PCI Express can transfer data at 
speeds from 250 MB/sec to 4 GB/sec. If the PCI Express chip set and the device are 
capable of different speeds, they will operate at the slower speed.

PCMCIA — Personal Computer Memory Card International Association — The 
organization that establishes standards for PC Cards.
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PIO — programmed input/output — A method of transferring data between two 
devices through the processor as part of the data path.

pixel — A single point on a display screen. Pixels are arranged in rows and columns to 
create an image. A video resolution, such as 800 x 600, is expressed as the number of 
pixels across by the number of pixels up and down.

Plug-and-Play — The ability of the computer to automatically configure devices. 
Plug and Play provides automatic installation, configuration, and compatibility with 
existing hardware if the BIOS, operating system, and all devices are Plug and Play 
compliant.

POST — power-on self-test — Diagnostics programs, loaded automatically by the 
BIOS, that perform basic tests on the major computer components, such as memory, 
hard drives, and video. If no problems are detected during POST, the computer 
continues the start-up.

processor — A computer chip that interprets and executes program instructions. 
Sometimes the processor is referred to as the CPU (central processing unit).

PS/2 — personal system/2 — A type of connector for attaching a PS/2-compatible 
keyboard, mouse, or keypad.

PXE — pre-boot execution environment — A WfM (Wired for Management) 
standard that allows networked computers that do not have an operating system to be 
configured and started remotely.

R
RAID — redundant array of independent disks — A method of providing data 
redundancy. Some common implementations of RAID include RAID 0, RAID 1, 
RAID 5, RAID 10, and RAID 50.

RAM — random-access memory — The primary temporary storage area for program 
instructions and data. Any information stored in RAM is lost when you shut down your 
computer.

readme file — A text file included with a software package or hardware product. 
Typically, readme files provide installation information and describe new product 
enhancements or corrections that have not yet been documented.

read-only — Data and/or files you can view but cannot edit or delete. A file can have 
read-only status if:

• It resides on a physically write-protected floppy disk, CD, or DVD.

• It is located on a network in a directory and the system administrator has assigned 
rights only to specific individuals.
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refresh rate — The frequency, measured in Hz, at which your screen's horizontal lines 
are recharged (sometimes also referred to as its vertical frequency). The higher the 
refresh rate, the less video flicker can be seen by the human eye.

resolution — The sharpness and clarity of an image produced by a printer or displayed 
on a monitor. The higher the resolution, the sharper the image.

RFI — radio frequency interference — Interference that is generated at typical radio 
frequencies, in the range of 10 kHz to 100,000 MHz. Radio frequencies are at the 
lower end of the electromagnetic frequency spectrum and are more likely to have 
interference than the higher frequency radiations, such as infrared and light.

ROM — read-only memory — Memory that stores data and programs that cannot be 
deleted or written to by the computer. ROM, unlike RAM, retains its contents after 
you shut down your computer. Some programs essential to the operation of your 
computer reside in ROM.

RPM — revolutions per minute — The number of rotations that occur per minute. 
Hard drive speed is often measured in rpm.

RTC — real time clock — Battery-powered clock on the system board that keeps the 
date and time after you shut down the computer.

RTCRST — real-time clock reset — A jumper on the system board of some computers 
that can often be used for troubleshooting problems.

S
SAS — serial attached SCSI — A faster, serial version of the SCSI interface (as opposed 
to the original SCSI parallel architecture).

SATA — serial ATA — A faster, serial version of the ATA (IDE) interface.

ScanDisk — A Microsoft utility that checks files, folders, and the hard disk’s surface 
for errors. ScanDisk often runs when you restart the computer after it has stopped 
responding.

SCSI — small computer system interface — A high-speed interface used to connect 
devices to a computer, such as hard drives, CD drives, printers, and scanners. The 
SCSI can connect many devices using a single controller. Each device is accessed by an 
individual identification number on the SCSI controller bus.

SDRAM — synchronous dynamic random-access memory — A type of DRAM that is 
synchronized with the optimal clock speed of the processor.

serial connector — An I/O port often used to connect devices such as a handheld 
digital device or digital camera to your computer.
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Service Tag — A bar code label on your computer that identifies your computer when 
you access Dell Support at support.dell.com or when you call Dell for customer service 
or technical support.

setup program — A program that is used to install and configure hardware and 
software. The setup.exe or install.exe program comes with most Windows software 
packages. Setup program differs from system setup.

shortcut — An icon that provides quick access to frequently used programs, files, 
folders, and drives. When you place a shortcut on your Windows desktop and double-
click the icon, you can open its corresponding folder or file without having to find it 
first. Shortcut icons do not change the location of files. If you delete a shortcut, the 
original file is not affected. Also, you can rename a shortcut icon.

SIM — Subscriber Identity Module — A SIM card contains a microchip that encrypts 
voice and data transmissions. SIM cards can be used in phones or portable computers.

smart card — A card that is embedded with a processor and a memory chip. Smart 
cards can be used to authenticate a user on computers equipped for smart cards.

S/PDIF — Sony/Philips Digital Interface — An audio transfer file format that allows 
the transfer of audio from one file to another without converting it to and from an 
analog format, which could degrade the quality of the file.

standby mode — A power management mode that shuts down all unnecessary 
computer operations to save energy.

Strike Zone™ — Reinforced area of the platform base that protects the hard drive by 
acting as a dampening device when a computer experiences resonating shock or is 
dropped (whether the computer is on or off).

surge protectors — Prevent voltage spikes, such as those that may occur during an 
electrical storm, from entering the computer through the electrical outlet. Surge 
protectors do not protect against lightning strikes or against brownouts, which occur 
when the voltage drops more than 20 percent below the normal AC-line voltage level.

Network connections cannot be protected by surge protectors. Always disconnect the 
network cable from the network connector during electrical storms.

SVGA — super-video graphics array — A video standard for video cards and 
controllers. Typical SVGA resolutions are 800 x 600 and 1024 x 768.

The number of colors and resolution that a program displays depends on the 
capabilities of the monitor, the video controller and its drivers, and the amount of 
video memory installed in the computer.

S-video TV-out — A connector used to attach a TV or digital audio device to the 
computer.
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SXGA — super-extended graphics array — A video standard for video cards and 
controllers that supports resolutions up to 1280 x 1024.

SXGA+ — super-extended graphics array plus — A video standard for video cards and 
controllers that supports resolutions up to 1400 x 1050.

system board — The main circuit board in your computer. Also known as the 
motherboard.

system setup — A utility that serves as an interface between the computer hardware 
and the operating system. System setup allows you to configure user-selectable options 
in the BIOS, such as date and time or system password. Unless you understand what 
effect the settings have on the computer, do not change the settings for this program.

T
TAPI — telephony application programming interface — Enables Windows programs 
to operate with a wide variety of telephony devices, including voice, data, fax, and 
video.

text editor — A program used to create and edit files that contain only text; for example, 
Windows Notepad uses a text editor. Text editors do not usually provide word wrap or 
formatting functionality (the option to underline, change fonts, and so on).

TPM — trusted platform module — A hardware-based security feature that when 
combined with security software enhances network and computer security by enabling 
features such as file and e-mail protection.

travel module — A plastic device designed to fit inside the module bay of a portable 
computer to reduce the weight of the computer.

U
UAC — user account control— Microsoft Windows Vista™ security feature that, 
when enabled, provides an added layer of security between user accounts and access to 
operating system settings.

UMA — unified memory allocation — System memory dynamically allocated to video.

UPS — uninterruptible power supply — A backup power source used when the 
electrical power fails or drops to an unacceptable voltage level. A UPS keeps a 
computer running for a limited amount of time when there is no electrical power. UPS 
systems typically provide surge suppression and may also provide voltage regulation. 
Small UPS systems provide battery power for a few minutes to enable you to shut 
down your computer.
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USB — universal serial bus — A hardware interface for a low-speed device such as a 
USB-compatible keyboard, mouse, joystick, scanner, set of speakers, printer, 
broadband devices, imaging devices, or storage devices. Devices are plugged directly in 
to a 4-pin socket on your computer or in to a multi-port hub that plugs in to your 
computer. USB devices can be connected and disconnected while the computer is 
turned on, and they can also be daisy-chained together.

UTP — unshielded twisted pair — Describes a type of cable used in most telephone 
networks and some computer networks. Pairs of unshielded wires are twisted to protect 
against electromagnetic interference, rather than relying on a metal sheath around 
each pair of wires to protect against interference.

UXGA — ultra extended graphics array — A video standard for video cards and 
controllers that supports resolutions up to 1600 x 1200.

V
video controller — The circuitry on a video card or on the system board (in computers 
with an integrated video controller) that provides the video capabilities—in 
combination with the monitor—for your computer.

video memory — Memory that consists of memory chips dedicated to video functions. 
Video memory is usually faster than system memory. The amount of video memory 
installed primarily influences the number of colors that a program can display.

video mode — A mode that describes how text and graphics are displayed on a 
monitor. Graphics-based software, such as Windows operating systems, displays in 
video modes that can be defined as x horizontal pixels by y vertical pixels by z colors. 
Character-based software, such as text editors, displays in video modes that can be 
defined as x columns by y rows of characters.

video resolution — See resolution.

virus — A program that is designed to inconvenience you or to destroy data stored on 
your computer. A virus program moves from one computer to another through an 
infected disk, software downloaded from the Internet, or e-mail attachments. When 
an infected program starts, its embedded virus also starts.

A common type of virus is a boot virus, which is stored in the boot sectors of a floppy 
disk. If the floppy disk is left in the drive when the computer is shut down and then 
turned on, the computer is infected when it reads the boot sectors of the floppy disk 
expecting to find the operating system. If the computer is infected, the boot virus may 
replicate itself onto all the floppy disks that are read or written in that computer until 
the virus is eradicated.

V — volt — The measurement of electric potential or electromotive force. One V appears 
across a resistance of 1 ohm when a current of 1 ampere flows through that resistance.
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W
W — watt — The measurement of electrical power. One W is 1 ampere of current 
flowing at 1 volt.

WHr — watt-hour — A unit of measure commonly used to indicate the approximate 
capacity of a battery. For example, a 66-WHr battery can supply 66 W of power for 
1 hour or 33 W for 2 hours.

wallpaper — The background pattern or picture on the Windows desktop. Change 
your wallpaper through the Windows Control Panel. You can also scan in your favorite 
picture and make it wallpaper.

WLAN — wireless local area network. A series of interconnected computers that 
communicate with each other over the air waves using access points or wireless routers 
to provide Internet access.

write-protected — Files or media that cannot be changed. Use write-protection when 
you want to protect data from being changed or destroyed. To write-protect a 3.5-inch 
floppy disk, slide its write-protect tab to the open position.

WWAN — wireless wide area network. A wireless high-speed data network using 
cellular technology and covering a much larger geographic area than WLAN. 

WXGA — wide-aspect extended graphics array — A video standard for video cards 
and controllers that supports resolutions up to 1280 x 800.

X
XGA — extended graphics array — A video standard for video cards and controllers 
that supports resolutions up to 1024 x 768.

Z
ZIF — zero insertion force — A type of socket or connector that allows a computer 
chip to be installed or removed with no stress applied to either the chip or its socket.

Zip — A popular data compression format. Files that have been compressed with the 
Zip format are called Zip files and usually have a filename extension of .zip. A special 
kind of zipped file is a self-extracting file, which has a filename extension of .exe. You 
can unzip a self-extracting file by double-clicking it.

Zip drive — A high-capacity floppy drive developed by Iomega Corporation that uses 
3.5-inch removable disks called Zip disks. Zip disks are slightly larger than regular 
floppy disks, about twice as thick, and hold up to 100 MB of data.
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Index

Numerics

8-in-1 memory card reader, 88

A

air vents

description, 25, 28, 31

audio device

connecting, 68

enabling, 82

audio. See sound

B

battery

charge gauge, 49

charging, 52

checking the charge, 48

performance, 47

power meter, 48

removing, 53

storing, 53

blank cards

ExpressCards, 86

memory card, 89

removing, 87, 90

Blu-ray Disc, 65, 113

boot sequence, 180

brightness

adjusting, 39

C

camera, 20, 24

carnet, 164

CD

blank, 63

CD-RW drive problems, 113

drive problems, 113

Check Disk, 114

computer

crashes, 123-124

restore to previous operating 
state, 141

slow performance, 115, 125

specifications, 172

stops responding, 123

conflicts

software and hardware 
incompatibilities, 139

connecting

audio device, 68

Mobile Broadband network, 98

TV, 68

contacting Dell, 170

copying CDs

helpful tips, 64
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how to, 63

copying DVDs

helpful tips, 64

how to, 63

D

Dell

contacting, 170

Dell Diagnostics

about, 107

starting from the Drivers and 
Utilities media, 109

starting from your hard drive, 108

Dell MediaDirect

about, 23

problems, 124

Dell support site, 15

DellConnect, 166

device latch release

description, 31

device status lights

description, 21

diagnostics

Dell, 107

display

adjusting brightness, 39

description, 20

resolution, 41

switching the video image, 39

documentation

End User License Agreement, 14

ergonomics, 14

online, 15

Product Information Guide, 14

regulatory, 14

safety, 14

warranty, 14

drivers

about, 135

identifying, 136

reinstalling, 136

Drivers and Utilities media

about, 137

Dell Diagnostics, 107

drives

problems, 112

See hard drive

DVD

blank, 63

drive problems, 113

E

End User License Agreement, 14

ergonomics information, 14

error messages, 115

ExpressCard slot

description, 27

ExpressCards, 85

blanks, 86-87

installing, 86

removing, 87
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F

Factory Image Restore, 143, 145

H

hard drive

description, 31

problems, 114

replacing, 152

hardware

conflicts, 139

Dell Diagnostics, 107

Hardware Troubleshooter, 139

I

IEEE 1394 connector

description, 25

problems, 121

infrared sensor

description, 27

Internet connection

about, 33

options, 33

setting up, 33

IRQ conflicts, 139

K

keyboard

numeric keypad, 43

problems, 121

shortcuts, 43

keyboard status lights

description, 24

keypad

numeric, 43

L

labels

Microsoft Windows, 14

Service Tag, 14

M

media

playing, 59

media control buttons

Dell MediaDirect button, 67

media memory cards, 88

installing, 89

types, 88

memory

adding, 155

removing, 156

memory card

blanks, 89

memory card reader, 88

memory cards

blanks, 90

removing, 90

memory module cover

description, 31
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messages

error, 115

microphone

directional, 55

Mobile Broadband

network connections, 98

problems, 126

See also wireless switch

monitor

switching the video image, 39

monitor. See display

N

network

Mobile Broadband 
(WWAN), 126

problems, 126

network connector

description, 30

O

operating system

reinstalling Windows Vista, 141

P

PC Restore, 143

phone numbers, 170

power

line conditioners

problems, 128

protection devices

surge protectors

UPS

power button

description, 20

power light

conditions, 128

printer

cable, 35

connecting, 33, 35

problems, 129

setting up, 33, 35

USB, 35

problems

blue screen, 124

CD drive, 113

CD-RW drive, 113

computer crashes, 123-124

computer does not start up, 123

computer stops responding, 123

conflicts, 139

Dell Diagnostics, 107

Dell MediaDirect, 124

drives, 112

DVD drive, 113

error messages, 115

hard drive, 114

IEEE 1394 connector, 121

keyboard, 121

lockups, 123

network, 126

power, 128

power light conditions, 128
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printer, 129

program crashes repeatedly, 123

program stops responding, 123

programs and Windows 
compatibility, 124

restore computer to previous 
operating state, 141

restore operating system to 
previous state, 140

scanner, 130

slow computer performance, 115, 
125

software, 123-125

sound and speakers, 131

speakers, 131

spyware, 115, 125

Product Information Guide, 14

Q

QuickSet Help, 17

R

RAM. See memory

regulatory information, 14

reinstalling

Windows Vista, 141

resolution

setting, 41

S

S/PDIF digital audio

enabling, 82

Safely Remove Hardware 
icon, 120

safety instructions, 14

scanner

problems, 130

screen. See display

security cable slot

description, 28

Service Tag, 14

SIM. See Subscriber Identity 
Module

software

conflicts, 139

problems, 124-125

software and hardware 
incompatibilities, 139

sound

problems, 131

volume, 131

speakers

description, 22

problems, 131

volume, 131

specifications, 172

spyware, 115, 125

Subscriber Identity Module, 159

support

contacting Dell, 170
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support website, 15

System Restore, 140-141

system setup program

commonly used options, 180

purpose, 179

screens, 180

viewing, 180

T

taskbar

Dell Mobile Broadband Card 
Utility, 127

Safely Remove Hardware, 120

wireless activity indicator, 98

telephone numbers, 170

touch pad, 45

track stick/touch pad buttons

description, 22

traveling with the computer

by air, 164

identification tag, 163

packing, 163

tips, 164

troubleshooting

conflicts, 139

Dell Diagnostics, 107

Hardware Troubleshooter, 139

restore computer to previous 
operating state, 140-141

turning off your computer, 150

TV

connecting, 68

U

uninterruptible power supply. 
See UPS

UPS

USB connector

description, 30

V

video

problems, 133

video controller

determining configuration, 19

volume

adjusting, 131

W

warranty information, 14

Windows Vista

Device Driver Rollback, 137

Factory Image Restore, 143

Program Compatibility 
wizard, 124

reinstalling, 141

System Restore, 140-141

Windows XP

Device Driver Rollback, 137

device driver rollback, 136

Hardware Troubleshooter, 139

PC Restore, 143

Program Compatibility 
wizard, 124
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reinstalling, 146

system restore, 141

wizards

Program Compatibility 
wizard, 124

WWAN

See also Mobile Broadband
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